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SECTION 1 Généralités
Le processeur audio DFR22 avec réduction de l’effet Larsen est un processeur audio numérique à 2 entrées et 2 sor-
ties. Il est idéal pour les sonorisations fixes des institutions religieuses, théâtres et salles de réunions. Le DFR22 con-
stitue également un outil puissant pour les sonorisations de concerts. Grâce aux fonctions de type glisser-déplacer de
l'interface utilisateur graphique du DFR22, les processeurs peuvent être placés n'importe où dans le chemin de signal.
Le mélangeur matriciel 2 X 2 permet de diriger l’une ou les deux entrées vers l’une ou les deux sorties et offre des
commandes supplémentaires pour les niveaux et la polarité.

Conventions utilisées dans le présent document

L’interface logicielle du DFR22 est tellement intuitive et conviviale qu’il se peut que l’utilisateur soit tenté de ne pas lire 
ce document et de passer immédiatement à la programmation de l’unité. Avant de le faire, il convient toutefois de par-
courir rapidement les généralités, puis de lire attentivement le Guide de mise en route à la page 13. Les réponses à 
toutes les questions concernant le logiciel se trouvent dans les sections ci-après du document.

Structure et organisation du présent guide

• Généralités .................................................Cette section présente les principales fonctions du processeur 
audio et examine les modes opératoires de l’interface et de la fenêtre principale.

• Guide de mise en route .............................Ce guide traite des opérations logicielles de base à effectuer 
afin de configurer le processeur audio pour une installation.

• Création d’un préréglage ..........................Cette section traite des éléments de la configuration de flu-
ence d’un DFR22, tels que la structure de gain de l’appareil, l’acheminement du signal des entrées aux 
sorties, l’ajout de processeurs au chemin de signal et de leur exploitation dans la fenêtre principale.

• Gestion des préréglages et de l’appareil .Cette section explique la façon d'enregistrer un préréglage 
dans l'ordinateur, de le stocker dans le DFR22 et de sauvegarder dans l'ordinateur les préréglages 
stockés dans l'appareil. Elle explique également les fonctions du menu [Device] (Appareil).

• Fonctions du processeur ..........................Cette section traite des fonctions couramment rencontrées sur 
de nombreux modules processeur de signal telles que la commande d’affaiblissement, la prise d’instan-
tanés des paramètres, ainsi que l’enregistrement de ces derniers dans l’ordinateur et leur rappel à partir 
de celui-ci.

• Processeurs fixes ......................................Cette section décrit les fonctions des blocs de gain d’entrée et 
de sortie et du mélangeur matriciel.

• Processeurs modulaires ...........................Cette section décrit les fonctions propres à chacun des pro-
cesseurs de signal de type glisser-déplacer.

• Broches de commande .............................Cette section décrit l’architecture interne de la fonction de 
commande de dispositif externe du processeur audio et explique la façon de configurer les broches de 
commande du DFR22 à l’aide du logiciel, une fois le matériel externe connecté.

• Sécurité.......................................................Cette section traite des fonctions du processeur audio limitant 
l'accès des utilisateurs aux paramètres de l'appareil et aux commandes du panneau frontal.

Conventions de notation
• Texte entre [crochets]. .  Cette notation indique qu’il s’agit de texte extrait directement de l’interface 

logicielle, comme par exemple des labels de commande, des boutons ou des commandes sur menu.

• Touches du clavier . . . . Les touches telles que Maj, Ctrl et Echap apparaissent en caractères gras. 
Dans les cas où l’utilisateur est amené à appuyer sur une combinaison de touches, ou à combiner l’emploi 
des touches et de la souris, le signe plus est utilisé de la manière suivante : Ctrl + Cliquer.
© 2003 Shure Incorporated Guide du logiciel DFR22 6



Fonctions du processeur audio
Fonctions du processeur audio

Le DFR22 est un processeur audio numérique à 2 entrées et 2 sorties avec une interface logicielle et des commandes 
simples sur son panneau frontal, qui stocke 16 préréglages. Il permet une conversion 24 bits, un échantillonnage à 48 
kHz et une gamme dynamique minimum de 100 dB.

Interface logicielle glisser-déplacer
L’interface ordinateur avec le processeur audio simule les schémas de principe utilisés dans la conception du
système de sonorisation. Cela rend l’apprentissage du logiciel extrêmement aisé pour les professionnels de la
sonorisation auxquels l’interface paraît immédiatement familière. Il est possible de créer et d’éditer des
préréglages simplement en cliquant, glissant et déplaçant à l’aide de la souris. Le chemin du signal peut être
configuré à l’aide de toute combinaison de processeurs de signal de type glisser-déplacer.

Processeurs de signal modulaires
Chaque module de traitement de signaux est encapsulé dans un bloc graphique qu’il est possible de manipuler
à l’aide de la souris. Une fois qu’un processeur est placé dans le diagramme de fluence, ses paramètres sont
accessibles en double-cliquant sur le bloc correspondant pour ouvrir sa fenêtre de paramètres. Il est possible
d’enregistrer les paramètres dans l’ordinateur et de les rappeler de celui-ci, ainsi que de les copier entre mod-
ules similaires. Les paramètres du processeur peuvent également être synchronisés via la liaison. Le proces-
seur audio DFR22 offre le choix suivant de modules processeur de signaux.

Commande de dispositif externe
Une fois que le DFR22 est installé et programmé à l'aide de l'interface logicielle, les utilisateurs finaux peuvent
le commander à l’aide d’un ordinateur ou d’un contrôleur AMX ou Crestron. De plus, il est possible de con-
necter les broches de commande qui se trouvent sur le panneau arrière à du matériel externe pour permettre
au DFR22 de réagir aux fermetures de contacts, aux potentiomètres et aux interrupteurs muraux.

Sécurité
La fonction de sécurité rassure l’installateur quant à l’inviolabilité de l’appareil une fois celui-ci installé. L’accès
utilisateur peut être totalement limité pour empêcher l’utilisateur de modifier des paramètres ou d’utiliser les
commandes du panneau frontal. Il est seulement possible de visualiser les paramètres du préréglage en
vigueur à l’aide de l’interface logicielle. Il est également possible de personnaliser le contrôle des utilisateurs
pour leur autoriser l’accès à certains paramètres mais pas à d’autres.

• Puissant réducteur de Larsen numérique de Shure, à 
la fois pour les processeurs mono et stéréo

• Commande automatique de gain et
• Égalisateurs graphiques 10 et 30 bandes mélangeurs 

et non mélangeurs
• Égalisateurs paramétriques 3 à 10 bandes avec filtres 

passe-haut et passe-bas et de dégradé

• Filtre répartiteur et séparateur à 2 voies
• Caisson de graves
• Obturateur/extenseur descendant
• Compresseur mono et stéréo/écrêteur avec option 

Soft-Knee
• Atténuateur
• Écrêteur de pointe
© 2003 Shure Incorporated Guide du logiciel DFR22 7



Matériel nécessaire pour le logiciel du DFR22
Matériel nécessaire pour le logiciel du DFR22
Pour pouvoir être exploité correctement, le logiciel version 3 du DFR22 exige un PC ayant les caractéristiques suivantes :

• 20 Mo d’espace disque dur disponible
• Lecteur de CD-ROM
• Moniteur VGA à résolution d’au moins 640 x 480/256 couleurs
• Souris ou autre dispositif pointeur

La vitesse de traitement et la mémoire nécessaire varient suivant la version de Windows et le nombre d’applications 
tournant en arrière-plan. L’exploitation simultanée du logiciel du DFR22 et de programmes tels que SIA-Smaart® ou 
Gold Line TEF™ demande un processeur plus rapide et plus de RAM. Le tableau ci-dessous indique le matériel néces-
saire pour faire tourner le logiciel du DFR22 sans autres applications en arrière-plan, telles qu’anti-virus, protection 
anti-intrusion, messagerie instantanée ou courrier électronique.

Modes d’interface
L’interface utilise deux modes principaux d’exploitation : mode Design (création) et mode Live (dynamique). Cela per-
met de créer des configurations pour le DFR22, que l’ordinateur soit connecté ou non à l’appareil. Certaines fonctions 
propres à chaque mode sont décrites dans le manuel.

Mode Design (création)
Le lancement de l’application s’effectue toujours en mode Design. Ce mode est celui qui est utilisé pour créer
des préréglages qui sont stockés plus tard dans le DFR22. Lorsque l’on opère dans ce mode, il n’est pas
nécessaire que l’ordinateur soit connecté à l’appareil. Il est possible d’enregistrer sur l’ordinateur les
préréglages créés, que l’on peut plus tard rappeler et transmettre à l’appareil par l’intermédiaire de la connex-
ion RS-232. Cela permet de concevoir des préréglages dans un lieu autre que celui où est installé le matériel.

Mode Live (dynamique)
Ce mode permet d’ajuster les préréglages du matériel en temps réel alors que l’ordinateur est connecté au
DFR22. Cela permet de percevoir instantanément les changements apportés au traitement de signaux lor-
squ’on modifie les paramètres et ainsi d’affiner facilement les préréglages sur place. Toutes les opérations
effectuées en mode Live sont enregistrées directement dans le préréglage actif.

Mode Preview (aperçu)
Lorsqu’on utilise le mode Live avec un appareil dans lequel sont enregistrés de nombreux préréglages, il est
possible de rappeler ces derniers individuellement pour les modifier en temps réel. Lorsqu’on choisit un
préréglage à charger dans le diagramme de fluence, la fenêtre passe en mode Preview pour permettre de véri-
fier le préréglage choisi avant de le désigner comme prochain préréglage actif. L’interface revient en mode Live
lorsqu’on charge le préréglage ou annule l’opération.

Version de Windows Vitesse du processeur RAM
98, Seconde édition Pentium 166 MHz 48 Mo
NT Pentium 233 MHz 64 Mo
ME Pentium 300 MHz 64 Mo
2000 Professionnel Pentium 300 MHz 96 Mo
XP Professionnel ou Édition familiale Pentium 300 MHz 128 Mo
© 2003 Shure Incorporated Guide du logiciel DFR22 8



Généralités
La fenêtre principale

Cette fenêtre, illustrée ci-dessous à la figure 1-1, constitue la principale zone de travail dans l'interface logicielle. Il est 
possible de l’agrandir proportionnellement ou de la maximiser pour lui faire occuper tout l’écran. La fermeture de cette 
fenêtre fait quitter l’application.

1. Barre de titre : En mode Live, elle affiche des informa-
tions propres à l'appareil. Voir la section ci-dessous pour 
une description plus détaillée.

2. Menu principal : Il permet d’accéder aux commandes 
sur menu propres à l’appareil et au diagramme de fluence.

3. Barre de contrôle : Elle affiche des commandes propres 
à l’appareil et au diagramme de fluence. Voir la section à la 
page suivante pour de plus amples informations.

4. Diagramme de fluence : Il s’agit de l’espace où sont 
créés les préréglages. Voir la section à la page suivante 
pour de plus amples informations.

5. Barre d’état : Elle affiche des commandes et des indica-
teurs relatifs au diagramme de fluence. Voir la section à la 
page 11 pour de plus amples informations.

Barre de titre
Les informations données sur la barre de titre de cette fenêtre changent en fonction du mode opératoire. En
mode Design, « DFR22: Offline » (DFR22 : hors ligne) apparaît sur la barre de titre, qui indique le niveau de
sécurité par défaut. En mode Live, la barre de titre affiche des informations propres à l’unité à laquelle on est
connecté, comme illustré ci-dessous à la figure 1-2.

1. Code appareil : Le code appareil est spécifié en réglant 
les micro-interrupteurs situés au dos de l'appareil. Voir le 
Guide d’installation pour obtenir les instructions correspon-
dantes.

2. Nom de l’appareil : Pour nommer l’appareil, en mode 
Live, sélectionner [Devices>Name Device] (Appar-
eils>Nommer l’appareil) dans le menu principal. Pour de 

plus amples renseignements, voir l’étape 5 du Guide de 
mise en route à la page 13.

3. Niveau de sécurité : En mode Live, ce champ indique le 
niveau de sécurité actuel établi pour l’appareil. Pour de 
plus amples renseignements, voir la section Sécurité à la 
page 100.

FIGURE 1-1 : Fenêtre principale

1

2

3

4

5

FIGURE 1-2 : Barre de titre
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La fenêtre principale
Barre de contrôle
L'aspect et la fonction de cette partie de la fenêtre changent suivant le mode opératoire, comme illustré 
ci-dessous.

1. Bouton [Live Mode] (Mode Live) : Cliquer sur ce bou-
ton pour passer en mode Live, ce qui permet de visualiser 
et d’éditer tout préréglage stocké dans le matériel. L’ordi-
nateur doit être connecté au DFR22 pour qu’il soit possible 
de passer dans ce mode.

2. Bouton [Design Mode] (Mode Design) : Cliquer sur 
ce bouton pour passer en mode Design. Le préréglage 
utilisé en mode Live reste chargé dans le diagramme de 
fluence.

3. Boîte d’information : Elle affiche des détails sur le 
préréglage chargé à l’écran, y compris son nom, la date de 
son dernier enregistrement et sa description. 

4. Bouton [Store Preset] (Stockage du préréglage) : 
Cliquer sur ce bouton pour stocker le préréglage actif dans 
le DFR22.

5. Bouton [Recall Preset] (Rappel du préréglage) : 
Cliquer dessus pour charger un préréglage dans le dia-
gramme de fluence à partir du DFR22 et travailler dessus 
en mode Design.

6. Bouton [Save As] (Enregistrer sous) : Cliquer sur ce 
bouton pour enregistrer le préréglage actif dans l’ordina-
teur.

7. Bouton [Open] (Ouvrir) : Cliquer sur ce bouton pour 
charger un fichier de préréglage dans le diagramme de flu-
ence à partir de l’ordinateur.

8. Sélecteur de préréglage : Cliquer sur ce menu dérou-
lant pour sélectionner un préréglage à partir d’une liste de 
préréglages stockés dans l’appareil.

9. Vumètres à DEL : Ces vumètres à DEL indiquent les 
niveaux audio dans l’appareil. Il est possible de les activer 
et de les désactiver en cliquant dessus ou en choisissant 
[View>Enable I/O Meters] (Vue>Activer les vumètres E/S) 
sur le menu principal.

10. Bouton [Load] (Charger) : Cliquer dessus pour 
charger le préréglage visible à l’écran dans le diagramme 
de fluence

11. Bouton [Cancel] (Annuler) : Cliquer dessus pour 
retourner au préréglage précédent.

Diagramme de fluence
Le diagramme de fluence est une représentation graphique de la façon dont les signaux audio traversent la
structure de gain du processeur audio et les blocs processeur placés sur les bandes de canaux d’entrée et de
sortie. Chaque préréglage généré dans le diagramme de fluence stocke la configuration des blocs processeur
et des connexions d'acheminement de signaux qui ont été créés. L’utilisateur peut créer des préréglages en
mode Live ou en mode Design et les stocker soit dans l’appareil, soit dans son PC. En mode Live, le
préréglage chargé dans le diagramme de fluence est le préréglage actif. Pour désigner un préréglage différent
comme préréglage actif, utiliser le menu déroulant du sélecteur de préréglage situé dans la boîte d’information
(élément nº 8 ci-dessus).

1 2 3 4 5 6 7

9 10

11

Mode Design :

Mode Live :

Mode Preview :

8

FIGURE 1-3 : Barre de contrôle
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Généralités
Indicateur de mode
Il affiche le mode actif du diagramme de fluence comme illustré ci-dessous.

Bandes de canaux d’entrée et de sortie
Ces bandes sont des représentations graphiques des canaux d’entrée et de sortie du DFR22. Elles con-
tiennent les blocs de gain et de mélange qui constituent la structure de gain de l’appareil, comme expliqué
à la section Structure de gain à la page 18. Elles comprennent également les espaces dans lesquels se
placent les blocs processeur, que l’on peut faire glisser et déplacer à partir de la fenêtre « Processor Tool-
box » (Boîte à outils de processeur) (voir page 12).

1. Bloc de gain d’entrée : Il s’agit de l’étage initial de la 
structure de gain du processeur audio. Double-cliquer sur 
ce bloc pour ouvrir la fenêtre « Input Gain » (Gain d'entrée) 
qui offre des options de démultiplication de -10 dBV/+4 
dBu, une coupure de canal, un contrôle de polarité et un 
affaiblissement de +10 dB/-l’infini pour chaque canal 
d’entrée. C’est également là que l’on nomme les canaux 
d’entrée.

2. Label de canal d'entrée : Il affiche le label de canal 
spécifié dans la fenêtre « Input Gain ».

3. Espace pour processeur : Ces espaces permettent 
l’accueil des blocs processeur modulaires. Des proces-
seurs peuvent y être insérés soit à l’aide de la méthode 
glisser-déplacer dans la fenêtre « Processor Toolbox » en 
choisissant l’option [Processor>Add] (Processeur>Ajouter) 
dans le menu principal, soit en cliquant sur le bouton droit 
de la souris et en sélectionnant l’option [Add Processor] 
(Ajouter un processeur) dans le menu contextuel.

4. Points de mélange : Cliquer sur ces points pour achem-
iner un signal entre les bandes d’entrée et celles de sortie. 
Des lignes apparaissent entre les points connectés pour 
indiquer la fluence. Chaque bande d’entrée peut être con-
nectée à l’une quelconque des bandes de sortie ou aux deux.

5. Numéros de canaux : Ces numéros correspondent à 
chacun des canaux d'entrée et de sortie.

6. Sélecteurs d’entrée : Cliquer sur ces sélecteurs 
d’entrée numérotés au point de mélange de chaque bande 
de sortie pour acheminer instantanément le signal à partir 
du point de mélange du canal d’entrée correspondant.

7. Bloc de mélange : Il s’agit de l’étage intermédiaire de la 
structure de gain du processeur audio. Double-cliquer sur 
ce bloc pour ouvrir la fenêtre « Matrix Mixer » (Mélangeur 
matriciel) où il est possible de diriger le signal de l’une 
quelconque des bandes de canal d’entrée vers l’une 
quelconque des bandes de canal de sortie ou vers les 
deux, et de régler les niveaux à l’aide de commandes 
d’affaiblissement. Cette fenêtre comporte un onglet distinct 
pour chaque bande de canal de sortie où sont affichés le 
gain, la polarité et les commandes de coupure pour les 
deux canaux d’entrée.

8. Bloc de gain de sortie : Double-cliquer sur ce bloc pour 
ouvrir la fenêtre « Output Gain » (Gain de sortie) qui offre 
des options de démultiplication de -10 dBV/+4 dBu, une 
coupure de canal, un contrôle de polarité, un atténuateur 
de -12 et de 18 dB et un affaiblissement de +10 dB/-l’infini 
pour chaque canal de sortie. Il s’agit de l’étage final de la 
structure de gain du processeur audio. C’est également là 
que l’on nomme les canaux de sortie.

9. Label de canal de sortie : Il affiche le label de canal 
spécifié dans la fenêtre « Output Gain ».

Barre d’état
Il s’agit de la partie inférieure de la fenêtre principale.

Mode Design Mode Live Mode Preview

1

2 3 4 6 7

8

9

5

FIGURE 1-4 : Bandes de canaux d’entrée et de sortie

1 2 3 4

FIGURE 1-5 : Barre d’état
11 Guide du logiciel DFR22 ©2003 Shure Incorporated



La fenêtre « Processor Toolbox »
1. Coupure des entrées : Cliquer sur cette commande 
pour couper instantanément les deux canaux d’entrée.

2. Coupure des sorties : Cliquer sur cette commande 
pour couper instantanément les deux canaux de sortie.

3. Compteur d’usage de traitement numérique des 
signaux : Il indique le pourcentage de ressources de trait-
ement numérique des signaux du DFR22 utilisé par la con-
figuration active des blocs processeur placés dans le 

diagramme de fluence. Ce compteur affiche une barre 
verte qui s’allonge au fur et à mesure que l’usage de traite-
ment numérique des signaux augmente.

4. Compteur de mémoire de délai : Il indique le 
pourcentage de mémoire de délai utilisé par les proces-
seurs de délai placés dans le diagramme de fluence. Ce 
compteur affiche une barre bleue qui s’allonge au fur et à 
mesure que l’usage augmente.

La fenêtre « Processor Toolbox »

La fenêtre « Processor Toolbox » apparaît à côté de la fenêtre principale lorsque l’application est lancée, comme illus-
tré à la figure 1-6. Cette fenêtre affiche la bibliothèque de processeurs qu'il est possible de glisser et de déplacer 
jusque sur les espaces vides du diagramme de fluence. Elle peut être redimensionnée par glissement de son bord 
supérieur ou inférieur vers le haut ou vers le bas. Une barre de défilement apparaît sur le côté droit pour permettre 
l’accès à tout bloc processeur, quelle que soit la hauteur de la fenêtre.

Affichage et masquage
La fenêtre « Processor Toolbox » peut être fermée en cliquant sur le [X]
situé dans le coin droit de la barre de titre, ou en choisissant [View>Show
Processor Toolbox] (Vue>Afficher la boîte à outils de processeur) dans le
menu principal. Pour réouvrir la fenêtre « Processor Toolbox », sélectionner
à nouveau [View>Show Processor Toolbox]. Une coche apparaît à côté de
l’option du menu lorsque la fenêtre « Processor Toolbox » est ouverte. 

Caractéristiques
1. Boutons d’affichage de liste déroulante : Un bouton d’affichage de 

liste déroulante apparaît au-dessus de chaque catégorie de proces-
seur dans la fenêtre « Processor Toolbox ». Cliquer sur un bouton 
d’affichage de liste déroulante pour afficher ou masquer tous les blocs 
processeur de cette catégorie.

2. Blocs processeur : Les blocs processeur sont la représentation 
graphique des modules processeur. Une fois qu’ils sont placés sur le 
diagramme de fluence, ils sont accessibles en double-cliquant sur 
chaque bloc pour ouvrir sa fenêtre de paramètres. Le pourcentage de 
ressources de traitement numérique des signaux utilisé par chaque module processeur est affiché à droite 
des blocs dans la fenêtre « Processor Toolbox ».

1

2

FIGURE 1-6 : La fenêtre 
« Processor Toolbox »
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SECTION 2 Guide de mise en route
Le Guide de mise en route traite des opérations de base à effectuer pour configurer le processeur audio. Il convient,
avant de suivre les instructions ci-après, de se familiariser avec la section Généralités, qui présente quelques fonctions
de base de l’interface logicielle.

Il est possible d’effectuer un grand nombre de ces opérations sans être connecté à l’appareil en enregistrant les
préréglages dans l’ordinateur et en les transférant ultérieurement dans le matériel. Afin de familiariser parfaitement
l’utilisateur avec les fonctions du DFR22, ces instructions ont été rédigées en supposant que les conditions suivantes
sont remplies :

• L’utilisateur travaille en étant connecté à l’appareil.
• L’installation inclut une commande de dispositif externe.
• La sécurité de l’appareil doit être établie.

Il se peut que certains éléments des instructions ne soient pas applicables à l’installation particulière. Nous conseillons
toutefois de lire le Guide de mise en route dans sa totalité afin de se familiariser avec le déroulement recommandé des
opérations de configuration de l’appareil pour pouvoir s’y référer plus tard.

Installation du logiciel

Si le logiciel n’est pas déjà installé, procéder comme suit pour installer l’application à partir du CD-ROM.

Pour installer le logiciel à partir du CD-ROM :
1. Insérer le CD dans le lecteur de l’ordinateur.
2. Le programme d’installation démarre automatiquement. Suivre les instructions affichées à l’écran.

Si l’installation ne démarre pas automatiquement :
1. Cliquer sur le bouton [Start] (Démarrer) de la barre des tâches de Windows et choisir [Run...] (Exécuter...) 

sur le menu déroulant
2. Taper « D:\setup » (où « D » est la lettre correspondant au lecteur de CD-ROM). Le programme d'installa-

tion démarre automatiquement. Suivre les instructions affichées à l’écran.
3. Cliquer sur [OK] et suivre les instructions du programme d’installation.

Si le logiciel a été téléchargé, localiser le fichier « .exe » dans l’Explorateur Windows et l’ouvrir. Suivre les instructions 
du programme d’installation.

Établissement de la communication avec l’appareil

Cette procédure est celle qu’il convient d’utiliser lors du branchement initial de l’ordinateur à l’appareil. Elle offre la 
première possibilité de vérifier que l’ordinateur et le DFR22 communiquent correctement. Pour de plus amples infor-
mations sur le branchement de l’ordinateur à l’appareil et la sélection du numéro de code de ce dernier, voir le Guide 
d’installation.

1. Brancher l’ordinateur au processeur audio DFR22.
Raccorder le port COM de l’ordinateur au port RS-232 du panneau frontal
ou arrière du DFR22.

2. Lancer l’application logicielle
3. Choisir le port COM

a) Choisir [Devices>Select COM Port] (Appareils>Choisir port COM) sur 
le menu principal.

b) La boîte de dialogue « COM Port » s’ouvre, comme illustré à la figure 2-1.
c) Choisir le port COM auquel le câble RS-232 est relié et cliquer sur [OK].

FIGURE 2-1 : Boîte de dialogue 
« COM Port »
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Configuration de la commande externe
4. Cliquer sur le bouton [Live Mode] de la barre de contrôle

5. Nommer l’appareil
a) Choisir [Devices>Name Device] sur le menu principal.
b) La boîte de dialogue « Name Device » s’affiche, comme illustré à la 

figure 2-2.
c) Taper un nom d’appareil d’une longueur maximum de quinze caractères 

et cliquer sur [Name] (Nom).
d) Le nom de l’appareil apparaît en mode Live sur la barre de titre de la 

fenêtre principale, ainsi que sur le menu [Devices].

Configuration de la commande externe

Si des dispositifs externes sont connectés aux broches de commande, le DFR22 doit être configuré pour qu’il identifie 
les contrôleurs externes. Cette configuration est stockée au niveau de l’appareil et doit être établie avant la création de 
tout préréglage. Si l’on n’est pas connecté à l’appareil, il est possible de créer une configuration et de l’enregistrer dans 
l’ordinateur pour la transférer ultérieurement dans le DFR22 par l’intermédiaire de la liaison RS-232. Voir la section 
Broches de commande à la page 89 pour des instructions complètes étape par étape.

1. Passer en mode Design
Il faut être en mode Design pour configurer la commande externe. Si l’on est en mode Live, cliquer sur le bou-
ton [Design Mode] de la barre de contrôle de la fenêtre principale.

2. Configurer les broches de commande
Choisir [Devices>Control Pin Configuration] (Appareils>Configuration des broches de commande) sur le menu
principal, ce qui ouvre la fenêtre « Control Pins » (Broches de commande).

a) Spécifier le nombre de préréglages qui seront choisis via la commande externe dans le champ [# Presets] 
(Nombre de préréglages).

b) Choisir le type de codage que le DFR22 doit utiliser pour reconnaître les messages du matériel externe 
dans le champ [Encoding Type] (Type de codage).

c) Au besoin, spécifier quel autre matériel est connecté pour la coupure de canaux et la commande de gain, 
comme par exemple des potentiomètres et des interrupteurs.

3. Enregistrer la configuration dans l’appareil ou l’ordinateur
Choisir l’option de menu [Configuration>Store to Device] (Configuration>Stocker dans l’appareil) ou [Configu-
ration>Save to PC] (Configuration>Enregistrer dans le PC).

Remarque : Il est possible de choisir des préréglages par défaut grâce au sélecteur de préréglage 
situé sur le panneau frontal du DFR22.

Remarque : S’il s’avère nécessaire de sortir des préréglages de l’ordinateur après avoir configuré les con-
nexions d’entrée de commande, il faut désactiver les connexions dans la fenêtre « Control 
Pins » avant d’aller plus loin. Cliquer sur la flèche se trouvant sur le côté droit du bloc de com-
mande de préréglage et choisir [Disable] (Désactiver) dans le menu déroulant.

FIGURE 2-2 : Boîte de dialogue 
« Name Device »
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Création d’un modèle de préréglage
Création d’un modèle de préréglage

Cette opération peut se faire en mode Live ou Design. Lorsqu’on stocke plusieurs préréglages dans le processeur 
audio, on gagne un temps considérable en créant un modèle de préréglage contenant les attributs qui leur seront com-
muns. Ce modèle peut être rappelé à partir de l’appareil ou ouvert à partir d’un PC, révisé selon le besoin, puis stocké 
dans l’appareil chaque fois comme nouveau préréglage.

1. Choisir un modèle de préréglage
Lors du démarrage de l’application DFR22, le diagramme de fluence contient un préréglage vierge. Pour uti-
liser l’un des autres préréglages par défaut comme modèle, choisir [File>New] (Fichier>Nouveau) dans le
menu principal, puis sélectionner [Dual Mono] (Mono double), [Stereo] (Stéréo) ou [Dual Mono Split] (Mono
double divisé). Il est également possible de passer en mode Live et de sélectionner l’un des préréglages incor-
porés à des fins d’édition. Pour de plus amples renseignements, voir la section Structure de gain à la page 18.

2. Nommer les canaux d’entrée et de sortie
Double-cliquer sur les blocs de gain d’entrée et de sortie pour ouvrir la fenêtre de paramètres du processeur et
éditer les labels de canaux qui apparaissent sous les commandes de gain. Pour de plus amples renseigne-
ments, voir la section Établissement de labels d’entrées et de sorties à la page 19.

3. Remplir le diagramme de fluence
Glisser et déplacer les blocs processeur de signal de la fenêtre « Processor Toolbox » jusque sur le dia-
gramme de fluence. En cas d’utilisation d’un filtre répartiteur, ce dernier doit être le premier type de processeur
placé dans la configuration, suivi des écrêteurs, afin d’éviter d’endommager les haut-parleurs. Pour de plus
amples renseignements, voir la section Ajout de processeurs modulaires à la page 22.

4. Créer des groupes de blocs liés
Appuyer sur Ctrl et cliquer pour choisir plusieurs processeurs du même type que l'on souhaite commander
comme un groupe pour des paires stéréo, groupes de haut-parleurs, zones, etc. Il est également possible de
relier des blocs de gain afin de contrôler le niveau global du système. Choisir [Processor>Link] (Proces-
seur>Lien) sur le menu principal. Pour de plus amples renseignements, voir la section Liaison à la page 25.

5. Engager les atténuateurs sur les sorties
Il peut s’avérer nécessaire d’engager l’atténuateur 12 ou 18 dB afin de mieux aligner le niveau d'écrêtage de
sortie du DFR22 avec le niveau d'écrêtage d’entrée de l’équipement auquel il est raccordé. Double-cliquer sur
un bloc de gain de sortie pour ouvrir la fenêtre « Output Gain » et cliquer pour activer chaque atténuateur selon
le besoin.

6. Diriger le signal des entrées aux sorties
Cliquer et déplacer des points de connexion des bandes d’entrée à ceux des bandes de sortie pour acheminer
le signal dans le mélangeur matriciel. Pour de plus amples renseignements, voir la section Acheminement du
signal à la page 20.

7. Régler les paramètres de processeur
Double-cliquer sur chaque bloc processeur pour ouvrir sa fenêtre de paramètres. Si l’on travaille hors ligne en
mode Design, il est possible de définir des niveaux préliminaires et de les mettre au point plus tard quand on
est connecté à l’appareil. Pour de plus amples informations sur l’utilisation des processeurs, voir la section
Fonctions du processeur à la page 35, ainsi que la section de référence correspondant à chaque processeur.

8. Établir une correspondance entre le préréglage et les connexions de commande
Cette mesure n'est applicable que lorsque l’on commande le gain et/ou la coupure de canaux via les broches
de commande. Choisir [Devices>Control Pin Configuration] sur le menu principal pour ouvrir la fenêtre « Con-
trol Pins ». Choisir [Configuration>Recall From Device] (Configuration>Rappeler à partir de l’appareil) pour
incorporer la configuration active des broches dans la fenêtre. Les canaux d’entrée et de sortie sont répertoriés
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Gestion des préréglages
dans une colonne sous chaque bloc de connexion. Cliquer sur la case se trouvant à côté de chaque canal
d’entrée ou de sortie pour lequel on veut établir une correspondance avec les connexions de commande. Pour
de plus amples renseignements, voir la section « Processor Mapping » à la page 97.

9. Verrouiller les processeurs en mode de consultation seule
Cette mesure n’est applicable que lorsque la sécurité est adaptée pour les utilisateurs finaux accédant au
DFR22 à partir du logiciel. Ce type de sécurité est stocké avec chaque processeur au niveau préréglé. Choisir
les processeurs que l'utilisateur ne doit pas pouvoir modifier et sélectionner [Security>Level 2>Lock Selected]
(Sécurité>Niveau 2>Verrouillage activé) sur le menu principal. Pour une explication complète et des instruc-
tions plus détaillées, voir la section Sécurité de processeur individuel à la page 103.

10. Nommer le préréglage
Cliquer une fois avec le bouton gauche de la souris en n'importe quel
point de la boîte d'information située au centre de la barre de contrôle
pour ouvrir la boîte de dialogue « Preset Information » (Informations
sur le préréglage), comme illustré sur la droite à la figure 2-3. Taper
un nom d'une longueur maximum de 15 caractères et une description
pour le préréglage, puis cliquer sur [OK]. Pour de plus amples
renseignements, voir la section Attribution d’un nom à un
préréglage à la page 21.

Gestion des préréglages

1. Stocker le préréglage terminé dans l’appareil
Si l’on travaille en mode Live, le préréglage est déjà stocké dans l’appareil. Si l’on travaille en mode Design,
cliquer sur le bouton [Store Preset] de la barre de contrôle de la fenêtre principale. Pour de plus amples
renseignements, voir la section Préréglages de l’appareil à la page 31. Il est nécessaire d’être en mode Design
pour reproduire ce préréglage. Il suffit de cliquer sur le bouton [Store Preset] et de créer ainsi des doubles
jusqu’à ce que le nombre nécessaire de préréglages soient stockés dans l’appareil.

2. Supprimer de l’appareil des préréglages non utilisés
L’appareil contient initialement trois préréglages incorporés. S’ils ne doivent pas être utilisés, il est conseillé de
les supprimer de l’appareil afin que les utilisateurs finaux ne puissent pas y accéder. (S’il s’avère nécessaire de
les utiliser plus tard, il est possible de les rappeler à l’aide du menu [File>New].) Voir la section Suppression
d’un préréglage à la page 32 pour obtenir les instructions correspondantes.

3. Activer la commande externe
Une fois que la création et l’édition des préréglages est terminée et si les connexions de commande ont été
désactivées précédemment pour commander le processeur audio par l’intermédiaire de l’ordinateur, ouvrir la
fenêtre « Control Pins » et les réactiver. Voir la section REMARQUE IMPORTANTE SUR LE PASSAGE D’UN
PRÉRÉGLAGE À UN AUTRE : à la page 91 pour de plus amples renseignements.

FIGURE 2-3 : Boîte de dialogue 
« Preset Information »
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Établissement de la sécurité
Établissement de la sécurité

Cette étape est la dernière de la configuration de l’appareil. Avant de continuer, lire attentivement la section Sécurité à 
la page 100. Ces instructions n’ont pour but que de donner une vue générale de la procédure.

1. Faire passer le DFR22 en mode Live
Il faut être en mode Live pour établir la sécurité de l’appareil. Si l’on est en mode Design, cliquer sur le bouton
[Live Mode] de la barre de contrôle de la fenêtre principale.

2. Établir le verrouillage du panneau frontal
Choisir [Security>Front Panel Lockout] (Sécurité>Verrouillage du panneau frontal) dans le menu principal, ce
qui ouvre la boîte de dialogue « Front Panel Lockout » (Verrouillage du panneau frontal). Sélectionner la case
se trouvant à côté de chaque fonction du panneau frontal dont on désire verrouiller l’accès aux utilisateurs
finaux. Utiliser cette fonction du logiciel pour verrouiller sélectivement les commandes du panneau frontal. Pour
verrouiller toutes les commandes du panneau frontal, il est également possible de régler en position basse le
cinquième micro-interrupteur situé à l’arrière de l’appareil.

3. Établir un mot de passe
Choisir [Security>Set Password] (Sécurité>Établir un mot de passe) sur le menu principal, ce qui ouvre la boîte
de dialogue « Create Password » (Créer un mot de passe). Taper un mot de passe, appuyer sur la touche Tab
(Tabulation) et le retaper pour le confirmer. Cliquer sur [OK].

4. Établir le niveau d’accès utilisateur
Choisir [Security>Set Level] (Sécurité>Établir un niveau) sur le menu principal, ce qui ouvre la boîte de dia-
logue « Set Security » (Établir la sécurité). Choisir le niveau d’accès utilisateur approprié. Cliquer sur [OK].
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SECTION 3 Création d’un préréglage
Un préréglage est une combinaison unique des connexions d’acheminement de signaux, de la variété et du placement
des processeurs modulaires et des paramètres des processeurs. La configuration est créée dans le diagramme de flu-
ence de la fenêtre principale et enregistrée soit comme préréglage dans l'appareil, soit comme fichier dans l'ordina-
teur, fichier qu’il est possible de transférer dans l’appareil ultérieurement.

Configuration de fluence

Pour qu’un signal audio traverse l’appareil, il faut diriger le signal des entrées aux sorties en connectant des points de 
mélange. Cette section décrit les principes de base de la conception d’une fluence dans l’interface utilisateur du DFR22.

Structure de gain
Le processeur audio DFR22 permet de contrôler le gain à trois étages de la fluence : gain d’entrée, mélangeur
matriciel et gain de sortie. Il est essentiel de bien comprendre cette structure de gain avant de faire traverser
l’appareil par un signal audio pour éviter d’endommager le matériel connecté en aval du processeur audio par
des niveaux excessifs de gain. L’illustration qui suit offre une vue générale de la structure de gain du DFR22.

1) Gain d’entrée
Double-cliquer sur tout bloc de gain d’entrée pour ouvrir la fenêtre « Input Gain » du processeur, ce qui
affiche les commandes des deux canaux. Cela permet de contrôler la sensibilité d’entrée, le gain et la
polarité pour chaque canal et de personnaliser les noms des bandes de canaux d’entrée.

Il s’agit du point d’entrée d’un signal dans le diagramme de fluence. À la sortie du processeur de gain
d’entrée, le signal traverse séquentiellement les espaces de processeur de sa bande de canal d’entrée. À
la fin de la bande de canal, le signal arrive à un point de mélange d’où il est possible de le diriger vers l’une
des sorties ou vers les deux via le mélangeur matriciel. 

2) Mélangeur matriciel
Une fois qu’un signal a été dirigé jusqu’au point de mélange d’une bande de canal de sortie, il pénètre
dans l’étage mélangeur matriciel de la structure de gain. Double-cliquer sur n’importe quel bloc de
mélange pour ouvrir la fenêtre « Matrix Mixer » du processeur, ce qui affiche une sous-fenêtre pour
chaque bande de canal de sortie. Lorsque le filtre répartiteur ou le séparateur est placé sur les deux
canaux de sortie, les sous-fenêtres du mélangeur correspondant à ces canaux se combineront en une
seule fenêtre. Utiliser cette fenêtre pour régler la polarité et les niveaux relatifs des entrées dirigées vers le
canal de sortie choisi.

À la sortie du mélangeur matriciel, le signal traverse séquentiellement les espaces de processeur de la
bande de sortie désignée. À la fin de la bande de canal, le signal arrive au bloc de gain de sortie.

Remarque : Les niveaux de signal dépassant le seuil d’entrée du processeur audio doivent faire l’objet d’un 
réglage externe pour empêcher un écrêtage aux convertisseurs analogiques/numériques. 

1 2 3

4

FIGURE 3-1 : Diagramme de la structure de gain
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Configuration de fluence
3) Gain de sortie
Il s’agit de l’étage final de la commande de gain du processeur audio. Double-cliquer sur tout bloc de gain
de sortie pour ouvrir la fenêtre « Output Gain ». Cela permet de contrôler la sensibilité de sortie, le gain et
la polarité et offre un atténuateur 12 et 18 dB en option pour chaque canal. Cette fenêtre permet également
de personnaliser les noms des bandes de canaux de sortie. À la sortie du processeur de gain de sortie, le
signal traverse le convertisseur numérique/analogique, puis passe à travers les atténuateurs analogiques
(s’ils sont engagés) jusqu’à la sortie audio.

4) Connexion d’acheminement de signal
Elle peut être créée dans le diagramme de fluence en cliquant et glissant entre les points de mélange, en
cliquant sur un sélecteur d’entrée situé directement à gauche du bloc MIX (Mélange), ou en ouvrant la
fenêtre « Matrix Mixer » et en sélectionnant l’entrée. Pour de plus amples renseignements, voir la section
Acheminement du signal à la page 20.

Coupure des canaux
Les canaux d’entrée et de sortie du processeur audio peuvent être coupés de plusieurs façons. Les canaux
coupés sont signalés dans le diagramme de fluence comme illustré sur le tableau ci-dessous.

Coupure de toutes les entrées ou sorties
• Cliquer sur la commande Mute All Inputs (Couper toutes les entrées) ou sur la commande Mute All 

Outputs (Couper toutes les sorties) situées sur la barre d’état de la fenêtre principale.

• Choisir soit l’option de menu [Processor>Mute All Inputs] (Processeur>Couper toutes les entrées), soit 
l’option de menu [Processor>Mute All Outputs] (Processeur>Couper toutes les sorties).

• Mettre l’appareil hors tension pour couper automatiquement toutes les sorties.

Coupure de canaux individuels
1. Ouvrir la fenêtre « Input Gain », « Matrix Mixer », « Crossover » (Filtre répartiteur) ou « Output Gain » 

en double-cliquant sur le bloc processeur approprié.
2. Cliquer sur le bouton de coupure correspondant au canal approprié.
3. Le bloc est signalé par un « M » rouge pour indiquer qu’il est coupé.

Établissement de labels d’entrées et de sorties
Les entrées et sorties sont sans titre lorsqu’on crée un nouveau préréglage, mais il est facile de leur en attri-
buer un à l’aide des fenêtres « Input Gain » et/ou « Output Gain ». Les labels de canaux sont enregistrés en
même temps que le préréglage, ce qui permet d’attribuer aux entrées et sorties de chaque préréglage des
labels qui leur sont propres.

Pour changer le label d’un canal :
1. Double-cliquer sur le bloc de gain du canal.
2. Localiser la boîte de label du canal dans la fenêtre du processeur.
3. Cliquer et glisser le curseur sur le texte pour mettre ce dernier en surbrillance.
4. Taper un nouveau label de quinze caractères au maximum.
5. Mettre les changements en vigueur en cliquant sur une autre commande ou en refermant la fenêtre.

Bloc de gain Entrées vers le 
mélangeur matriciel

Canaux de sortie des 
filtres répartiteurs

Entrées et sorties coupées
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Configuration de fluence
Acheminement du signal
Le DFR22 permet de diriger le signal de l'une quelconque des deux entrées vers l'une quelconque des sorties
ou vers les deux. Pour que le signal passe des bandes de canaux d’entrée à celles de canaux de sortie, il doit
traverser le mélangeur matriciel. Il est possible de connecter les entrées aux sorties en utilisant l’une
quelconque des méthodes décrites ci-après.

Réalisation de connexions dans le diagramme de fluence
Pour les configurations système les plus simples, la façon la plus facile de connecter les entrées aux sor-
ties consiste à le faire à l’aide de la souris dans le diagramme de fluence.

Cliquer sur des points de mélange :
1. Cliquer sur un point de mélange d’entrée.
2. Le curseur change pour indiquer qu’il attend 

la désignation d’une connexion de sortie :
3. Cliquer sur un point de mélange de sortie.

Cliquer et glisser entre points de mélange :
1. Cliquer et glisser d’un point de mélange d’entrée à un point de mélange de sortie. 
2. Une ligne de connexion apparaît le long du chemin de signal. Elle devient verte lorsque la connexion 

est validée.
3. Relâcher le bouton de la souris pour réaliser la connexion.

Cliquer sur les sélecteurs d’entrée :
1. Cliquer sur un sélecteur d’entrée de canal de sortie dont le numéro correspond 

au canal d’entrée.
2. Une ligne de connexion apparaît dans le diagramme de fluence entre les points 

de mélange et le sélecteur d’entrée numéroté est mis en surbrillance.

Réalisation de connexions dans la fenêtre « Matrix Mixer »
Dans le cas de configurations plus complexes dans lesquelles de nombreuses lignes de connexion se
croisent, la fenêtre « Matrix Mixer » peut offrir une méthode plus facile de connexion des entrées aux sorties.

Pour réaliser des connexions dans le mélangeur matriciel :
1. Double-cliquer sur le bloc de mélange correspondant à la sortie que l’on désire connecter.
2. La fenêtre « Matrix Mixer » s’ouvre.
3. Dans la partie gauche de la fenêtre, cliquer sur le bouton d’entrée correspondant à chaque canal 

d’entrée que l’on veut connecter à la sortie sélectionnée. Le bouton d’entrée s'allume en vert lor-
squ’une connexion est établie.

4. Une ligne de connexion apparaît dans le diagramme de fluence entre les points de mélange et le 
sélecteur d’entrée numéroté est mis en surbrillance pour chaque connexion active. 

Suppression de connexions
• Cliquer sur une ligne de connexion et appuyer sur la touche Suppr. 
• Cliquer sur le sélecteur d’entrée correspondant à la connexion. Cela désactive la connexion.
• Cliquer avec le bouton droit de la souris sur une ligne de connexion et utiliser le menu contextuel qui 

apparaît.
• Choisir plusieurs connexions en maintenant la touche Ctrl enfoncée tout en cliquant sur ces connex-

ions, puis appuyer sur la touche Suppr.

Conseil ! Il est possible d’annuler une connexion à l’aide de la touche Echap si on change d’avis 
après avoir cliqué sur un point de mélange d’entrée, avant de cliquer sur un point de 
mélange de sortie.
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Configuration des processeurs
Attribution d’un nom à un préréglage
Dans la mesure où il est possible de stocker jusqu’à 16 préréglages différents dans le DFR22, il peut être utile
de les différencier grâce à un nom et à une brève description. Ces détails sont affichés dans la boîte d’informa-
tion située au milieu de la barre de contrôle de la fenêtre principale, comme illustré ci-dessous à la figure 3-2.

Le nom tapé dans cette boîte de dialogue devient à la fois le nom du préréglage lors du stockage de la config-
uration dans l’appareil et celui du fichier lors de l’enregistrement de ce préréglage dans l'ordinateur. La descrip-
tion s’affiche également dans toutes les boîtes de dialogue contenant une liste des préréglages. Ces détails
peuvent être révisés à tout moment en mode Live ou Design.

Pour attribuer un nom à un préréglage :
1. Cliquer une fois avec le bouton gauche de la souris en n’importe 

quel point de la boîte d’information.
2. La boîte de dialogue « Preset Information » s’ouvre.
3. Taper un nom et une description de 15 et 80 caractères au maxi-

mum respectivement.
4. Cliquer sur [OK]
5. La boîte d’information est mise à jour pour refléter les 

changements.

Configuration des processeurs

L’exploitation des processeurs s’effectue à deux niveaux : au niveau configuration dans le diagramme de fluence et 
dans la fenêtre de paramètres individuelle de chaque processeur, que l’on ouvre en double-cliquant sur le bloc proces-
seur. Cette section traite de l’exploitation de processeurs dans le diagramme de fluence et explique les différences qui 
existent entre les deux catégories principales de processeurs.

Types de processeurs
On utilise deux types principaux de processeurs dans le diagramme de fluence : fixes et modulaires. Ils se dis-
tinguent principalement par le fait que les processeurs fixes font partie de la structure de gain du DFR22 et par
conséquent de chaque configuration de fluence. Les processeurs modulaires sont les blocs processeur réper-
toriés dans la fenêtre « Processor Toolbox » et que l'on choisit et positionne en fonction des exigences d'un
système particulier.

Processeurs fixes
Les blocs de gain et de mélange sont appelés processeurs fixes parce que leur implantation sur les
bandes de canaux est permanente. Il est impossible de les supprimer, de les déplacer, de les copier ou de
les coller. Il est toutefois possible de les lier, ainsi que d’enregistrer et de rappeler leurs paramètres.

Processeurs modulaires
Les blocs processeur modulaires sont appelés ainsi parce qu’il est possible de les placer sur tout espace
vide (sauf le filtre répartiteur, le séparateur, le caisson de graves et l’atténuateur), ainsi que de les
déplacer, de les copier, de les coller et de les supprimer. Chaque bloc processeur figurant sur le dia-
gramme de fluence fonctionne de façon indépendante. Lorsqu’on ouvre la fenêtre de paramètres d’un pro-
cesseur modulaire, seuls les paramètres de ce bloc sont modifiés, sauf dans les situations suivantes.

• Le processeur représente la moitié d’une paire stéréo.
• Il est affecté à un groupe de blocs liés.

FIGURE 3-2 : La boîte d’information

FIGURE 3-3 : Boîte de dialogue 
« Preset Information »
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Configuration des processeurs
Ajout de processeurs modulaires
Chaque bande de canal comporte une rangée d’espaces vides pouvant contenir n’importe quel bloc proces-
seur modulaire. En dehors du filtre répartiteur, du séparateur, du caisson de graves et de l’atténuateur, il n’y a
aucune restriction en matière d’implantation des processeurs sur le diagramme de fluence ou de nombre d’util-
isations possibles d’un processeur donné sur une même bande de canal. Les espaces vides entre processeurs
n’affectent pas la fluence ; les blocs n’ont donc pas besoin d’être contigus sur les bandes de canaux.

Lorsque des blocs processeur sont ajoutés initialement au diagramme de fluence, leurs paramètres sont ceux
qui sont établis par défaut à l’usine. Il est possible de changer individuellement les paramètres de chaque pro-
cesseur en ouvrant sa fenêtre de paramètres. Les blocs conservent leurs paramètres, même lorsqu’ils sont
copiés ou déplacés dans un espace différent.

Il est possible d’ajouter des blocs processeur au diagramme de fluence à l’aide de la fenêtre « Processor Tool-
box » ou d’une commande sur menu. Chacune de ces méthodes est décrite ci-après.

Utilisation de la fenêtre « Processor Toolbox »
La souris peut être utilisée pour saisir un bloc processeur et l’extraire de la fenêtre « Processor Toolbox ».
Le curseur de la souris change pour indiquer que l’action suivante de la souris placera le bloc dans le dia-
gramme de fluence. L’aspect du curseur dépend de sa position, comme illustré sur le tableau ci-dessous.

Pour ajouter un bloc processeur extrait de la fenêtre « Processor Toolbox » :
1. Pointer et cliquer sur un bloc processeur dans la fenêtre « Processor Toolbox ».
2. Maintenir le bouton de la souris enfoncé et faire glisser le bloc jusqu’au diagramme de fluence.
3. Relâcher le bouton de la souris pour placer le bloc à l’endroit où se trouve le curseur.

- OU -

1. Pointer et cliquer sur un bloc processeur dans la fenêtre « Processor Toolbox ».
2. Cliquer sur l’espace vide approprié dans le diagramme de fluence.

Utilisation d’une commande sur menu
Il est possible d’ajouter des processeurs au diagramme de fluence sans ouvrir la fenêtre « Processor Tool-
box », à l’aide du menu principal ou du menu contextuel que l’on fait apparaître en cliquant avec le bouton
droit de la souris, comme indiqué ci-dessous.

Pour ajouter un bloc processeur à l’aide du menu :
1. Cliquer pour choisir un espace vide.
2. Utiliser le menu contextuel que l’on fait apparaître en cliquant avec le bouton droit de la souris pour 

choisir un processeur.
- OU -
Utiliser l’option [Processor>Add] de la barre de menu principal.

Un autre avantage offert par l’utilisation d’une commande sur menu pour placer des blocs processeur est
la possibilité de placer le même type de processeur dans plusieurs espaces à l’aide d’une même com-
mande sur menu.

Implantation possible du 
processeur.

Implantation inappropriée 
pour ce processeur.

Conseil !Si l’on change d’avis après avoir cliqué sur un bloc processeur dans la fenêtre « Processor Toolbox 
», on peut appuyer sur la touche Echap pour annuler cette opération avant de placer le bloc pro-
cesseur dans le diagramme de fluence.
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Configuration des processeurs
Pour ajouter plusieurs blocs processeur à la fois :
1. Appuyer sur Ctrl et cliquer pour sélectionner plusieurs espaces vides.
2. Utiliser le menu contextuel que l’on fait apparaître en cliquant avec le bouton droit de la souris pour 

choisir un processeur.
- OU -
Utiliser l’option [Processor>Add] de la barre de menu principal.

3. Le processeur viendra remplir tous les espaces sélectionnés.

Processeurs stéréo
Les processeurs stéréo sont placés dans le diagramme de fluence pratiquement de la même façon que
n'importe quel autre bloc processeur modulaire. Chacun des canaux stéréo apparaît toutefois comme un
bloc distinct. Double-cliquer sur l’un ou l’autre des blocs pour ouvrir la fenêtre de paramètres des deux
canaux.

Chacun des processeurs suivants fonctionne comme paire stéréo :

Pour ajouter un bloc processeur stéréo extrait de la fenêtre « Processor Toolbox » :
1. Cliquer sur un bloc processeur stéréo dans la fenêtre « Processor Toolbox ».

Lorsqu’un processeur stéréo est choisi dans la fenêtre « Processor Toolbox », l’aspect du curseur est
quelque peu différent de ce qu’il est pour d’autres processeurs, comme illustré sur le tableau ci-dessous.

2. Ajouter le premier canal de la paire stéréo en appliquant l'une des méthodes suivantes.
a) Cliquer avec le bouton gauche de la souris et le maintenir enfoncé pour faire glisser un bloc pro-

cesseur de la fenêtre « Processor Toolbox » jusqu’au diagramme de fluence.
b)  Relâcher le bouton de la souris pour placer le premier canal du processeur à l’endroit où se trouve 

le curseur.
- OU -

a) Cliquer une fois sur un bloc processeur dans la fenêtre « Processor Toolbox ».
b) Cliquer à nouveau sur l’espace vide approprié dans le diagramme de fluence.

3. Le curseur change pour indiquer que le deuxième canal du processeur doit être placé.
4. Cliquer sur l’espace approprié pour ajouter le deuxième canal stéréo. 

Pour ajouter un processeur stéréo à l’aide du menu :
1. Appuyer sur Ctrl et cliquer pour choisir des espaces vides sur deux canaux différents.
2. Utiliser le menu contextuel que l'on fait apparaître en cliquant avec le bouton droit de la souris pour 

placer les deux canaux de la paire stéréo.
- OU -
Utiliser l’option [Processor>Add] de la barre de menu principal.

Nom de bloc Description
ST DFR 5 Réducteur numérique de Larsen stéréo 5 bandes
ST DFR 10 Réducteur numérique de Larsen stéréo 10 bandes
ST DFR 16 Réducteur numérique de Larsen stéréo 16 bandes
ST COMP Compresseur stéréo
Sft ST COMP Compresseur stéréo avec Soft-Knee
ST LIM Écrêteur stéréo
Sft ST LIM Écrêteur stéréo avec Soft-Knee

Implantation possible du premier canal 
du processeur stéréo.

Implantation possible du deuxième canal 
du processeur stéréo.
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Configuration des processeurs
Remplacement de processeurs
Un seul bloc processeur peut occuper un espace donné à un moment donné. Pour remplacer un proces-
seur existant par un autre, commencer par le supprimer de l’espace, puis ajouter le nouveau processeur à
l’aide de l’une quelconque des méthodes décrites plus haut.

Le filtre répartiteur, le séparateur et le caisson de graves
Étant des processeurs de sortie, le filtre répartiteur, le séparateur et le caisson de graves peuvent être
placés uniquement sur des bandes de canaux de sortie. Ils peuvent être ajoutés à des bandes de sortie
comme n’importe quel autre bloc processeur mais les points suivants doivent être pris en considération :

• Le filtre répartiteur se prolonge vers le bas pour recouvrir les deux sorties, et il doit donc être placé 
sur le canal nº 1.

• Le point de mélange disparaît du deuxième canal après le placement du filtre répartiteur au-des-
sus de lui.

• Les espaces de processeurs disparaissent du deuxième canal, à gauche du bloc du filtre répartiteur.
• Le séparateur affecte le diagramme de fluence de la même manière que le filtre répartiteur 

(voir ci-dessus).

L’atténuateur
L’atténuateur ne doit être placé que sur la bande de canal d'entrée qui achemine le signal de téléavertisse-
ment. Le placement d’un atténuateur sur une bande de sortie n’est pas possible.

Copie et collage
Les commandes copier, couper et coller traditionnelles ne fonctionnent que sur les blocs processeur modu-
laires. Elles constituent un moyen commode de reproduire des blocs processeur, ainsi que leurs paramètres,
dans plusieurs canaux.

Pour copier et coller un bloc processeur :
1. Pointer et cliquer pour choisir un bloc processeur.
2. Choisir la commande copier en appliquant l’une des méthodes suivantes :

• Utiliser le menu contextuel que l'on fait apparaître en cliquant avec le bouton droit de la souris.
• Choisir [Edit>Copy] (Édition>Copier) sur le menu principal.
• Appuyer sur Ctrl + C sur le clavier.

3. Pointer et cliquer pour choisir un espace vide.
4. Choisir la commande coller à l'aide du menu principal ou du menu que l'on fait apparaître en cliquant avec 

le bouton droit de la souris, ou en appuyant sur Ctrl + V.

Suppression des processeurs des espaces
Il est facile de retirer des blocs processeur modulaires d’une configuration sans affecter un autre aspect du dia-
gramme de fluence. 

Pour supprimer un bloc processeur :
1. Pointer et cliquer pour choisir un bloc processeur.
2. Choisir la commande supprimer en appliquant l’une des méthodes suivantes :

• Utiliser le menu contextuel que l'on fait apparaître en cliquant avec le bouton droit de la souris.
• Choisir [Edit>Delete] (Édition>Supprimer) sur le menu principal.
• Appuyer sur la touche Suppr.

Remarque : Si la configuration demande un filtre répartiteur ou un séparateur, il doit être ajouté au dia-
gramme de fluence avant de connecter les points de mélange ou d’ajouter d’autres proces-
seurs aux bandes de canaux de sortie.

Remarque : Ces commandes ne fonctionnent pas avec des sélections multiples.
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Configuration des processeurs
Liaison
Il est possible de lier plusieurs blocs processeur du même type pour les commander en bloc. Les changements
effectués dans la fenêtre de paramètres de processeur de tout bloc lié d’un groupe modifient simultanément
les paramètres de tous les autres blocs de ce groupe. Cependant, quelques activités fonctionnent indépen-
damment sur des blocs liés :

• Suppression, copie, coupe et collage,
• Transfert du bloc dans un espace ou une bande de canal différent(e),
• Attribution d’un nom à la fenêtre de paramètres de processeur.

Les processeurs fixes implantés au même étage de la structure de gain peuvent également être groupés, ce
qui permet de synchroniser les commandes de niveau pour tous les canaux groupés. Il est par exemple possi-
ble de grouper deux blocs de gain d’un canal d’entrée pour les commander comme paire stéréo. On peut
également lier les deux blocs de gain de sortie pour régler globalement les niveaux des canaux de sortie à
l’aide d’une même commande.

Création d’un groupe de blocs liés
Lors de la création initiale d’un groupe de blocs liés, tous les processeurs de ce groupe se synchronisent
en fonction des mêmes paramètres. Si des paramètres ont déjà été spécifiés pour l’un des processeurs
avant la création du groupe, il est possible de désigner ce processeur comme source lors de la création ini-
tiale du groupe, ce qui fait hériter les autres blocs processeur de ces paramètres. De même, si l’on désire
supprimer tous les paramètres de processeurs existants, il est possible de choisir les paramètres établis
par défaut à l’usine comme source initiale. Une fois le groupe de blocs liés créé, les changements apportés
aux paramètres de l’un quelconque de ces blocs affecteront tous les blocs de ce groupe.

Pour créer un groupe de blocs liés :
1. Appuyer sur Ctrl et cliquer pour sélectionner plusieurs blocs 

processeur.
2. Choisir [Processor>Link>New Link Group] (Processeur>Liai-

son>Nouveau groupe de blocs liés) sur le menu principal ou 
[Link>New Link Group] (Liaison>Nouveau groupe de blocs 
liés) sur le menu contextuel que l'on fait apparaître en cli-
quant avec le bouton droit de la souris.

3. La boîte de dialogue « Create Link Group » (Créer un groupe 
de blocs liés) apparaît, comme illustré sur la droite à la 
figure 3-4.

4. Taper un nom de deux caractères pour le groupe de blocs liés.
5. Choisir une source de paramètres initiaux pour le groupe de 

blocs liés.
6. Cliquer sur [OK] pour accepter les paramètres.

Le nom de groupe de blocs liés à deux caractères apparaît sur le bloc processeur dans le diagramme de
fluence et dans l’indicateur de liens situé dans l’angle inférieur droit de la fenêtre de paramètres de proces-
seur, comme illustré sur le tableau ci-dessous.

Remarque : Seuls des processeurs exactement du même type peuvent être liés.

Fenêtre de paramètres de processeur Diagramme de fluence

Remarque : Les processeurs ne peuvent appartenir qu’à un seul groupe 
de blocs liés à la fois.

FIGURE 3-4 : Boîte de dialogue 
« Create Link Group »
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Configuration des processeurs
Ajout à un groupe de blocs liés
Des blocs processeur peuvent être ajoutés à un groupe existant de blocs liés s’ils sont exactement du
même type que ces derniers et qu’ils ne sont pas déjà liés. Tout processeur ajouté à un groupe de blocs
liés hérite des paramètres en vigueur de ce groupe.

Pour ajouter des blocs à un groupe existant de blocs liés :
1. Cliquer pour choisir un bloc processeur ou appuyer sur Ctrl 

et cliquer pour en choisir plusieurs.
2. Choisir [Processor>Link>Add To] (Processeur>Liai-

son>Ajouter à) sur le menu principal ou [Link>Add To] (Liai-
son>Ajouter à) sur le menu contextuel que l'on fait apparaître 
en cliquant avec le bouton droit de la souris.

3. La boîte de dialogue « Add to Link Group » (Ajout à un 
groupe de blocs liés) apparaît, comme illustré à la figure 3-5. 
Elle n'indique que les groupes de blocs liés qui contiennent 
des processeurs de type identique à celui du bloc choisi.

4. Choisir un groupe de blocs liés.
5. Cliquer sur [OK]

Suppression d’une liaison entre blocs processeur
Il est possible de retirer des blocs processeur d’un groupe de blocs liés sans affecter les autres blocs de ce
groupe. Il est également possible de dissoudre un groupe de blocs liés en supprimant la liaison entre tous
les blocs de ce groupe. 

Pour retirer des blocs d’un groupe existant de blocs liés :
1. Cliquer pour choisir un bloc processeur ou appuyer sur Ctrl et cliquer pour en choisir plusieurs.
2. Choisir [Processor>Link>Unlink] (Processeur>Liaison>Supprimer la liaison) sur le menu principal ou 

[Link>Unlink Selected] (Liaison>Supprimer la liaison pour les blocs choisis) sur le menu contextuel que 
l'on fait apparaître en cliquant avec le bouton droit de la souris.

Contournement
Il est possible de contourner tout bloc processeur modulaire dans la fenêtre principale. Cela permet d’évaluer
le chemin du signal en excluant provisoirement un processeur. Les blocs contournés sont signalés dans le dia-
gramme de fluence par un indicateur jaune, comme illustré à la figure 3-6.

Pour activer et désactiver le contournement :
1. Cliquer pour choisir un bloc processeur ou appuyer sur Ctrl et cliquer pour en 

choisir plusieurs.
2. Activer le contournement en appliquant l’une quelconque des méthodes suivantes :

• Appuyer sur Ctrl + B sur le clavier.
• Choisir [Processor>Bypass Selected] (Processeur>Contourner les blocs 

choisis) sur le menu principal.
• Choisir [Bypass Selected] (Contourner les blocs choisis) sur le menu contextuel que l'on fait apparaître 

en cliquant avec le bouton droit de la souris.

Gestion des ressources de traitement numérique des signaux
Bien que la puissance de traitement du DFR22 soit suffisante pour de nombreuses applications, il est possible
de remplir le diagramme de fluence d’un nombre de blocs processeur dépassant les ressources de traitement
numérique des signaux de l’appareil. Cette section explique en termes généraux la façon dont le processeur
audio gère les besoins de traitement de signaux d’une configuration et offre quelques suggestions sur la façon
d’exploiter au maximum les ressources de traitement numérique des signaux.

Remarque : Un groupe de blocs liés doit contenir au moins deux blocs processeur. Le retrait de tous les 
blocs sauf un d’un groupe de blocs liés supprime ce groupe.

FIGURE 3-5 : Boîte de dialogue 
« Add to Link Group »

FIGURE 3-6 : Bloc processeur 
contourné
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Configuration des processeurs
Affectation des ressources
Il suffit de placer un bloc processeur sur une bande de canal pour affecter les ressources de traitement
numérique des signaux nécessaires pour que le processeur tourne au maximum de sa capacité. C’est la rai-
son pour laquelle autant de variétés du même type de blocs processeur sont offertes, ce qui permet de ne
choisir que la capacité de traitement réellement nécessaire pour un module donné. Lorsqu’une configuration
est simple, il n’est pas très important de se préoccuper de la capacité de traitement numérique des signaux
utilisée. Cependant, plus la configuration est compliquée, plus il est important de choisir des blocs processeur
qui utilisent le minimum de ressources de traitement nécessaire pour exécuter la tâche qui doit l’être.

Par exemple : lorsque l’on place un égaliseur paramétrique à dix bandes sur une bande de canal, on
affecte instantanément la puissance de traitement exigée par les dix filtres, même si on n’en utilise que
quatre. Le PEQ5 serait alors le meilleur choix.

Mémoire de délai
Le DFR22 dispose d’une mémoire tampon d’une capacité maximum de 10 secondes de délai qu’il est pos-
sible de diviser entre les processeurs de délai, quelle qu’en soit la combinaison. Comme les ressources de
traitement numérique des signaux, la mémoire de délai est affectée à chaque bloc processeur en fonction
du délai maximum indiqué dans le nom du bloc. 

Par exemple, si l'on a besoin d'un délai de 45 ms, ne pas utiliser celui de 2 secondes alors que celui de
150 ms fera tout aussi bien l'affaire. Bien que les deux processeurs puissent être réglés aux mêmes
valeurs, le bloc DLY 2s occupe deux secondes complètes de mémoire de délai.

Compteurs d’usage de traitement numérique des signaux
Ces compteurs situés sur la barre d’état au bas de la fenêtre principale indiquent la quantité de ressources
de traitement numérique des signaux et la mémoire de délai utilisées par la configuration active. La con-
naissance de ces deux paramètres permet une gestion efficace des choix de processeurs. Lorsqu’on
ajoute ou retire un bloc processeur sur le diagramme de fluence, le compteur de ressources de traitement
numérique des signaux compile instantanément les résultats et indique les ressources système utilisées
par la configuration de processeur active.

Conseils d’optimisation des ressources de traitement numérique des signaux
Si la boîte de messages illustrée à la figure 3-7 apparaît lorsqu'on
essaye d'ajouter un processeur, il faut optimiser la configuration
pour libérer une partie des ressources de traitement numérique
des signaux, puis ajouter le processeur. Les conseils qui suivent
doivent aider à optimiser l’usage des ressources de traitement
numérique des signaux.

• Remplacer les réducteurs numériques de Larsen par des égali-
seurs paramétriques une fois la limitation du système effectuée.

Par exemple : dans une configuration dans laquelle plusieurs
réducteurs numériques de Larsen sont nécessaires sur plu-
sieurs entrées pour améliorer les performances de gain avant
Larsen, on peut utiliser initialement un réducteur sur chaque
entrée pour effectuer la limitation du système. Une fois les filtres déployés, copier les filtres de Larsen
et les coller dans un égaliseur paramétrique, puis supprimer le réducteur numérique de Larsen. On
peut répéter cette opération pour l’autre entrée, puis ne laisser que les réducteurs numériques de
Larsen requis pour la détection automatique de Larsen, lorsque la configuration du système a été réal-
isée. Pour de plus amples renseignements sur la façon de copier et de coller des filtres d’un proces-
seur à un autre, voir la section Copie et collage à la page 73.

• Regrouper plusieurs égaliseurs se trouvant sur un même chemin de signal dans un même module, si 
cela est possible.

Remarque : Ne pas confondre mémoire de délai et ressources de traitement numérique des signaux. 
Chaque délai utilise la même capacité de traitement numérique des signaux, quelle que soit 
sa longueur maximum.

FIGURE 3-7 : Ressources de traitement 
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Configuration des processeurs
Exemple : deux PEQ3 utilisent plus de ressources de traitement numérique des signaux qu’un PEQ7.
Noter que tous les égaliseurs paramétriques sont proposés avec des filtres passe-haut et passe-bas et
de dégradé afin d’économiser ces ressources. Si l’on n’a pas besoin des choix supplémentaires de
pente offerts par le processeur PASSE-HAUT/PASSE-BAS/DÉGRADÉ, il n’est pas nécessaire
d’inclure des filtres passe-haut et passe-bas et de dégradé dans un module séparé sur le même
chemin de signal.

• Regrouper plusieurs processeurs de délai se trouvant sur un même chemin de signal dans un même 
module, si cela est possible. L’utilisation de deux blocs DLY5ms pour obtenir un délai de 7 ms con-
somme deux fois plus de ressources de traitement numérique des signaux que l’emploi d’un seul bloc 
DLY150ms, même si cela économise de la mémoire de délai.

• Retirer les processeurs de tout canal inutilisé.
• Utiliser le séparateur pour regrouper un même traitement de signaux effectué sur les deux canaux de 

sortie.
• Utiliser un PEQ10 au lieu d’un GEQ30. Dans la plupart des cas, on n’utilise pas l’ensemble des trente 

filtres du GEQ30 et le PEQ10 utilise moins de la moitié des ressources de traitement numérique des 
signaux.
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Préréglages par défaut
Préréglages par défaut

Pour aider l’utilisateur à se familiariser aux configurations de base, le DFR22 contient initialement trois préréglages par 
défaut incorporés. Ces préréglages sont également répertoriés dans le sous-menu [File>New], ce qui permet d’utiliser 
n’importe lequel d’entre eux comme modèle pour créer un nouveau préréglage.

Préréglage nº 1 – [Dual Mono] (Mono double)
Dans cette configuration, le signal arrivant à l’entrée nº 1 est acheminé vers la sortie nº 1 et celui arrivant à
l’entrée nº 2 est acheminé vers la sortie nº 2. Chaque bande d’entrée contient les processeurs suivants :

• DFR16 - affecté aux commandes du panneau frontal
• PEQ10+CS
• GEQ30
• LIM

De plus, chaque bande de sortie est dotée d’un processeur de délai de 2 secondes, réglé à 0 ms par défaut. 

Préréglage nº 2 – [Stereo] (Stéréo)
Dans cette configuration, le signal arrivant à l’entrée nº 1 est acheminé vers la sortie nº 1 et celui arrivant à
l’entrée nº 2 est acheminé vers la sortie nº 2. Les canaux d’entrée sont liés entre eux, de même que les canaux
de sortie, ce qui permet de contrôler le gain sur les deux canaux simultanément, à la fois à l’étage d’entrée et à
l’étage de sortie de la structure de gain.

Les bandes d’entrée contiennent les processeurs suivants :

• DFR16 stéréo - affecté aux commandes du panneau frontal
• Des PEQ10+CS liés
• Des GEQ30 liés
• Écrêteur stéréo

De plus, les bandes de sortie sont dotées de processeurs de délai de 2 secondes liés, réglés à 0 ms par défaut

Préréglage nº 3 – [Dual Mono Split] (Mono double divisé)
Dans cette configuration, le signal arrivant à l’entrée nº 1 et celui arrivant à l’entrée nº 2 sont chacun achem-
inés vers les deux sorties. La bande d’entrée contient les processeurs suivants :

• DFR16 - affecté aux commandes du panneau frontal
• PEQ10+CS
• GEQ30
• LIM

De plus, chaque bande de sortie est dotée d’un processeur de délai de 2 secondes, réglé à 0 ms par défaut.

Remarque : Il est recommandé soit de verrouiller le sélecteur de préréglage du panneau frontal, soit 
de supprimer de l’appareil les préréglages par défaut qui ne sont pas utilisés, afin que les 
utilisateurs finaux n’y accèdent pas par erreur.
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SECTION 4 Gestion des préréglages et de l’appareil
En mode Design, il est possible d’enregistrer un préréglage après sa création, soit sur l’ordinateur, soit sur l’appareil,
selon que l’on est ou non raccordé au DFR22. À tout moment, un seul et unique préréglage est actif dans le DFR22. Il
est désigné sous le nom de préréglage actif. En mode Live, le préréglage qu’il est possible de visualiser ou de modifier
est en fait le préréglage actif. Il est possible de l’enregistrer dans l’ordinateur à tout moment en cliquant sur le bouton
[Save As] de la barre de contrôle de la fenêtre principale.

Fichiers de préréglages

Il est possible de créer une bibliothèque complète de préréglages à l’aide du logiciel du DFR22 sans être connecté à 
l’appareil. Les préréglages enregistrés sur l'ordinateur peuvent être rappelés, révisés puis transmis plus tard à l'appar-
eil. Ils sont enregistrés avec une extension « .d22 ».

Enregistrement d’un nouveau préréglage sur l’ordinateur
Si l'on n'est pas connecté à l'appareil, chaque nouveau préréglage est enregistré sur l’ordinateur.

Pour enregistrer un nouveau préréglage sur l’ordinateur :
1. Dans la fenêtre principale, choisir [File>Save As] (Fichier>Enregistrer sous) sur le menu principal ou 

cliquer sur le bouton [Save As] de la barre de contrôle.
2. La boîte de dialogue « Save As » apparaît.
3. Passer à l’unité de lecture et au répertoire destiné au nouveau fichier.
4. Taper un nom de fichier et, si on le désire, une description.
5. Cliquer sur [Save] (Enregistrer).

Révision des fichiers de préréglages
Lorsqu’on apporte des changements à un préréglage existant, il est possible de l’enregistrer sur l’ordinateur
sous un nom différent ou de remplacer la version précédente en gardant le même nom.

Pour réviser un préréglage enregistré sur l’ordinateur :
1. Dans la fenêtre principale, choisir [File>Open File] (Fichier>Ouvrir le fichier) sur le menu principal ou 

cliquer sur le bouton [Open] (Ouvrir) de la barre de contrôle.
2. La boîte de dialogue « Open » apparaît.
3. Passer à l’unité de lecture et au répertoire du fichier de préréglage que l’on désire ouvrir.
4. Cliquer sur le fichier pour le choisir, puis sur le bouton [Open].
5. Apporter les changements nécessaires.
6. Choisir [File>Save As] sur le menu principal ou cliquer sur le bouton [Save As] de la barre de contrôle.
7. La boîte de dialogue « Save As » apparaît.
8. Cliquer sur le nom du fichier original pour le choisir, puis cliquer sur [Save].
9. Une boîte de dialogue apparaît pour demander de vérifier que l’on désire remplacer la version précédente 

du fichier de préréglage.
10. Cliquer sur [Yes] (Oui) pour remplacer le fichier.

Remarque :Les quinze premiers caractères du nom de fichier et les 80 premiers caractères de 
la description apparaissent dans la boîte d’information située sur la barre de contrôle.
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Préréglages de l’appareil
Préréglages de l’appareil

Le DFR22 peut stocker 16 préréglages dans sa mémoire appareil. Une fois les préréglages stockés dans l’appareil, ils 
peuvent être renommés, supprimés ou sauvegardés en bloc.

Stockage d’un préréglage dans l’appareil
Lorsqu’on est connecté à l’appareil, il est possible en mode Design d’y stocker de nouveaux préréglages ou
d’ouvrir des fichiers de préréglages existants et de les stocker dans l’appareil.

Pour stocker un préréglage dans l’appareil :
1. Dans la fenêtre principale, choisir [File>Store As Preset] 

(Fichier>Stocker comme préréglage) sur le menu principal 
ou cliquer sur le bouton [Store Preset] (Stocker le 
préréglage) de la barre de contrôle.

2. Si la boîte de dialogue « Select Devices » (Choisir les appa-
reils) apparaît, comme illustré à la figure 4-1, choisir un 
appareil dans la liste et cliquer sur [Connect] (Connexion).

3. La boîte de dialogue « Store Preset » apparaît, comme 
illustré ci-dessous à la figure 4-2.

4. Taper un nom de préréglage de quinze caractères au 
maximum.

5. Taper un numéro de préréglage ou accepter la valeur par 
défaut.

6. Taper une description (facultative) pour faciliter l’identification du contenu du préréglage lors d’opérations 
ultérieures.

7. Cliquer sur [Store] (Stocker).

FIGURE 4-1 : Boîte de dialogue 
« Select Devices »

FIGURE 4-2 : Boîte de dialogue « Store Preset »
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Préréglages de l’appareil
Changement du nom d’un préréglage
Une fois qu’un préréglage a été stocké dans l’appareil, il est possible de changer son nom et sa description en
mode Live. Le nom d’un préréglage enregistré sur l’ordinateur peut également être modifié en mode Design.

Pour changer le nom d’un préréglage stocké dans l’appareil :
1. Cliquer sur le bouton [Live Mode] de la barre de contrôle.
2. Choisir le préréglage que l’on désire renommer sur le menu déroulant de 

la boîte d’information de la barre de contrôle.
3. La fenêtre principale passe en mode Preview pour le préréglage choisi.
4. Cliquer sur le bouton [Load] de la barre de contrôle pour faire de ce 

préréglage le préréglage actif.
5. Cliquer une fois en un point quelconque de la boîte d’information.
6. La boîte de dialogue « Preset Information » (Information sur le préréglage) 

apparaît, comme illustré sur la droite à la figure 4-3.
7. Taper le nouveau nom et/ou description.
8. Cliquer sur [OK].

Pour changer le nom d’un préréglage enregistré dans l’ordinateur :
1. Passer en mode Design.
2. Ouvrir le fichier de préréglage.
3. Cliquer une fois en un point quelconque de la boîte d’information.
4. La boîte de dialogue « Preset Information » apparaît, comme ci-dessus.
5. Taper le nouveau nom et/ou description.
6. Cliquer sur [OK].
7. Réenregistrer le préréglage sur l’ordinateur.

Suppression d’un préréglage
Le préréglage actif ne peut pas être supprimé. Si
l’on désire le supprimer, il faut d’abord choisir un
autre préréglage actif.

Pour supprimer un préréglage :
1. Cliquer sur le bouton [Design Mode] de la barre 

de contrôle.
2. Choisir [File>Delete Preset] (Fichier>Supprimer 

le préréglage).
3. Si la boîte de dialogue « Select Devices » appa-

raît, choisir un appareil dans la liste et cliquer 
sur [Connect].

4. La boîte de dialogue « Select Preset to delete » 
(Choisir le préréglage à supprimer) apparaît, 
comme illustré à la figure 4-4.

5. Choisir le préréglage que l’on désire supprimer 
ou appuyer sur Maj  et cliquer pour en choisir 
plusieurs.

6. Cliquer sur [Delete] (Supprimer).

FIGURE 4-3 : Boîte de dialogue 
« Preset Information »

FIGURE 4-4 : Boîte de dialogue « Select Preset to delete »
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Sauvegarde
Sauvegarde

Il est possible de sauvegarder dans un même fichier archive tous les préréglages et paramètres stockés dans l’appareil 
et de restaurer ce jeu sauvegardé dans l’appareil à une date ultérieure. Il faut être en mode Design pour restaurer une 
sauvegarde.

Pour sauvegarder tous les préréglages dans l’appareil :
1. Choisir [File>Backup Device] (Fichier>Sauvegarder) sur 

le menu principal.
2. Si la boîte de dialogue « Select Devices » apparaît, 

choisir un appareil dans la liste et cliquer sur [Connect].
3. La boîte de dialogue « Save As Backup » (Enregistrer 

comme sauvegarde) apparaît, comme illustré sur la 
droite à la figure 4-5.

4. Cliquer sur [Backup Entire Device] (Sauvegarde 
complète).

5. La boîte de dialogue « Save Backup As » (Enregistrer la 
sauvegarde sous) apparaît, comme illustré ci-dessous 
sur la droite à la figure 4-6.

6. Passer au répertoire approprié et taper un nom de fichier.
7. Cliquer sur [Save].

Pour sauvegarder certains préréglages en particulier :
1. Effectuer les opérations 1 à 3 précédentes.
2. Cliquer pour choisir un préréglage dans la liste. Appuyer 

sur Maj et cliquer ou appuyer sur Ctrl et cliquer pour 
choisir plusieurs préréglages.

3. Cliquer sur le bouton [Backup Selected Presets] (Sau-
vegarder les préréglages choisis).

4. La boîte de dialogue « Save As » apparaît.
5. Passer au répertoire voulu, donner un nom au fichier et 

cliquer sur [Save].
6. Répéter les opérations 4 et 5 pour chaque préréglage 

choisi comme préréglage à sauvegarder.

Pour restaurer une sauvegarde dans l’appareil :
1. Cliquer sur le bouton [Design Mode] de la barre de 

contrôle.
2. Choisir [File>Restore Device] (Fichier>Restaurer) sur 

le menu principal.
3. La boîte de dialogue « Open Backup » (Ouvrir la sauve-

garde) apparaît, semblable à la boîte de dialogue « 
Save Backup As » illustrée sur la droite à la figure 4-6.

4. Passer au répertoire correct et choisir le jeu sauvegardé 
approprié sur la liste.

5. Cliquer sur [Open].
6. Si la boîte de dialogue « Select Devices » apparaît, 

choisir un appareil dans la liste et cliquer sur [Connect].
7. La sauvegarde est transmise à l'appareil.

FIGURE 4-5 : Boîte de dialogue « Save As Backup »

FIGURE 4-6 : Boîte de dialogue « Save Backup As »
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Le menu Device
Le menu Device

Shure Link Application List (Liste d’applications Shure Link)
Elle répertorie tous les logiciels Shure Link installés sur l’ordinateur. Pour passer à une autre application, il suf-
fit de choisir celle-ci sur le menu, ce qui permet de la lancer en mode Design.

Global Preset Mode (Mode de préréglage global)
Lorsque la commande Global Preset Mode est activée pour chaque appareil Shure Link du réseau, un change-
ment de préréglage sur un appareil entraîne la modification des préréglages sur l’ensemble des appareils. Une
coche apparaît à côté de cette commande sur menu lorsqu’elle est active pour le DFR22.

Control Pin Configuration (Configuration des broches de commande)
Choisir cette option de menu pour configurer les broches de commande de façon à pouvoir commander l’appa-
reil avec du matériel externe. Cette opération ouvre la fenêtre « Control Pins », dont le fonctionnement est
expliqué en détail dans le chapitre débutant à la page 89.

Select COM port (Choix du port COM)
Choisir cette option de menu pour spécifier le port COM auquel est raccordé
le DFR22 ou le réseau Shure Link. Cette opération ouvre la boîte de dia-
logue « COM Port », qui répertorie tous les ports COM de l’ordinateur.

Pour choisir le port COM
1. Choisir [Devices>Select COM Port] sur le menu principal.
2. La boîte de dialogue « COM Port » s’ouvre, comme illustré à la figure 4-7.
3. Choisir le port COM auquel le câble RS-232 est relié et cliquer sur [OK].

Name Device (Nom appareil)
Cette option de menu permet de spécifier un nom unique pour le DFR22,
afin de mieux le distinguer des autres éléments de la liste d’appareils.

Pour attribuer un nom à l’appareil :
1. Choisir [Devices>Name Device] sur le menu principal.
2. La boîte de dialogue « Name Device » s’affiche, comme illustré à la 

figure 4-8.
3. Taper un nom d’appareil d’une longueur maximum de quinze caractères 

et cliquer sur [Name].
4. Le nom de l’appareil apparaît en mode Live sur la barre de titre de la fenêtre principale, ainsi que sur le 

menu [Devices].

Device List (Liste d’appareils)
En mode Live, elle répertorie tous les appareils Shure Link connectés au réseau. Choisir un appareil pour y
accéder directement et lancer son logiciel de commande en mode Live.

FIGURE 4-7 : Boîte de dialogue 
« COM Port »

FIGURE 4-8 : Boîte de dialogue 
« Name Device »
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SECTION 5 Fonctions du processeur
Cette section décrit les fonctions logicielles communes à de nombreuses fenêtres de paramètres de processeurs. Pour les
fonctions spécifiques à chaque type de processeur, voir la section Processeurs fixes à la page 42 et la section Proces-
seurs modulaires à la page 48.

Affaiblisseurs

Les affaiblisseurs apparaissent sur de nombreuses fenêtres de processeur, comme dans l’exemple illustré à la 
figure 5-1, ci-dessous sur la droite. Ils permettent de régler le gain en déplaçant la souris verticalement comme on 
ferait coulisser un affaiblisseur sur une table de mélange. Il est également possible de spécifier le niveau numérique-
ment en tapant un chiffre dans la boîte de valeur. Commencer par choisir l’affaiblisseur, puis régler le niveau en appli-
quant l’une quelconque des méthodes décrites ci-après.

Choix
Choisir un affaiblisseur en positionnant le curseur de la souris au-dessus du bouton de l’affaiblisseur et en cli-
quant dessus avec le bouton gauche de la souris, ou en cliquant dans la boîte de valeur située sous la bande
d’affaiblissement. Le bouton de l’affaiblisseur se met en surbrillance pour indiquer qu’il a été sélectionné. Si la
fenêtre contient plusieurs affaiblisseurs, on peut passer de l’un à l’autre de la gauche vers la droite en appuy-
ant sur la touche Tab et de la droite vers la gauche en appuyant simultanément sur les touches Maj et Tab.

Réglage du niveau

Pour régler le niveau à l’aide de la souris :

• Cliquer sans relâcher sur le bouton d’affaiblisseur pour le 
glisser vers le haut et le bas.

• Cliquer sur la bande d’affaiblissement au niveau désiré.
• Cliquer avec le bouton droit de la souris sur le bouton 

d’affaiblisseur pour régler le niveau à 0 dB.

Pour régler le niveau par une seule frappe de touche :
1. Choisir l’affaiblisseur que l’on désire régler.
2. Utiliser l’une quelconque des touches ci-dessous pour 

régler le niveau.

Boîte de valeur
La boîte de valeur permet de spécifier le niveau à un dixième de décibel près. Une boîte de valeur est
associée à tous les affaiblisseurs. Dans la plupart des fenêtres de processeur, une boîte de valeur se
trouve juste en dessous de chaque affaiblisseur. Les deux exceptions sont les fenêtres des GEQ10 et
GEQ30, qui ne comportent qu’une seule boîte de valeur de gain pour tout le groupe d’affaiblisseurs. Dans
ce cas, choisir d’abord le bouton que l’on désire régler, puis taper une valeur dans la boîte.

Bouton de l’affaiblisseur sélectionné

Bouton de l’affaiblisseur désélectionné

Touche Résultat
Flèche vers le haut Augmentation de 0,5 dB

Flèche vers le bas Réduction de 0,5 dB

Page précédente Augmentation de 3 dB

Page suivante Réduction de 3 dB

Barre d’espacement Établissement d'une valeur de 0 dB

1

2

3

4

1. Bande 
d'affaiblissement

2. Bouton 
d'affaiblisseur

3. Boîte de valeur
4. Boutons compteur 

circulaire

FIGURE 5-1 : Commandes standard
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Enregistrement et rappel de paramètres
Boutons compteur circulaire
Des boutons compteur circulaire apparaissent à côté de toutes les boîtes de valeur. Ils représentent un
moyen commode de faire évoluer le niveau sans devoir taper une valeur précise.

Pour régler la valeur à l’aide des boutons compteur circulaire :

• Cliquer sur le bouton compteur circulaire d’augmentation ou de réduction pour faire évoluer le niveau 
de +/– 0,5 dB.

• Cliquer sans relâcher sur un bouton compteur circulaire pour faire défiler les niveaux vers le haut ou 
vers le bas. Plus on maintient le bouton de la souris enfoncé, plus le défilement s’accélère.

Enregistrement et rappel de paramètres

Les paramètres figurant dans la fenêtre de paramètres de tout processeur peuvent être enregistrés dans un fichier de 
l’ordinateur et rappelés la prochaine fois qu’on a besoin d’une configuration similaire dans le même type de processeur. 
Cela permet de créer des paramètres par défaut spéciaux ou propres à une installation pour des processeurs couram-
ment utilisés. Si de nombreux paramètres vont être enregistrés dans l'ordinateur, il est recommandé de créer un réper-
toire destiné spécialement aux paramètres de processeurs ou à une installation particulière.

Pour enregistrer des paramètres de processeur :
1. Double-cliquer sur chaque bloc processeur pour ouvrir sa fenêtre de paramètres.
2. Choisir [File>Save Settings] (Fichier>Enregistrer les paramètres) sur le menu ou appuyer sur Ctrl + S sur 

le clavier.
3. Passer au répertoire approprié et taper un nom de fichier.
4. Cliquer sur [Save].
5. L’application ajoute une extension indiquant le type de processeur qui a créé le fichier. Voir l’Annexe C : 

Extensions de fichiers pour une liste complète des extensions de fichiers de paramètres de processeur.

Pour rappeler des paramètres de processeur :
1. Double-cliquer sur chaque bloc processeur pour ouvrir sa fenêtre de paramètres.
2. Choisir [File>Recall Settings] (Fichier>Rappeler les paramètres) sur le menu ou appuyer sur Ctrl + R sur

le clavier.
3. Passer au répertoire approprié et choisir le fichier de paramètres.
4. Cliquer sur [Open].

Attribution d’un nom aux fenêtres de processeur

La fenêtre de paramètres de chaque bloc processeur modulaire du diagramme de fluence peut recevoir un nom qui lui 
est propre, ce qui est utile lorsque plusieurs fenêtres sont ouvertes simultanément. Le titre d’une fenêtre de processeur 
se compose par défaut du nom du type général de processeur, du label de la bande de canal sur laquelle il est placé, 
du numéro d’espace et de son état vis-à-vis du verrouillage de sécurité.

Il est possible, pour distinguer entre des processeurs semblables, d’attribuer à la fenêtre un nom spécial reflétant la 
fonction ou les paramètres propres au processeur. Le nouveau nom de fenêtre apparaît dans la barre de titre de la 
fenêtre de paramètres du processeur et sur la barre des tâches de Windows lorsque la fenêtre de paramètres est min-
imisée.

Pour renommer une fenêtre de paramètres de processeur :
1. Double-cliquer sur le bloc pour ouvrir la fenêtre de paramètres du processeur.
2. Choisir [Options>Name] (Options>Nom) sur le menu.
3. Taper le nouveau nom, de quinze caractères au maximum.

Remarque : Il n’est possible de rappeler des paramètres que pour un processeur d’un type iden-
tique à celui du processeur qui a créé le fichier de paramètres.
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Instantanés
4. Cliquer sur [OK].

Instantanés

La fonction instantané est disponible dans toute fenêtre de paramètres de processeur comportant un diagramme de 
courbe de réponse ou de courbe de transfert. Elle permet de capturer une image de la courbe active, puis de l’afficher 
à titre de référence lors de la révision des paramètres du processeur. Le processeur conserve cet instantané en mém-
oire jusqu’à ce qu’un nouveau soit réalisé dans la même fenêtre de processeur ou que l’on quitte l’application.

Les exemples suivants de courbes de réponse ont été relevés dans la fenêtre de paramètres d’un égaliseur 
paramétrique à cinq bandes avec filtres passe-haut et passe-bas et de dégradé (PEQ5+CS).

Pour utiliser la fonction instantané :
1. Cliquer sur le bouton [TAKE] (Prise) comme illustré à la 

figure 5-2. Cela permet de capturer la courbe de 
réponse ou de transfert active.

2. Cliquer sur le bouton [SHOW] (Affichage). 
Cela affiche l’instantané derrière la 
courbe active. Le bouton est allumé en 
vert lorsque l’instantané est affiché.

3. Changer les paramètres de processeur. Lor-
squ’on modifie la courbe, on peut la com-
parer à l’instantané de la courbe précédente 
qui apparaît à l’arrière-plan, comme illustré à 
la figure 5-3.

4. Cliquer à nouveau sur le bouton [SHOW] pour désac-
tiver et réactiver l'instantané, comme illustré sur la 
droite à la figure 5-4.

Remarque : Cela ne change que le nom de la fenêtre de paramètres du processeur. Le titre du 
bloc processeur reste le même sur le diagramme de fluence.

Remarque : Lorsqu’on affiche l’instantané avant 
d’avoir changé tout paramètre de 
processeur, il est caché derrière la 
courbe en vigueur. L’instantané est 
visible dès que la courbe est modi-
fiée avec des paramètres différents.

FIGURE 5-2 : Prise d’un instantané

FIGURE 5-3 : Modification de la courbe de réponse

FIGURE 5-4 : Masquage de l’instantané
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Importation de fichiers ASCII
Importation de fichiers ASCII

Les fenêtres d’égaliseurs et la fenêtre de réponse combinée peuvent afficher des données contenues dans un fichier 
ASCII, comme le montre l’illustration ci-dessous, qui représente une fenêtre correspondant au cas d’un égaliseur 
PEQ10+CS.

Utiliser la fonction d’importation de fichiers ASCII pour afficher les données comparatives de fréquence et d’amplitude 
mesurées dans Smaart ou TEF. En inversant les données, il est possible d’utiliser l’affichage comme guide visuel lors 
de l’établissement des paramètres des égaliseurs. L’affichage n’indique que les valeurs d’amplitude pour les 
fréquences contenues dans le fichier ; il n’interpole pas de ligne entre les points réellement mesurés. Il se peut par con-
séquent qu’il y ait un vide sur l’affichage, en particulier aux basses fréquences.

La fonction d’importation ASCII est compatible avec les formats suivants :

• Mesures de la fonction de transfert dans SIA-Smaart® Pro (versions 2/x et 3.x) et SIA SmaartLive™.
• Mesures TDS dans toutes les versions du logiciel TEF™ TDS pour Windows et DOS, et mesures EFC 

dans le logiciel TEF SLX.

Enregistrement de fichiers en format ASCII

Fichiers Smaart
Pour exporter une mesure à l'aide du logiciel Smaart, mesurer en mode Transfer Function (Fonction de
transfert). Sélectionner ensuite [File>ASCII Save] (Fichier>Enregistrement de fichiers ASCII) sur le menu
de l'application Smaart. 

FIGURE 5-5 : Importation d’un fichier ASCII
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Importation de fichiers ASCII
Fichiers TEF
Pour exporter une mesure à l'aide du logiciel TEF TDS :
1. Choisir [File>Save] (Fichier>Enregistrer) sur le menu de l’application TEF TDS. 
2. Taper les informations concernant le fichier et cliquer sur [Save].
3. Choisir « ASCII » comme type de fichier dans la fenêtre « Save TDS File » (Enregistrer un fichier TDS).

Commandes et fonctions d’importation

Import (Importation)
Cliquer sur ce bouton pour importer des fichiers ASCII de Smaart ou de TEF. Lorsque la fenêtre «
Open File » (Ouvrir le fichier) apparaît, sélectionner le fichier que l’on souhaite importer. Les don-

nées du fichier importé seront affichées dans le diagramme de réponse. Lorsqu’un fichier TEF TDS ou EFC
est importé, la valeur d’amplitude moyenne est portée à 0 dB et toutes les autres valeurs d’amplitude sont
décalées en conséquence. Par défaut, les fichiers de la fonction de transfert de Smaart ne sont pas décalés.
Les amplitudes sont centrées par rapport à l’axe 0 dB, exactement comme elles le sont dans Smaart.

Refresh (Régénération)
Cliquer sur ce bouton pour réimporter le dernier fichier importé. Si une nouvelle mesure est
relevée dans Smaart ou TEF et enregistrée avec le même nom de fichier, ce qui écrase le fichier

antérieur, il est possible de cliquer sur le bouton [REFRESH] pour importer la nouvelle mesure sans devoir
utiliser la boîte de dialogue d’ouverture de fichier. 

Show (Affichage)
Cliquer sur ce bouton pour afficher ou masquer le fichier importé. Le bouton [SHOW] est allumé
en vert lorsqu’un fichier est affiché.

Offset (Décalage)
Cela indique l’importance du décalage de la valeur affichée par rapport aux valeurs d’amplitude
réelles contenues dans le fichier ASCII. Par défaut, une mesure TEF TDS ou EFC sera décalée
de son amplitude moyenne pour être centrée par rapport à l’axe 0 dB dans le diagramme de

réponse.

Invert (Inversion)
Cliquer sur cette boîte pour inverser les données affichées par rapport à l’axe des abscisses. Il
est ensuite possible d’utiliser l’affichage inversé comme guide visuel lors de l’établissement des

paramètres des égaliseurs.[INVERT] est sélectionné par défaut.

Help (Aide)
Cliquer sur ce bouton pour solliciter l’aide en ligne en ce qui concerne l’importation de fichiers
ASCII Smaart et TEF.

Remarque : Le bouton [REFRESH] NE change PAS le décalage du fichier d’origine. Si la valeur d’amplitude 
moyenne d’un fichier TEF TDS ou EFC change, l’affichage régénéré restera décalé par rap-
port à la valeur moyenne d’origine. En outre, tout décalage ajouté au fichier à l’aide de la 
boîte de texte [OFFSET] (Décalage) ne change pas lorsque l’on clique sur [REFRESH].
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Diagramme de réponse combinée
Diagramme de réponse combinée

Cette fenêtre cumule les courbes de réponse des processeurs se trouvant dans le chemin de signal choisi, afin d’aider 
l’utilisateur à atteindre une égalisation uniforme en salle. Il est possible d’y accéder en choisissant [View>Combined 
Response Graph] (Vue>Diagramme de réponse combinée) sur le menu principal.

Fonctions de la fenêtre

1) Sélecteur de la bande d’entrée
Les bandes d’entrée y sont répertoriées avec les mêmes noms que dans le diagramme de fluence. Choisir
la bande pour laquelle la visualisation de la réponse combinée est souhaitée.

2) Sélecteur de la bande de sortie
Les bandes de sortie y sont répertoriées avec les mêmes noms que dans le diagramme de fluence. Lor-
squ’une bande d’entrée et une bande de sortie sont choisies, la réponse combinée affichée correspond à
ce chemin de signal.

3) Sélecteur des processeurs
Par défaut, les réponses des égaliseurs, des réducteurs numériques de Larsen et des filtres répartiteurs
sont combinées sur le diagramme de réponse. Les égaliseurs incluent les égaliseurs paramétriques
(PEQ), les égaliseurs graphiques (GEQ) et les processeurs PASSE-HAUT/PASSE-BAS/DÉGRADÉ. Les
filtres répartiteurs incluent le filtre répartiteur à 2 voies et le caisson de graves. Les réducteurs numériques
de Larsen incluent tous les processeurs de réduction numérique de Larsen mono et stéréo.

4) Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse combinée active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW]. Le bouton

1 2 3

4

5

67

FIGURE 5-6 : Fenêtre « Combined Response Graph »
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Diagramme de réponse combinée
[SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus détaillée de la fonction
instantané, voir la section Instantanés à la page 37.

5) ASCII File (Importation de fichiers ASCII)
Cette fonction permet l’importation de données de fréquences dans le diagramme de réponse à partir de
SIA Smaart et de Gold Line TEF. Une fois dans le diagramme, les données graphiques peuvent être util-
isées à titre de référence lors de la modification de la courbe de réponse de tout processeur se trouvant
dans le chemin de signal. Se reporter à la page 38 pour obtenir des instructions sur la façon d’utiliser la
fonction d’importation de fichiers ASCII.

6) Diagramme de réponse
Il se met à jour au fur et à mesure des changements apportés aux paramètres et aux positions des proces-
seurs se trouvant dans le chemin de signal spécifié.

7) Indicateur de polarité
La polarité affichée correspond à la somme totale des éléments du chemin de signal. Si une entrée est
sélectionnée, cet indicateur reflète les paramètres correspondant au bloc Input Gain. Si une sortie est
sélectionnée, il reflète les paramètres correspondant au bloc Matrix Mixer, à tout filtre répartiteur ou cais-
son de graves et au bloc Output Gain. Dans le cas où une entrée et une sortie sont sélectionnées, tous les
ajustements de polarité du chemin sont inclus.
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SECTION 6 Processeurs fixes
Ces processeurs constituent les trois étages différents de la structure de gain du DFR22 (se reporter à la page 18 pour
plus de détails sur ce sujet). Ils sont appelés processeurs fixes parce que les blocs de gain et de mélange du dia-
gramme de fluence ne peuvent être ni déplacés ni supprimés.

Gain d’entrée

La fenêtre « Input Gain » contient les commandes individuelles des deux canaux d’entrée. Double-cliquer sur le bloc 
de gain à l’extrémité gauche de n’importe laquelle des bandes de canaux d’entrée pour ouvrir cette fenêtre, comme 
illustré ci-dessous à la figure 6-1.

1) Options de démultiplication
Utiliser ces boutons pour démultiplier chaque canal d’entrée de façon à ce que son niveau corresponde au
niveau de sortie du matériel en ligne en amont du processeur audio. Cliquer pour passer au niveau -10
dBV ou +4 dBu. Le réglage par défaut est +4 dBu.

2) Polarité du signal
Cliquer sur ce bouton pour inverser la polarité du signal pénétrant dans la bande de canal d’entrée. La
polarité par défaut est la polarité normale.

+4 dBu sélectionné

–10 dBV sélectionné

Polarité normale

Polarité inversée

1

2

3

4

5

6

FIGURE 6-1 : Fenêtre « Input Gain »
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Gain d’entrée
3) Commandes de gain
Utiliser ces commandes pour régler le niveau de signal de chaque canal d’entrée. Choisir d’abord le bou-
ton d’affaiblisseur, puis régler le niveau à l’aide de la souris ou des touches fléchées, ou spécifier un
niveau dans la boîte de valeur. Pour des instructions complètes concernant leur utilisation, voir la section
Affaiblisseurs à la page 35. La plage de réglage va de +10 dB à –l’infini et la valeur par défaut est 0 dB, ou
gain unité.

4) Coupure de canal
Cliquer sur ce bouton pour couper le canal. Lorsque la coupure est active, le bouton est allumé en rouge.
Le réglage par défaut est inactif.

5) Label de canal
Utiliser cette boîte de texte pour personnaliser le label de bande de canal d’entrée dans le diagramme de
fluence. Le réglage par défaut est « Untitled In » (Entrée sans titre) pour chaque canal d’entrée.

6) Indicateur de liaison
Il affiche l’état de liaison du canal d’entrée. Tout paramètre changé sur un canal lié le sera également sur
l’autre canal lié du même groupe. Pour une explication complète sur l'établissement de liaisons et sur les
groupes de blocs liés, voir la section Liaison à la page 25.

Remarque : Les commandes de gain d’entrée règlent le niveau du signal après qu’il a été converti 
numériquement dans le processeur audio. Les niveaux de signal dépassant le seuil 
d’entrée du processeur audio doivent faire l’objet d’un réglage externe. 

Coupure activée

Coupure inactive

Canal lié

Canal non lié
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Mélangeur matriciel
Mélangeur matriciel

La fenêtre « Matrix Mixer » contient des commandes de connexion de points de mélange dans le diagramme de flu-
ence, réparties entre des onglets de sous-fenêtres distincts pour chaque point de mélange de sortie. Double-cliquer sur 
n’importe lequel des blocs de mélange pour ouvrir cette fenêtre, comme illustré ci-dessous à la figure 6-2.

1) Onglets de sous-fenêtres

2

3

4

5

6
7

1

FIGURE 6-2 : Fenêtre « Matrix Mixer »

La fenêtre s’ouvre à la sous-fenêtre de sortie corre-
spondant au bloc de mélange sur lequel on a double-
cliqué. Cliquer sur n’importe quel onglet pour accéder 
aux commandes correspondant à l’autre point de 
mélange de sortie.

Les onglets de sous-fenêtres correspondent aux 
points de mélange de sortie du diagramme de flu-
ence. Dans le cas de l’utilisation d’un filtre répartiteur 
ou d’un séparateur, le titre de l’onglet indique que ce 
processeur recouvre les deux canaux de sortie, 
comme illustré à la figure 6-3.

FIGURE 6-3 : Filtre répartiteur dans la fenêtre 
« Matrix Mixer »
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Mélangeur matriciel
2) Sélecteur d’entrée
Cliquer sur ce bouton pour activer une connexion à partir du point de mélange de canal d’entrée corre-
spondant dans le diagramme de fluence. Le bouton est allumé en vert lorsqu’une connexion est activée.
Les commandes des entrées inactives disparaissent en fondu. Le réglage par défaut est inactif.

3) Polarité du signal

4) Commandes de gain
Utiliser ces commandes pour régler le niveau de signal de chaque canal. Choisir d’abord le bouton
d’affaiblisseur, puis régler le niveau à l’aide de la souris ou des touches fléchées, ou spécifier un niveau
dans la boîte de valeur. Pour des instructions complètes concernant leur utilisation, voir la section
Affaiblisseurs à la page 35. La plage de réglage va de +10 dB à –l’infini et la valeur par défaut est 0 dB, ou
gain unité.

5) Coupure de canal

6) Label de canal
Il affiche le label de canal spécifié dans la fenêtre « Input Gain » ou « Output Gain ».

7) Indicateur de liaison
Il affiche l’état de liaison du point de mélangeur matriciel. Lorsqu'on lie des blocs de mélange, toutes les
commandes correspondant à chaque bloc de mélange sont liées à l’exception du sélecteur d’entrée. Pour
une explication complète sur l'établissement de liaisons et sur les groupes de blocs liés, voir la section
Liaison à la page 25.

Connexion activée

Connexion inactive

Polarité normale Cliquer sur ce bouton pour inverser la polarité du signal pénétrant 
dans le point de mélangeur matriciel. La polarité par défaut est la 
polarité normale.Polarité inversée

Coupure activée
Cliquer sur ce bouton pour couper le canal. Lorsque la coupure est 
active, le bouton est allumé en rouge. Le réglage par défaut est inactif.

Coupure inactive

Processeur lié

Processeur non lié
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Gain de sortie
Gain de sortie
La fenêtre « Output Gain » contient les commandes individuelles des deux canaux de sortie. Double-cliquer
sur le bloc de gain à l’extrémité droite de n’importe laquelle des bandes de canaux de sortie pour ouvrir cette
fenêtre, comme illustré ci-dessous à la figure 6-4.

1) Options de démultiplication
Utiliser ces boutons pour démultiplier chaque canal de sortie de façon à ce que son niveau corresponde au
niveau de sortie du matériel en ligne en aval du processeur audio. Cliquer pour passer au niveau -10 dBV
ou +4 dBu. Le réglage par défaut est +4 dBu.

2) Polarité du signal
Cliquer sur ce bouton pour inverser la polarité du signal sortant de la bande de canal de sortie. La polarité
par défaut est la polarité normale.

3) Commandes de gain
Utiliser ces commandes pour régler le niveau de signal de chaque canal de sortie. Choisir d’abord le bou-
ton d’affaiblisseur, puis régler le niveau à l’aide de la souris ou des touches fléchées, ou spécifier un
niveau dans la boîte de valeur. Pour des instructions complètes concernant leur utilisation, voir la section

+4 dBu sélectionné

–10 dBV sélectionné

Polarité normale

Polarité inversée

1

2

3

4

5

6

7

FIGURE 6-4 : Fenêtre « Output Gain »
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Gain de sortie
Affaiblisseurs à la page 35. La plage de réglage va de +10 dB à –l’infini et la valeur par défaut est 0 dB, ou
gain unité.

4) Atténuateurs de sortie
Cliquer sur l’un de ces boutons pour atténuer le signal de sortie de –12 ou de –18 dB. Lorsque l’atténua-
teur choisi est activé, le bouton correspondant est allumé en rouge. L’état par défaut de ces boutons est
inactif.

5) Coupure de canal
Cliquer sur ce bouton pour couper le canal. Lorsque la coupure est active, le bouton est allumé en rouge.
Le réglage par défaut est inactif.

6) Label de canal
Utiliser cette boîte de texte pour personnaliser le label de bande de canal de sortie dans le diagramme de
fluence. Le réglage par défaut est « Untitled Out » (Sortie sans titre) pour chaque canal de sortie.

7) Indicateur de liaison
Il affiche l’état de liaison du canal de sortie. Tout paramètre changé sur un canal lié le sera également sur
tous les autres canaux liés du même groupe. Pour une explication complète sur l'établissement de liaisons
et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Atténuateur de 12 dB 
activé
Atténuateur de 12 dB 
inactif

Remarque : Il est impossible d’activer simultanément les atténuateurs de –12 et de –18 dB sur la 
même sortie.

Coupure activée

Coupure inactive

Canal lié

Canal non lié
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SECTION 7 Processeurs modulaires
Cette section décrit les fonctions et commandes propres à chaque fenêtre de paramètres de bloc processeur. Dans
certains cas, plusieurs blocs processeur partagent des commandes presque identiques telles que l’extenseur descen-
dant et l’obturateur. Les processeurs sont alors décrits comme formant un groupe utilisant une seule fenêtre de
paramètres comme dans l’exemple illustré. Les paramètres de commande propres à l’un des processeurs du groupe
sont mentionnés comme tels dans la description de ces commandes.

Commande automatique de gain (AGC)

La commande automatique de gain crée un niveau de volume plus stable lorsque les orateurs parlent à des niveaux 
sonores différents. Elle agit comme un ingénieur du son qui aurait son doigt sur un affaiblisseur, augmentant le gain du 
signal d’entrée lorsque le niveau est trop faible et le réduisant lorsque le niveau est trop élevé.

Fonction
Utiliser ce processeur dans les cas où il est souhaitable de maintenir un niveau de volume constant, comme
par exemple pour les microphones de podium ou de chaire où la proximité des orateurs par rapport au micro-
phone varie. La commande automatique de gain compense les faibles niveaux en augmentant progressive-
ment le gain. Si un orateur parle ensuite d’une voix forte dans le microphone, la commande automatique de
gain réduit progressivement le gain. Toutefois, si un orateur modifie très rapidement le niveau sonore de sa
voix, que ce soit en criant, en chuchotant ou en se rapprochant tout près du microphone, cette courte pointe ou
dépression dans le niveau sonore global traverse la commande automatique de gain sans être modifiée. La
commande automatique de gain ne change le gain que si elle détecte une activité au niveau de son entrée.
Cela permet d’éviter des changements de gain non souhaitables pendant les pauses prévues dans le déroule-
ment du programme.

Nom de bloc Description
AGC Commande automatique de gain

1

2

3 4 5

6

78

FIGURE 7-1 : Fenêtre AGC
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Commande automatique de gain (AGC)
Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres propres au processeur de commande automa-
tique de gain, comme illustré ci-dessus à la figure 7-1. 

1) Ligne de gain maximum
L’amplification maximum du signal par la commande automatique de gain est de +12 dB comme indiqué
par la ligne de gain maximum. Cela évite les problèmes de modulation de bruit ou de Larsen indésirables
pouvant résulter d’une amplification excessive des signaux de faible niveau. La ligne de gain maximum
n’apparaît dans le diagramme de courbe de transfert que lorsque la combinaison des paramètres de seuil,
de basculement et de rapport entraîne une imposition de la limite de +12 dB par la commande automatique
de gain.

2) Diagramme de courbe de transfert
Le diagramme de courbe de transfert affiche le niveau de seuil et les paramètres de taux de compression
sous forme d’éléments graphiques pouvant être positionnés à l’aide de la souris. La courbe de transfert
résultante représente le changement du niveau de sortie de signal.

3) Curseur de seuil
La position du curseur de seuil correspond au réglage de la commande de seuil. Il est possible de glisser
ce curseur à l’aide de la souris vers la gauche et la droite le long du bord supérieur du diagramme de
courbe de transfert pour changer le réglage du seuil.

4) Curseur de rapport
La position du curseur de rapport correspond au réglage de la commande de rapport. Il est possible de
glisser ce curseur à l’aide de la souris vers le haut et le bas le long du bord droit du diagramme de courbe
de transfert pour changer le réglage du rapport.

5) Vumètre de réduction de gain
Ce vumètre indique l’augmentation ou la réduction totale de gain obtenue sur le signal d’entrée avec les
paramètres de processeur en vigueur. Il est possible d’activer et de désactiver cette fonction en choisis-
sant l’option [Options>Gain Reduction Meter] (Options>Vumètre de réduction de gain) sur le menu. Elle
est active par défaut.

6) Commandes de gain
Utiliser les commandes de gain pour régler les niveaux de gain d’entrée et de sortie. Les niveaux de gain
disponibles vont de -12 dB à +12 dB par paliers de 0,5 dB, la valeur par défaut étant de 0 dB. Il est possible
de changer la valeur en utilisant les conventions décrites dans la section Affaiblisseurs à la page 35.

7) Curseur de basculement
La position du curseur de basculement correspond au réglage de la commande de basculement. Il est pos-
sible de glisser ce curseur à l’aide de la souris vers la gauche et la droite le long du bord inférieur du dia-
gramme de courbe de transfert pour changer le réglage du basculement.

8) Vumètre de courbe de transfert
En mode Live, ce vumètre indique le niveau d’entrée et le niveau relatif de sortie du signal pour permettre
de surveiller l’effet du processeur sur le niveau sonore du programme en cours. Il est possible d’activer et
de désactiver cette fonction en choisissant l’option [Options>Transfer Curve Meter] (Options>Vumètre de
courbe de transfert) sur le menu. Elle est active par défaut.

Remarque : Le logiciel du processeur audio risque d’être moins performant si un grand nombre de 
vumètres y sont actifs. Il est possible de désactiver sélectivement le vumètre de courbe de 
transfert ou celui de réduction de gain, voire les deux, à partir du menu [Options].
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Commande automatique de gain (AGC)
Indicateur de dépassement du seuil.

Threshold (Seuil)
Il indique le niveau que doit atteindre le gain de signal avant que le processeur ne l’aug-
mente. Les signaux d’un niveau inférieur au seuil traversent le processeur au gain unité. Il
est possible de changer la valeur en cliquant sur les boutons compteur circulaire, en tapant
une valeur précise ou en utilisant le curseur de seuil qui se trouve au-dessus du diagramme

de courbe de transfert. Les valeurs disponibles vont de -60 dB à +20 dB par paliers de 0,5 dB, la valeur par
défaut étant 0 dB.

Ratio (Rapport)
Il indique la réduction de gain obtenue à la sortie du processeur par rapport au niveau
d’entrée qui dépasse la valeur de basculement. Un rapport de 4:1, par exemple, signifie
qu’une augmentation de 4 dB du niveau sonore du programme entraîne une augmentation

de 1 dB du niveau de sortie du processeur. Il est possible de changer la valeur en cliquant sur les boutons
compteur circulaire, en tapant une valeur précise ou en utilisant le curseur de rapport qui se trouve sur le
côté droit du diagramme de courbe de transfert. Les valeurs disponibles vont de 1:1 à 10:1 par paliers d’un
dixième, la valeur par défaut étant 2:1.

Attack (Attaque)
Cette valeur indique le temps qui s’écoule avant que le processeur ne réagisse à une éléva-
tion ou à une baisse du niveau d’entrée une fois que ce dernier a dépassé le seuil. Les
valeurs disponibles vont de 0,2 à 3 secondes, la valeur par défaut étant de 2 secondes.

Decay (Déclin)
Il indique le temps qui s’écoule avant que le processeur ne revienne au gain unité une fois
que le niveau d’entrée s’élève ou s’abaisse pour se rapprocher de la valeur de basculement.
Les valeurs disponibles vont de 0,5 à 5 secondes, la valeur par défaut étant de 5 secondes.

Hinge (Basculement)
La valeur de basculement est le niveau cible de sortie de la commande automatique de
gain. Il s’agit d’un point pivot qui détermine si le niveau d’entrée est relevé ou abaissé. Les
niveaux de signal inférieurs à la valeur de basculement (mais supérieurs au seuil) seront
relevés et ceux qui lui sont supérieurs seront abaissés. Il est possible de changer la valeur

en cliquant sur les boutons compteur circulaire, en tapant une valeur précise ou en utilisant le curseur de
basculement qui se trouve en dessous du diagramme de courbe de transfert. Les valeurs disponibles vont
de -60 dB à +20 dB par paliers de 0,5 dB, la valeur par défaut étant 0 dB.

Default (Réglage par défaut)
Cliquer sur ce bouton pour rétablir les paramètres système par défaut du processeur.

Bypass (Contournement)
Cliquer sur ce bouton pour faire passer un signal sans le modifier. Lorsque le contournement est actif, le
bouton est allumé en rouge. Le réglage par défaut est inactif.

Le niveau du signal a dépassé le seuil Cet indicateur s’allume en jaune lorsque le signal 
à l’entrée du bloc processeur excède le seuil 
spécifiéLe niveau du signal n’a pas atteint le seuil

Contournement actif

Contournement inactif
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Commande automatique de gain (AGC)
Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Processeur lié

Processeur non lié
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Compresseur/écrêteur

Les compresseurs et les écrêteurs réduisent le niveau de sortie du signal par rapport au niveau d’entrée une fois que 
ce dernier dépasse un certain seuil. Le processeur audio offre les types suivants de compresseurs et d’écrêteurs :

Fonction
Utiliser le compresseur pour démultiplier la sortie d’un signal de façon à l’adapter aux appareils à gamme
dynamique plus étroite tels que les amplificateurs, les magnétophones et les haut-parleurs. Utiliser l’écrêteur
pour protéger le système des pointes soudaines de puissance qui risqueraient d’endommager les haut-par-
leurs. En retardant le signal de 1 ms, l’écrêteur de pointe a un temps d'attaque de 0 pour permettre un meilleur
contrôle des sons transitoires. Le compresseur et l’écrêteur fonctionnent de la même façon mais l’écrêteur est
généralement réglé pour un temps d’attaque plus court et un taux de compression plus élevé. 

Nom de bloc Description
COMP Compresseur
Sft COMP Compresseur Soft Knee
LIM Écrêteur
Sft LIM Écrêteur Soft Knee
ST COMP

Même chose que ci-dessus : à 
utiliser sur deux canaux formant 
une paire stéréo.

Sft ST COMP
ST LIM

Sft ST LIM

PEAK LIM Écrêteur de pointe (Look Ahead)

1

2 3 4

5

67
FIGURE 7-2 : Fenêtre Sft ST COMP
© 2003 Shure Incorporated Guide du logiciel DFR22 52



Compresseur/écrêteur
Les types suivants de processeurs sont disponibles dans les écrêteurs et les compresseurs :

• Soft Knee - Ces processeurs permettent d’obtenir une transition progressive d’un signal non comprimé à 
un signal comprimé. Ils utilisent un pourcentage plus élevé des ressources totales de traitement numérique 
des signaux que ceux sans option Soft Knee.

• Stéréo - Ces processeurs permettent de préserver une image stéréo en plaçant deux blocs fonctionnant 
comme un processeur unique sur deux canaux différents. Les deux canaux de processeur réagissent avec 
une réduction de gain identique lorsque l’entrée à l’un ou l’autre canal dépasse le seuil. Ces processeurs 
utilisent un pourcentage plus élevé des ressources totales de traitement numérique des signaux que les 
processeurs mono.

Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres des compresseurs et des écrêteurs en prenant
le Sft ST COMP à titre d’exemple, comme illustré à la figure 7-2 ci-dessus. Tous les processeurs abordés dans
cette section fonctionnent de manière très similaire. Toutes les différences entre leurs caractéristiques et leur
fonctionnalité sont indiquées quand il y a lieu.

1) Diagramme de courbe de transfert
Le diagramme de courbe de transfert affiche le niveau de seuil et les paramètres de taux de compression
sous forme d’éléments graphiques pouvant être positionnés à l’aide de la souris. La courbe de transfert
résultante représente le changement du niveau de sortie de signal.

2) Curseur de seuil
La position du curseur de seuil correspond au réglage de la commande de seuil. Il est possible de glisser
ce curseur à l’aide de la souris vers la gauche et la droite le long du bord supérieur du diagramme de
courbe de transfert pour changer le réglage du seuil.

3) Curseur de rapport
La position du curseur de rapport correspond au réglage de la commande de rapport. Il est possible de
glisser ce curseur à l’aide de la souris vers le haut et le bas le long du bord droit du diagramme de courbe
de transfert pour changer le réglage du rapport.

4) Vumètre de réduction de gain
Ce vumètre indique l’augmentation ou la réduction totale de gain obtenue sur le signal d’entrée avec les
paramètres de processeur en vigueur. Il est possible d’activer et de désactiver cette fonction en choisis-
sant l’option [Options>Gain Reduction Meter] (Options>Vumètre de réduction de gain) sur le menu. Elle
est active par défaut.

5) Commandes de gain
Utiliser les commandes de gain pour régler les niveaux de gain d’entrée et de sortie. Les niveaux de gain
disponibles vont de -12 dB à +12 dB par paliers de 0,5 dB, la valeur par défaut étant de 0 dB. Il est possible
de changer la valeur en utilisant les conventions décrites dans la section Affaiblisseurs à la page 35.

6) Sélecteurs de vumètre de courbe de transfert (processeurs stéréo uniquement)
Ces boutons permettent de choisir le ou les canaux pour lesquels une visualisation du vumètre de courbe
de transfert est souhaitée. Lorsque le vumètre est actif pour le canal en question, le bouton correspondant
s’allume en vert.

7) Vumètre de courbe de transfert
En mode Live, ce vumètre indique le niveau d’entrée et le niveau relatif de sortie du signal pour permettre
de surveiller l’effet du processeur sur le niveau sonore du programme en cours. Il est possible d’activer et
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Compresseur/écrêteur
de désactiver cette fonction en choisissant l’option [Options>Transfer Curve Meter] (Options>Vumètre de
courbe de transfert) sur le menu. Elle est active par défaut.

Indicateur de dépassement du seuil

Threshold (Seuil)
Il indique le niveau de gain que doit atteindre le signal avant que le processeur ne com-
mence à le comprimer. Il est possible de changer la valeur en cliquant sur les boutons
compteur circulaire, en tapant une valeur précise ou en utilisant le curseur de seuil qui se
trouve au-dessus du diagramme de courbe de transfert. Les valeurs disponibles vont de -

60 dB à +20 dB par paliers de 0,5 dB, la valeur par défaut étant 0 dB.

Ratio (Rapport)
Il indique la réduction de gain obtenue à la sortie du processeur par rapport au niveau
d’entrée. Un rapport de 4:1, par exemple, signifie qu’une augmentation de 4 dB du niveau
sonore du programme entraîne une augmentation de 1 dB du niveau de sortie du proces-

seur. Il est possible de changer la valeur en cliquant sur les boutons compteur circulaire, en tapant une
valeur précise ou en utilisant le curseur de rapport qui se trouve sur le côté droit du diagramme de courbe
de transfert. Les valeurs disponibles vont de 1:1 à INF:1 par paliers d’un dixième, la valeur par défaut étant
2:1 pour les compresseurs et 10:1 pour les écrêteurs. L’écrêteur de pointe a un rapport fixe de INF:1. 

Attack (Attaque)
Cette valeur indique le temps qui s'écoule avant que le processeur ne commence à réduire
le gain une fois que le niveau du signal d’entrée dépasse le seuil. Les valeurs disponibles
vont de 1 à 200 ms, la valeur par défaut étant 5 ms pour les compresseurs et 2 ms pour les

écrêteurs. L’écrêteur de pointe a un temps d'attaque fixe de 0 ms.

Decay (Déclin)
Cette valeur indique le temps qui s'écoule avant que le processeur ne revienne au gain
unité une fois que le niveau du signal d’entrée tombe en dessous du seuil. Les valeurs dis-
ponibles vont de 50 à 1000 ms, la valeur par défaut étant 100 ms pour les compresseurs,

50 ms pour les écrêteurs et 20 ms pour l’écrêteur de pointe.

Knee (Coude)
Dans les processeurs Soft Knee, cette commande affiche une liste déroulante sur laquelle on peut choisir
une compression à coude progressif ou à coude brusque. Le réglage par défaut est SOFT (Coude progres-
sif). Cette commande est désactivée sur les compresseurs et écrêteurs standard.

Remarque : Le logiciel du DFR22 risque d’être moins performant si un grand nombre de vumètres y 
sont actifs. Il est possible de désactiver sélectivement le vumètre de courbe de transfert 
ou celui de réduction de gain, voire les deux, à partir du menu [Options].

Le niveau du signal a dépassé le seuil Cet indicateur s’allume en jaune lorsque le sig-
nal à l’entrée du bloc processeur excède le seuil 
spécifiéLe niveau du signal n’a pas atteint le seuil

Processeur Soft Knee Choisir SOFT (Coude progressif) ou HARD (Coude 
brusque) sur la liste déroulante.

Processeur standard La commande est désactivée.
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Compresseur/écrêteur
Default (Réglage par défaut)
Cliquer sur ce bouton pour rétablir les paramètres système par défaut du processeur.

Bypass (Contournement)

Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Processeurs Soft Knee
Les exemples qui suivent illustrent la différence entre les paramètres des compressions à coude progressif et
à coude brusque. Tous les autres paramètres cités dans ces exemples restent identiques.

Un coude progressif, comme celui illustré à la
figure 7-3, est utile lorsqu’on travaille avec des taux
de compression élevés. Le coude progressif aug-
mente graduellement le taux de compression de 1:1 à
12 dB environ en dessous du seuil jusqu’au taux
spécifié à 20 dB environ au-dessus du seuil.Cette
augmentation graduelle du taux rend la compression
plus discrète qu’elle ne l’est avec le coude brusque.

Le coude brusque, illustré à la figure 7-4, active 
immédiatement la compression au taux qui a été 
spécifié une fois que le niveau du signal dépasse le 
seuil. Il est particulièrement utile dans un écrêteur 
parce qu’il empêche les pointes soudaines de 
dépasser le seuil sans affecter le signal inférieur à ce 
dernier.

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le 
modifier. Lorsque le contournement est actif, le bouton est 
allumé en rouge. Le réglage par défaut est inactif.Contournement inactif

Remarque : Lorsque le contournement est actif dans l’écrêteur de pointe, le délai de 1 ms n’est 
pas contourné.

Processeur lié

Processeur non lié

Remarque : Si la situation demande un coude brusque, il est possible d’économiser 
des ressources de traitement numérique des signaux en utilisant un pro-
cesseur standard au lieu d’un processeur Soft Knee.

FIGURE 7-3 : Option 
Soft Knee

FIGURE 7-4 : Option 
Hard Knee
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Processeurs stéréo
Les processeurs stéréo ont les mêmes caractéristiques et la même fonctionnalité que leurs homologues mono,
tout en offrant quelques fonctions supplémentaires.

• Les changements apportés aux paramètres de l’un des deux canaux du processeur s’appliquent égale-
ment à l’autre canal.

• Les deux canaux de processeur réagissent avec une réduction de gain identique lorsque l’entrée à l’un ou 
l’autre canal dépasse le seuil.

• Les deux vumètres de courbe de transfert affichent le niveau d’entrée du canal A en rouge et celui du canal 
B en bleu.

• Des sélecteurs de vumètre permettent de visualiser en alternance le vumètre de courbe de transfert pour 
le canal A, le canal B, les deux ou ni l’un ni l’autre.

• Il y a un indicateur de dépassement du seuil pour les canaux A et B.
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Filtre répartiteur/séparateur/caisson de graves
Filtre répartiteur/séparateur/caisson de graves

Le filtre répartiteur divise le spectre de fréquences du signal d’entrée en plusieurs bandes, puis sort chaque bande 
dans un canal distinct. Le séparateur distribue le signal d’entrée à travers deux sorties sans autre traitement particulier. 
Le caisson de graves est un filtre passe-bas simple. Étant entièrement configurable, il peut également être utilisé 
comme filtre passe-bande ou passe-haut.

Fonction
Utiliser le filtre répartiteur pour diviser la gamme de fréquences du signal d’entrée à l’aide de deux filtres, puis
distribuer chaque bande de fréquences à une sortie distincte pour différents types de haut-parleurs. Utiliser le
séparateur simplement pour distribuer le même signal aux deux sorties. Utiliser le caisson de graves pour
isoler une seule bande de fréquences avant de transmettre le signal vers une sortie. Le filtre répartiteur, le
séparateur et le caisson de graves ne sont destinés qu’au traitement des sorties et ne peuvent pas être placés
sur les bandes de canaux d’entrée. Voir la section Ajout de processeurs : Le filtre répartiteur, le séparateur et
le caisson de graves à la page 24 pour de plus amples informations sur le placement de ces processeurs dans
le diagramme de fluence

Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres du filtre répartiteur et du caisson de graves en
prenant le XOVER 2 à titre d’exemple, comme illustré ci-dessus à la figure 7-5. Les caractéristiques du caisson
de graves sont identiques, à l’exception du nombre de filtres passe-bande. Le séparateur n’a pas de fenêtre de
paramètres, car il n’effectue aucun traitement sur le signal ; il se contente de le diriger.

Nom de bloc Description
XOVER 2 Filtre répartiteur à 2 voies
SPLIT 2 Séparateur à 2 voies
SUB Caisson de graves

1

2

3

4 5 6 7

FIGURE 7-5 : Fenêtre XOVER2
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Filtre répartiteur/séparateur/caisson de graves
1) Commandes de bande passante
Il existe un jeu de commandes pour chaque canal de sortie associé aux bandes passantes.

2) Labels de canaux de sortie
Ces labels situés en tête des colonnes des commandes de bande passante sont codés couleur en fonction
des courbes de bande passante correspondantes du traceur de réponse. Ils indiquent le canal de sortie
vers lequel chaque bande passante est dirigée. 

3) Traceur de réponse
Cette zone de la fenêtre affiche une représentation graphique des filtres passe-bande et des points de
répartition, qu’il est possible de manipuler en cliquant dessus et en les glissant à l’aide de la souris.

4) Bandes passantes
De chaque côté de chaque bande se trouve un manipulateur de coude qu’il est possible de glisser vers la
gauche et la droite pour régler indépendamment les fréquences de coude supérieure et inférieure. Au
milieu de chaque bande se trouve également un manipulateur de gain qu’il est possible de glisser vers le
haut et le bas pour régler le niveau de sortie de la bande passante. Lorsqu’un manipulateur est choisi, une
boule colorée apparaît à l’intérieur pour indiquer qu’il représente la commande active. Les pentes
supérieure et inférieure du filtre sont établies à l’aide des commandes de bande passante situées dans la
partie inférieure de la fenêtre.

5) Manipulateur de gain
Glisser ce manipulateur vers le haut ou le bas pour régler le gain de la bande passante. La position de ce
manipulateur correspond au réglage de la commande [GAIN].

6) Manipulateur de filtre répartiteur
Ce manipulateur indique la fréquence du point de répartition entre deux bandes passantes. Il est possible
de le glisser vers la gauche et la droite pour régler simultanément les fréquences de coude des pentes
sécantes de filtre. Lorsqu’un manipulateur de filtre répartiteur est choisi, il devient vert pour indiquer qu’il
représente la commande active et les manipulateurs de coude correspondants se remplissent pour
indiquer qu’ils sont sélectionnés. Les manipulateurs de coude conservent leurs positions respectives lor-
squ’on glisse le manipulateur de filtre répartiteur.

7) Manipulateurs de coude
Glisser ces manipulateurs vers la gauche ou la droite pour régler les fréquences de coude de la bande
passante. La position de ces manipulateurs correspond au réglage des commandes [LOW CORNER FREQ]
(Fréquence de coude inférieur) et [UPPER CORNER FREQ] (Fréquence de coude supérieur).

Set and Show Gains/Normalize Plot (Établir et afficher gains/normaliser tracé)
Cliquer en alternance sur ces deux boutons pour afficher alternative-
ment les bandes passantes à leurs niveaux de gain réels et les afficher
après normalisation. Le réglage par défaut est [SET AND SHOW GAINS
ON PLOT].

Lorsque les niveaux de gain des bandes passantes diffèrent de
manière significative, le point de répartition apparaît décalé par rapport
à sa position réelle, comme illustré à la figure 7-6. Passer en mode de
normalisation de l'affichage de tracé lorsqu'il est nécessaire de visual-
iser la position précise du point de répartition, comme illustré à la
figure 7-7.

Remarque : Pour visualiser l’effet du filtre répartiteur sur le chemin de signal, choisir [View>Combined Response 
Curve] (Vue>Courbe de réponse combinée) sur le menu principal. Pour de plus amples renseigne-
ments, voir la section Diagramme de réponse combinée à la page 40.

FIGURE 7-6 : [SET AND SHOW GAINS 
ON PLOT]
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Filtre répartiteur/séparateur/caisson de graves
• Cliquer sur le bouton [SET AND SHOW GAINS ON PLOT] pour 
afficher et régler les niveaux de gain des bandes passantes. 
Dans ce réglage, les niveaux de filtrage sont reflétés dans le 
traceur de réponse et les manipulateurs de gain sont visibles 
sur les bandes passantes.

• Cliquer sur le bouton [NORMALIZE PLOT] pour afficher les 
bandes passantes au gain unité dans le traceur de réponse. 
Les paramètres réels de gain ne sont pas affectés par ce 
réglage.

Default (Réglage par défaut)
Cliquer sur ce bouton pour rétablir les paramètres système par défaut du processeur.

Mute (Coupure)

Polarity (Polarité)

Low Corner Freq
Cette valeur indique le réglage de la fréquence du coude inférieur de la bande passante. La
plage de valeurs disponibles dépend du réglage de la fréquence du coude supérieur car les
fréquences de coudes ne peuvent pas se chevaucher. Il est possible de changer la valeur

en cliquant sur les boutons compteur circulaire, en utilisant des commandes au clavier ou en tapant une
valeur précise. Les valeurs par défaut pour les bandes passantes sont répertoriées ci-dessous.

Low Filter Type/Upper Filter Type (Type de filtre passe-bas/passe-haut)
Cette valeur indique la pente du coude de bande passante correspondant. Choisir une
valeur sur le menu déroulant comme indiqué ci-dessous. Le réglage par défaut est 24 dB/

oct Linkwitz-Riley.

Coupure active Cliquer sur ce bouton pour couper la sortie de la bande correspon-
dante. Lorsque la coupure est active, le bouton est allumé en rouge. 
Le réglage par défaut est inactif.Coupure inac-

tive

Polarité normale
Cliquer sur ce bouton pour inverser la polarité du signal quittant le 
filtre répartiteur. La polarité par défaut est la polarité normale.

Polarité inverse

Bande 1 OUT (SORTIE)
Bande 2 2,0 kHz

Abréviation Description
6 Butt 6 dB/oct Butterworth
6 Bessel 6 dB/oct Bessel
12 Butt 12 dB/oct Butterworth
12 Bess 12 dB/oct Bessel
12 L-R 12 dB/oct Linkwitz-Riley
18 Butt 18 dB/oct Butterworth
18 Bessel 18 dB/oct Bessel
24 Butt 24 dB/oct Butterworth

FIGURE 7-7 : [NORMALIZE PLOT}
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Filtre répartiteur/séparateur/caisson de graves
Upper Corner Freq
Cette valeur indique le réglage de la fréquence du coude supérieur de la bande passante.
La plage de valeurs disponibles dépend du réglage de la fréquence du coude inférieur car
les fréquences de coudes ne peuvent pas se chevaucher. Il est possible de changer la

valeur en cliquant sur les boutons compteur circulaire, en utilisant des commandes au clavier ou en tapant
une valeur précise. Les valeurs par défaut pour les bandes passantes sont répertoriées ci-dessous.

Gain
Utiliser les commandes de gain pour régler les niveaux de gain de sortie. Les niveaux de
gain disponibles vont de -18 dB à +12 dB par paliers de 0,5 dB, la valeur par défaut étant
de 0 dB. Il est possible de changer la valeur en utilisant les conventions décrites dans la
section Affaiblisseurs à la page 35.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Commandes au clavier
Il est possible d’utiliser des commandes au clavier pour effectuer des réglages fins des positions des
manipulateurs dans le traceur de réponse. Cliquer pour choisir un manipulateur, puis utiliser les raccourcis
suivants.

24 Bess 24 dB/oct Bessel
24 L-R 24 dB/oct Linkwitz-Riley

Bande 1 2,0 kHz
Bande 2 OUT

Processeur lié

Processeur non lié

Touche Réglage de fréquence
� Réduit la fréquence d’un point à l’écran
� Augmente la fréquence d’un point à l’écran

Maj + � Réduit la fréquence de 1/3 d’octave
Maj + � Augmente la fréquence de 1/3 d’octave

Remarque : Pousser la fréquence d’un point à l’écran change la valeur d’environ 1/100 d’octave, 
ou 1 %.

Touche Réglage de gain
� Augmente le gain de 0,5 dB
� Réduit le gain de 0,5 dB

Maj + �
ou Page précédente Augmente le gain de 3 dB

Maj + �
ou Page suivante Réduit le gain de 3 dB

Barre d’espacement ou
bouton droit de la souris Établit le gain à 0 dB
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Filtres passe-haut et passe-bas et de dégradé
Filtres passe-haut et passe-bas et de dégradé

Les filtres passe-haut et passe-bas et de dégradé amplifient ou coupent les haute et basse fréquences caractéristiques 
globales d’un système et augmente l’atténuation des limites maximum et minimum du spectre de fréquences.

Fonction
Utiliser ce processeur lorsqu’il est nécessaire de combiner des filtres passe-haut et passe-bas et une égalisa-
tion en salle aux deux extrémités d’un spectre large. Les filtres passe-haut et passe-bas se caractérisent par
une grande diversité d’options de pente, allant de -6 dB/oct à -24 dB/oct. Il est également possible de spécifier
la pente de coude des filtres de dégradé, qui peut être de 6 dB/oct ou 12 dB/oct.

Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres propres au processeur passe-haut et passe-bas
et de dégradé, comme illustré ci-dessus à la figure 7-8.

1) Diagramme de réponse
Cette courbe est une représentation graphique des résultats combinés de l’action des manipulateurs de fil-
tres dans le traceur de réponse.

Nom de bloc Description

CUT/SHELF Filtres passe-haut et passe-bas/filtres de dégradé 
haute et basse fréquences

Remarque : La courbe ne reflète pas l’effet cumulé de plusieurs blocs processeur dans le 
chemin du signal. Pour visualiser une courbe combinée, choisir [View>Combined 
Response Curve] sur le menu principal. Pour de plus amples renseignements, voir 
la section Diagramme de réponse combinée à la page 40.

1

2

3

4

FIGURE 7-8 : Fenêtre CUT/SHELF
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2) Traceur de réponse
Cette zone de la fenêtre de paramètres affiche une représentation graphique des manipulateurs de fil-
tres passe-haut et passe-bas et de dégradé, qu’il est possible de manipuler en cliquant dessus et en les
glissant à l’aide de la souris. Lors de l’ouverture initiale de la fenêtre de paramètres, les manipulateurs
de filtres apparaissent dans leurs positions par défaut dans le système aux limites maximum et minimum
du spectre de fréquences. Cliquer sur un manipulateur pour visualiser sa courbe de réponse et régler
ses paramètres.

3) Filtres passe-haut et passe-bas
Les filtres passe-haut et passe-bas apparaissent sous forme de manipulateurs au bord inférieur du traceur
de réponse avec des lignes pointillées verticales se prolongeant le long de leur centre de fréquence. Le
réglage de fréquence par défaut est OUT et le type par défaut est 6 dB/Butterworth.

4) Filtres de dégradé
Les filtres passe-haut et passe-bas et de dégradé apparaissent le long d’un axe horizontal au milieu du tra-
ceur de réponse. Le réglage de fréquence par défaut est OUT et le type par défaut est 6 dB/oct.

Freq (Fréquence)
Cette valeur indique la fréquence du point filtre choisi. Il est possible de changer la
valeur en cliquant sur les boutons compteur circulaire, en utilisant des commandes au

clavier ou en tapant une valeur précise. La gamme de fréquences va de 25 Hz à 20 kHz, OUT étant le
réglage par défaut.

Type
Cette valeur indique le type de pente du filtre choisi. Les valeurs disponibles
dans le menu déroulant varient pour les filtres passe-haut et passe-bas et
ceux de dégradé comme indiqué ci-dessous.

* Indique le réglage par défaut

Gain
Cette valeur indique le réglage de gain actif du filtre de dégradé choisi. Les niveaux de
gain disponibles vont de -18 dB à +18 dB par paliers de 0,5 dB, la valeur par défaut

étant de 0 dB. Il est possible de changer la valeur en utilisant les conventions décrites dans la section
Affaiblisseurs à la page 35. Lorsqu’on travaille avec un filtre passe-haut ou passe-bas, cette commande
est désactivée et le mot « CUT » (passe-haut/passe-bas) est affiché.

Clear (Réinitialisation)
Cliquer sur ce bouton pour rétablir les réglages par défaut des filtres. Il ouvre la boîte de dia-
logue Clear (Figure 7-20 à la page 87) qui donne le choix entre la réinitialisation des paramètres

de tous les filtres ou de ceux des filtres sélectionnés uniquement.

Dégradé Passe-haut et passe-bas

6 dB/octave*
12 dB/octave

6 dB/oct Butterworth* 18 dB/oct Butterworth
6 dB/oct Bessel 18 dB/oct Bessel
12 dB/oct Butterworth 24 dB/oct Butterworth
12 dB/oct Bessel 24 dB/oct Bessel
12 dB/oct Linkwitz-Riley 24 dB/oct Linkwitz/Riley
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Bypass (Contournement)

Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

ASCII File (Importation de fichiers ASCII)
Cette fonction permet l’importation de données de fréquences dans le diagramme de
réponse à partir de SIA Smaart et de Gold Line TEF. Une fois dans le diagramme, les don-
nées graphiques peuvent être utilisées à titre de référence lors de la modification de la
courbe de réponse du processeur. Se reporter à la page 38 pour obtenir des instructions

sur la façon d’utiliser la fonction d’importation de fichiers ASCII.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Affinage des paramètres
Il est possible d’ajuster avec précision les paramètres du filtre choisi en appliquant l’une quelconque des
méthodes suivantes :

• Saisie d’un chiffre dans l’une quelconque des boîtes de paramètres
• Utilisation des boutons compteur circulaire (ou de la boîte déroulante) voisins des boîtes de 

paramètres
• Utilisation de commandes au clavier

Commandes au clavier
Il est possible d’utiliser les commandes au clavier suivantes pour affiner le réglage du filtre choisi.

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le modi-
fier. Lorsque le contournement est actif, le bouton est allumé en 
rouge. Le réglage par défaut est inactif.Contournement inactif

Processeur lié

Processeur non lié

Touche Résultat
� Réduit la fréquence d’un point à l’écran
� Augmente la fréquence d’un point à l’écran
� Augmente le gain de 0,5 dB
� Réduit le gain de 0,5 dB

Maj + � Réduit la fréquence de 1/3 d’octave
Maj + � Augmente la fréquence de 1/3 d’octave
Maj + �

ou Page précédente Augmente le gain de 3 dB
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Copie et collage
Les paramètres des manipulateurs de filtres peuvent être copiés et collés d’une fenêtre de processeur « Cut
and Shelf » à une autre.

Pour copier et coller des filtres :
1. Cliquer pour choisir un seul filtre ou en choisir plusieurs en appliquant l’une des méthodes suivantes :

• Ctrl + Cliquer.
• Utiliser la commande [Edit>Select All] (Édition>Choisir tous les filtres) du menu.

2. Choisir la commande [Edit>Copy] du menu.
3. Ouvrir la fenêtre de processeur « Cut and Shelf » dans laquelle on désire coller des paramètres de filtre.
4. Choisir la commande [Edit>Paste] (Édition>Coller) du menu.

Maj + �
ou Page suivante Réduit le gain de 3 dB

Barre d’espacement ou
bouton droit de la souris Établit le gain à 0 dB

Suppr Rétablit les paramètres par défaut du ou 
des filtres choisis

Remarque : Pousser la fréquence d’un point à l’écran change la valeur d’environ 1/100 
d’octave, ou 1 %

Remarque : Lorsque plusieurs filtres sont sélectionnés en même temps, ils sont mis en surbril-
lance rose et leurs paramètres sont verrouillés. Pour désélectionner l'un de ces 
filtres, appuyer sur la touche Echap ou cliquer sur une commande quelconque à 
l'extérieur de la zone de sélection.
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Délai

Le processeur de délai stocke provisoirement le signal en mémoire de délai, puis le transmet au bout de l’intervalle 
spécifié. Le processeur audio offre les types suivants de délai :

Fonction
Utiliser le délai pour aligner le son de différents haut-parleurs de façon à ce qu’il parvienne au public en même
temps. Le délai peut également être utilisé pour corriger des problèmes d’annulation de phase entre les haut-
parleurs installés. Le délai peut être calculé en tranches de temps, de distance et de température de l’air. 

Fonctions de la fenêtre de paramètres
Cette section décrit les caractéristiques des processeurs de délai en prenant le DLY150 à titre d’exemple,
comme illustré ci-dessus à la figure 7-9. Les caractéristiques des autres délais sont identiques, en dehors du
délai maximum disponible.

Units (Unités)
Utiliser cette commande pour spécifier si les paramètres doivent être exprimés en
unités U.S. (English) ou métriques (Metric). Le réglage par défaut est métrique.

Time (Temps)
Utiliser cette commande pour spécifier le délai en millisecondes. Les valeurs vont
de 0 ms au délai maximum du bloc processeur, dans ce cas 150 ms. La valeur par
défaut est 0 ms.

Nom de bloc Description
DLY5ms Délai de 5 millisecondes au maximum
DLY150ms Délai de 150 millisecondes au maximum
DLY500ms Délai de 500 millisecondes au maximum
DLY2s Délai de 2 secondes au maximum

Remarque : Chaque type de bloc processeur de délai utilise la capacité maximum de mémoire de délai 
indiquée dans le nom du bloc, quelle que soit la capacité réellement utilisée. Pour écono-
miser les ressources du processeur audio, choisir le processeur de délai dont la capacité 
de mémoire est la plus proche du délai maximum nécessaire.

FIGURE 7-9 : Fenêtre DLY 150ms
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Distance
Utiliser cette commande pour spécifier le délai en distance. La gamme de
valeurs varie suivant le délai maximum mais la valeur par défaut est toujours
zéro. Choisir l’unité de mesure appropriée à l’aide des cases d’option situées

à droite de la commande. Lorsque les unités U.S. sont sélectionnées, il est possible de choisir entre
pouces et pieds. Lorsque les unités métriques sont sélectionnées, la distance est indiquée en mètres.

Air Temp (Température de l’air)
Utiliser cette commande lors du réglage du délai en distance, dans la
mesure où la vitesse du son est affectée par la température de l’air. Les
valeurs vont de -13 à 122 °F, ou -25 à 50 °C. Lorsque les unités U.S. sont

sélectionnées, la température de l'air est indiquée en degrés Fahrenheit. Lorsque les unités métriques sont
sélectionnées, la température de l’air est indiquée en degrés Celsius. La valeur par défaut est de 69° Fahr-
enheit ou 20° Celsius.

Bypass (Contournement)

Clear (Réinitialisation)
Cliquer sur ce bouton pour rétablir les paramètres système par défaut du processeur.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le modi-
fier. Lorsque le contournement est actif, le bouton est allumé en 
rouge. Le réglage par défaut est inactif.Contournement inactif

Processeur lié

Processeur non lié
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Réducteur numérique de Larsen (DFR)

Le réducteur numérique de Larsen est doté de l’algorithme breveté Adaptive Notch Filter (Filtre coupe-bande adaptatif) 
de Shure, capable de différencier les sons Larsen et non Larsen. Il détecte automatiquement le Larsen et déploie des 
filtres coupe-bande à bande étroite aux fréquences de Larsen détectées. Aucun système de sonorisation (combinaison 
de microphones, de mixage, de traitement des signaux, d’amplificateurs de puissance et de haut-parleurs) ne présente 
une réponse absolument plate. Lorsque le niveau sonore d’un système augmente, les fréquences correspondant aux 
pointes sont les premières à dépasser le seuil du Larsen. Le réducteur numérique de Larsen atténue ces fréquences, 
ce qui aplatit le diagramme de réponse du système de sonorisation. Le système peut alors fonctionner à un niveau glo-
bal plus élevé. Le processeur audio DFR22 offre les types suivants de réducteurs numériques de Larsen :

Fonction
Utiliser le réducteur numérique de Larsen comme processeur initial sur tout canal d'entrée recevant un signal
d’un microphone de direct dans lequel le Larsen pose un problème. Lorsque le réducteur numérique détecte
un Larsen, il insère un filtre étroit et fin dans le chemin audio, ce qui réduit le gain à la fréquence causant le
Larsen. Ce filtre est appelé filtre coupe-bande car il affecte une section étroite du spectre de fréquences. La
largeur avec laquelle de nouveaux filtres se déploient peut être spécifiée grâce au réglage du facteur Q des fil-
tres, auquel on peut accéder par le biais du menu [Options] du réducteur numérique de Larsen. Pour de plus
amples renseignements sur la largeur des filtres coupe-bande, voir la section Filtres à facteur Q élevé/bas à la
page 72

Le réducteur numérique de Larsen stéréo déploie un filtre coupe-bande sur les deux canaux à la même
fréquence et à la même profondeur lorsqu’un Larsen est détecté sur l’un ou l’autre des canaux. De cette
manière, il permet de préserver l’image stéréo.

Nom de bloc Description
DFR5 Réducteur numérique de Larsen à 5 bandes
DFR10 Réducteur numérique de Larsen à 10 bandes
DFR16 Réducteur numérique de Larsen à 16 bandes
ST DFR5

Même chose que ci-dessus : à utiliser 
sur deux canaux formant une paire 
stéréo.

ST DFR10

ST DFR16

1

FIGURE 7-10 : Fenêtre DFR10

2
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Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres du réducteur numérique de Larsen en prenant le
DFR10 à titre d’exemple, comme illustré ci-dessus à la figure 7-10. Les caractéristiques des autres réducteurs
numériques de Larsen sont identiques, à l’exception du nombre de filtres coupe-bande disponibles et de la
fonctionnalité stéréo.

1) Diagramme de réponse
Cette courbe est une représentation graphique des résultats combinés de l’action des filtres coupe-bande
actifs (en surbrillance jaune) du processeur.

2) Filtre actuellement sélectionné

Cette ligne apparaît sur le diagramme de réponse à la fréquence correspondant au filtre actuellement 
sélectionné, qui est encadré par deux flèches rouges sur la rangée des filtres de Larsen.

Freq (Fréquence)
Cette valeur indique la fréquence du filtre choisi. Il est possible de changer la valeur en
cliquant sur les boutons compteur circulaire, en utilisant des commandes au clavier ou en
tapant une valeur précise. La gamme de fréquences va de 25 Hz à 20 kHz, OUT étant le
réglage par défaut.

Depth (Profondeur)
Cette valeur indique la réduction de gain du filtre choisi. Les niveaux de gain disponibles
vont de 0 à -18 dB par paliers de 0,5 dB, la valeur par défaut étant de 0 dB.

Type
Cette valeur indique le type de bande passante du filtre choisi. Choisir HIGH Q (Q élevé)
ou LOW Q (Q bas) sur le menu déroulant. HIGH Q est la valeur par défaut. Voir la section

Filtres à facteur Q élevé/bas à la page 72 pour de plus amples renseignements.

Filtres de Larsen
Les commandes de filtres de Larsen apparaissent sous la forme d’une rangée de
témoins DEL. Il est possible de spécifier les nombres respectifs de filtres fixes et
dynamiques en glissant les crochets rouges vers la gauche et la droite à l’aide de
la souris. Les filtres actifs sont indiqués en jaune et apparaissent dans le dia-
gramme de réponse. Voir la section Affectation des filtres à la page 71 pour de

plus amples renseignements.

Lock (Verrouillage)
Cliquer sur ce bouton pour empêcher le déploiement de nouveaux filtres et l’approfondissement des filtres
existants. Utiliser cette option pour empêcher le réducteur de déployer des filtres pour des programmes
dans lesquels sont présents un Larsen volontaire ou des sons très semblables au Larsen (tels qu’effets de
guitare, sons synthétisés, flûte ou grand orgue). Lorsque la fonction de verrouillage est activée, le bouton
correspondant est allumé en rouge. Le réglage par défaut est inactif.

Remarque : La courbe ne reflète pas l’effet cumulé de plusieurs blocs processeur dans le chemin du sig-
nal. Pour visualiser une courbe combinée, choisir [View>Combined Response Curve] sur le 
menu principal. Pour de plus amples renseignements, voir la section Diagramme de réponse 
combinée à la page 40.

Verrouillage actif

Verrouillage inactif
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Bypass (Contournement)
Cliquer sur ce bouton pour désengager la fonction de filtrage coupe-bande du réducteur numérique de
Larsen. La fonction de contournement verrouille aussi le réducteur numérique de Larsen, empêchant le
déploiement de nouveaux filtres. Lorsque le contournement est actif, le bouton est allumé en rouge. Le
réglage par défaut est inactif.

Clear (Réinitialisation)
Cliquer sur ce bouton pour réinitialiser les paramètres de filtres. Il ouvre la boîte de dialogue
Clear (Figure 7-20 à la page 87) qui donne le choix entre la réinitialisation des paramètres de
tous les filtres ou de ceux des filtres sélectionnés uniquement.

Auto Clear (Réinitialisation automatique)
Cliquer sur ce bouton pour ouvrir la boîte de dialogue « Auto Clear », comme indiqué à la page 73. Cette
fonction permet de spécifier si et quand le réducteur numérique de Larsen doit réinitialiser les filtres
dynamiques qu’il a affectés et annuler les changements apportés à la profondeur des filtres fixes. Le bou-
ton est allumé en vert lorsque cette fonction est activée. Le réglage par défaut est inactif.

Front panel (Panneau frontal)
Utiliser cette commande pour affecter le réducteur numérique de Larsen aux témoins et
commandes du panneau frontal. Lorsqu’un réducteur numérique de Larsen est affecté au
panneau frontal, les témoins de la ou des rangées spécifiées s’allument sous l’effet des fil-

tres actifs et les boutons du panneau frontal permettent de commander le processeur. Pour une description
des boutons du panneau frontal, voir le Guide d’installation. Un seul réducteur numérique de Larsen peut être
affecté à une rangée donnée du panneau frontal. Le réglage par défaut est Unassigned (Non affecté).

Contournement actif

Contournement inactif

Réinitialisation automatique active

Réinitialisation automatique inactive

Proces-
seur Réglages

Réducteur 
numérique 
de Larsen 
mono

[Unassigned]
[Row A] (Rangée A)
[Row B] (Rangée B)

Réducteur 
numérique 
de Larsen 
stéréo

[Unassigned]
[Rows A & B] (Rangées A 
et B)

Remarque : Dans le diagramme de fluence, lorsque l’on copie et colle un bloc réducteur numérique 
de Larsen qui est affecté au panneau frontal, le nouveau bloc collé ne sera pas lui-même 
affecté. Lorsque l’on coupe et colle un bloc réducteur numérique de Larsen qui a été 
affecté au panneau frontal, il reste affecté.
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Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Configuration de base du réducteur numérique de Larsen
Le réducteur numérique de Larsen (comme tout autre processeur de réduction de l’effet Larsen) ne permet pas
d’augmenter le gain au-delà des limites physiques du système de sonorisation. Dans la plupart des cas, un
point de réaction décroissante est atteint une fois que cinq ou huit filtres coupe-bande sont insérés. Ceci est dû
au fait qu'il n'existe en général que quelques pointes dominantes dans la réponse du système. Le plus sou-
vent, l'utilisateur peut compter sur une amélioration de gain avant Larsen de 6 à 9 dB lorsqu’il utilise le réduc-
teur numérique de Larsen. Lorsque la « limitation » d’un système est effectuée et que de nombreuses
fréquences causent simultanément un effet Larsen, même lorsque le gain est lentement augmenté, cela signi-
fie que le point de réaction décroissante a été atteint. Si, à ce moment, le gain du système est toujours insuff-
isant avant l’apparition d’un Larsen, d'autres modifications, telles que le déplacement des micros et/ou des
haut-parleurs, doivent être apportées au système de sonorisation.

Le réducteur peut être configuré de deux façons de base pour réduire le Larsen, la méthode « de limitation » et
celle « d'assurance » décrites ci-dessous.

• Méthode de limitation - Cette méthode permet d’utiliser le réducteur à titre de mesure préventive contre 
le Larsen pour les canaux d’entrée utilisés près du point de Larsen et nécessitant une plus grande marge 
de stabilité. Elle permet d’augmenter le gain d’un canal d’entrée au-delà de son réglage normal pour 
causer délibérément le Larsen. Le réducteur insérera alors les filtres appropriés. Ensuite, lorsque le gain 
d’entrée est réduit à un niveau approprié, le système devient stable et utilisable.

• Méthode d’assurance - Cette méthode permet d’utiliser le réducteur comme une assurance complémen-
taire contre un Larsen inattendu dans un système de sonorisation par ailleurs stable. Il suffit de placer le 
processeur de réduction numérique de Larsen dans le chemin du signal sans définir de paramètres. Cette 
méthode convient aux systèmes présentant déjà un gain avant Larsen suffisant mais nécessitant une pro-
tection contre le Larsen occasionnel causé par des microphones mobiles ou des commandes de gain 
réglables par l'utilisateur.

Pour « limiter » le système : 
1. Supprimer tout filtre actif en cliquant sur le bouton [CLEAR].
2. La boîte de dialogue « Clear » s’ouvre.
3. Choisir [Clear All Filters] (Réinitialiser tous les filtres) et cliquer sur [OK].
4. Ouvrir tous les micros. 
5. Augmenter lentement le gain du système de sonorisation tout en parlant dans les microphones jusqu'à 

atteindre la première fréquence qui provoque un Larsen. Le processeur de réduction numérique de Larsen 
insérera un filtre coupe-bande pour atténuer cette fréquence. 

6. Lorsque le Larsen cesse au niveau du système, le niveau peut être augmenté davantage, puis le proces-
sus peut être répété pour d’autres fréquences. En général, le gain peut être accru de 3 à 9 dB au-dessus 
du niveau auquel le Larsen est apparu en premier lieu.

Processeur lié

Processeur non lié
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7. Affecter les filtres déployés comme filtres « fixes » (voir la section suivante intitulée Affectation des filtres). 
Les filtres dynamiques restants se déploieront selon le besoin lorsque le système est en usage. 

Affectation des filtres
Par défaut, la moitié des filtres du processeur de réduction numérique de Larsen sont affectés comme filtres
fixes et l’autre moitié comme filtres dynamiques. Toutefois, il est possible de choisir le nombre total de filtres
coupe-bande qui resteront fixes et le nombre de ceux qui seront affectés comme filtres dynamiques lorsque le
Larsen est détecté. Utiliser un plus grand nombre de filtres fixes sur les canaux d’entrée des microphones
fixes. Dans ce cas, l’acoustique des locaux définit les fréquences de Larsen dominantes, qui ne changent pas
sensiblement. Utiliser un plus grand nombre de filtres dynamiques sur les canaux d’entrée des microphones
sans fil ou à main. Dans ce cas, les fréquences de Larsen changent substantiellement lorsque l’utilisateur d’un
microphone déambule dans la salle ou sur la scène. Les filtres fixes de même que les filtres dynamiques
s’approfondissent automatiquement lorsqu’un Larsen est détecté.

• Filtres fixes - Une fois qu’elle est réglée, la fréquence d’un filtre fixe ne changera pas, à moins que tous 
les filtres soient réinitialisés manuellement.

• Filtres dynamiques - Lorsque tous les filtres de Larsen sont déployés et que de nouvelles fréquences de 
Larsen sont détectées, le réducteur numérique de Larsen redéploie chaque filtre dynamique pour la nou-
velle fréquence détectée, en partant du plus ancien et en allant vers le plus récent.

Il est possible de désigner les nombres respectifs de filtres fixes et
dynamiques en appliquant l’une ou l’autre des deux techniques
décrites ci-dessous : 

Pour utiliser la boîte de dialogue « Fixed » (Filtres fixes) :
1. Choisir [Options>Fixed filters allocation] (Options>Affectation des 

filtres fixes) sur le menu de la fenêtre du réducteur numérique de 
Larsen.

2. La boîte de dialogue « Fixed » apparaît, comme illustré sur la 
droite à la figure 7-11.

3. Taper le nombre de filtres fixes que l’on désire affecter. Le nombre de filtres dynamiques s’ajuste en con-
séquence.

4. Cliquer sur [OK].

Pour changer l’affectation des filtres à l’aide de la souris :
1. Positionner le curseur entre les crochets rouges comme indiqué sur la 

droite à la figure 7-12.
2. Le curseur prend la forme du symbole de redimensionnement horizontal 

: 
3. Cliquer et glisser vers la gauche pour augmenter le nombre de filtres 

dynamiques ou vers la droite pour augmenter celui de filtres fixes.

Remarque : Il est possible de copier les filtres fixes dans un bloc égaliseur paramétrique pour permettre la 
présence d’un plus grand nombre de filtres dynamiques dans la fenêtre du réducteur 
numérique de Larsen.

Remarque : Pour affecter des filtres à partir du panneau frontal, appuyer 
sur le bouton Auto Clear pour régler tous les filtres actuelle-
ment actifs sur fixe et tous les filtres actuellement inactifs sur 
dynamique. Pour de plus amples renseignements sur l’utilisa-
tion des commandes du panneau frontal du DFR22, voir le 
Guide d’installation.

FIGURE 7-11 : Boîte de dialogue « Fixed »

Positionner le curseur ici

ou ici

FIGURE 7-12 : Changement 
d’affectation des filtres à l’aide 

de la souris
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Filtres à facteur Q élevé/bas
Le réducteur numérique de Larsen permet de choisir entre deux largeurs pour les filtres coupe-bande, comme
illustré ci-dessous à la figure 7-13. Par défaut, les filtres du réducteur numérique de Larsen sont déployés
comme filtres [HIGH Q] (Filtres à facteur Q élevé). Au fur et à mesure que la profondeur d’un tel filtre s’accroît,
son facteur Q augmente jusqu’à une valeur de 101 (1/70e d’octave).

Il est également possible de déployer les filtres comme filtres [LOW Q] (Filtres
à facteur Q bas). Ce type de filtre affecte une gamme légèrement plus large
de fréquences en maintenant son facteur Q à une valeur de 14,42 (1/10e

d'octave) à mesure que la profondeur du filtre s'accroît.

• Pour changer le réglage d’un filtre existant, cliquer pour choisir le filtre et 
utiliser le menu déroulant [TYPE].

• Utiliser le menu [Options] pour choisir le facteur Q élevé ou bas pour 
tous les nouveaux filtres dynamiques au fur et à mesure de leur déploie-
ment.

Ajout, modification et suppression de filtres

Pour déployer ou modifier manuellement un filtre coupe-bande fixe :
1. Cliquer pour sélectionner un filtre fixe actif (en surbrillance jaune) ou, pour en activer un nouveau, choisir le 

filtre immédiatement à droite du dernier filtre actif.
2. Ajuster la fréquence, la profondeur et le type selon le besoin.
3. Les changements se reflètent dans le diagramme de réponse.

Pour supprimer tous les filtres coupe-bande actifs :
1. Cliquer sur le bouton [CLEAR].
2. La boîte de dialogue « Clear » apparaît, comme illustré à la figure 7-14.
3. Choisir [Clear All Filters] et cliquer sur [OK].
4. Cela supprime tous les filtres coupe-bande et aplatit le diagramme de 

réponse.

- OU -

1. Choisir la commande [Edit>Select All] sur le menu.
2. Tous les filtres déployés sont mis en surbrillance rose pour indiquer 

qu’ils sont sélectionnés.
3. Appuyer sur la touche Suppr.

Pour supprimer des filtres coupe-bande particuliers
1. Cliquer sur un indicateur de filtre pour le choisir ou appuyer sur Ctrl et cliquer pour choisir plusieurs filtres.
2. Appuyer sur la touche Suppr - OU -

Cliquer sur le bouton [CLEAR] pour ouvrir la boîte de dialogue « Clear », puis choisir l’option [Clear Selected 
Filter(s)] (Réinitialiser les filtres choisis).

Remarque : Seul un filtre actif ou le filtre inactif immédiatement voisin (à gauche ou à 
droite) peut être choisi.

Q élevé

Q bas
FIGURE 7-13 : Options de largeur des 

filtres coupe-bande

FIGURE 7-14 : Boîte de dialogue 
« Clear »
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Copie et collage
Les filtres coupe-bande peuvent être copiés et collés de la fenêtre d’un réducteur numérique de Larsen à celle
d’un autre. Le logiciel du DFR22 offre également la possibilité de copier et coller tout filtre actif de la fenêtre du
réducteur numérique de Larsen à une fenêtre d’égaliseur paramétrique (PEQ ou PEQ + CS). Le transfert de fil-
tres fixes dans une fenêtre d’égaliseur paramétrique permet d’affecter un plus grand nombre de filtres
dynamiques dans le bloc réducteur numérique de Larsen. Le collage de filtres dans un égaliseur paramétrique
à partir d’un réducteur numérique de Larsen, suivi de la suppression du bloc réducteur numérique de Larsen,
permet également d’économiser des ressources de traitement numérique des signaux.

Pour copier et coller des filtres :
1. Cliquer pour choisir un seul filtre ou en choisir plusieurs en appliquant l’une des méthodes suivantes :

• Appuyer sur Ctrl et cliquer sur chaque filtre que l’on veut sélectionner.
• Utiliser la commande [Edit>Select All] du menu.

2. Choisir la commande [Edit>Copy] du menu.
3. Ouvrir la fenêtre de processeur de réduction numérique de Larsen ou d’égaliseur paramétrique dans 

laquelle on désire coller les paramètres des filtres. S’assurer de choisir un bloc processeur ayant assez de 
filtres pour accueillir ceux qui viennent d’être copiés.

4. Choisir la commande [Edit>Paste] du menu.

Réinitialisation automatique
Par défaut, le réducteur numérique de Larsen enregistre l’état de ses filtres lors d’un changement de
préréglage ou d’une mise sous tension. Toutefois, il peut être configuré de manière à retirer automatiquement
les filtres dynamiques, ainsi que les changements apportés à la profondeur des filtres fixes, en fonction des
paramètres spécifiés par l'utilisateur dans la boîte de dialogue « Auto Clear », illustrée ci-dessous à la figure 7-
15. Il est possible d’accéder à cette boîte de dialogue en cliquant sur le bouton [AUTO CLEAR] dans la fenêtre du
réducteur numérique de Larsen.

Lorsque l’on coche la case [Enable Auto Clear] (Activer la réinitialisation automatique) dans la boîte de dia-
logue « Auto Clear », les filtres de réduction numérique de Larsen retourneront à l’état où ils se trouvaient
quand la fonction Auto Clear a été activée, à chaque fois qu’un changement de préréglage ou une mise sous
tension aura lieu. De plus, il est possible de spécifier une période de temps après laquelle tout filtre dynamique
et tout changement apporté à la profondeur des filtres fixes seront retirés.

Remarque : Il se peut que la bande passante des filtres de réducteur numérique de Larsen copiés 
dans un bloc égaliseur paramétrique diffère légèrement de celle du filtre d’origine mais 
qu’elle en soit très proche.

Remarque : Lorsque plusieurs filtres sont sélectionnés en même temps, ils sont mis en surbrillance 
rose et leurs paramètres sont verrouillés. Pour désélectionner l'un de ces filtres, cliquer 
sur une commande quelconque à l'extérieur de la zone de sélection.

Remarque : Pour la procédure de réglage de ces paramètres à l’aide des commandes du panneau 
frontal du DFR22, voir le Guide d’installation.
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Pour activer Auto Clear :
1. « Limiter » le système comme indiqué à la section Configuration 

de base du réducteur numérique de Larsen à la page 70.
2. Régler tous les filtres actifs sur [FIXED], comme expliqué à la sec-

tion Affectation des filtres à la page 71.
3. Cliquer sur le bouton [AUTO CLEAR].
4. La boîte de dialogue « Auto Clear » s’ouvre, comme illustré à la 

figure 7-15.
5. Cliquer pour cocher la case [Enable Auto Clear].
6. Si l’on désire que chaque changement apporté à un filtre soit 

retiré après une certaine période de temps, cocher la case [on 
timeout] (En fonction d’une durée établie) et indiquer un laps de 
temps allant de 0,1 à 99,9 heures. La valeur par défaut est 12 
heures. Chaque filtre est équipé de sa propre minuterie, pour 
laquelle le temps zéro est fixé au moment où le filtre est réglé ou approfondi.

7. Cliquer sur [OK].
8. Le bouton [AUTO CLEAR] de la fenêtre du réducteur numérique de Larsen s’allume en vert pour indiquer que 

la fonction correspondante est active.

Pour désactiver Auto Clear :
1. Cliquer sur le bouton [AUTO CLEAR].
2. Dans la boîte de dialogue « Auto Clear », enlever la coche de la case [Enable Auto Clear] pour désactiver 

la fonction correspondante. Les commandes Auto Clear apparaissent sur fond gris.
3. Cliquer sur [OK].
4. Sur la fenêtre du réducteur numérique de Larsen, le bouton [AUTO CLEAR] deviendra gris et inactif.

Remarque : Une fois que l’ensemble de ces opérations a été effectué, la fonction Auto Clear est activée 
uniquement pour le processeur de réduction numérique de Larsen actif. Pour que d’autres 
processeurs de réduction numérique de Larsen retirent automatiquement les changements 
apportés aux filtres, il faut activer la fonction Auto Clear dans la fenêtre de paramètres cor-
respondant à chacun de ces processeurs.

FIGURE 7-15 : Boîte de dialogue 
« Auto Clear »
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Atténuateur

L’atténuateur permet d’utiliser facilement le DFR22 dans un système de sonorisation qui demande un téléavertisse-
ment. Lorsqu’un signal de téléavertissement est présent, l’atténuateur affaiblit les autres signaux.

Fonction
Placer l'atténuateur sur une bande de canal d'entrée pour désigner cette entrée comme signal de téléaver-
tissement. Lorsque le signal de téléavertissement dépasse le seuil spécifié, l’atténuateur affaiblit tout autre sig-
nal présent à chaque point de mélange de sortie auquel il est connecté. Il n’atténue pas les signaux présents
aux points de mélange auxquels le signal de téléavertissement n’est pas connecté. Le signal de téléavertisse-
ment peut être acheminé vers les canaux de sortie dans le diagramme de fluence, sur la fenêtre « Matrix Mixer
» ou en cochant les cases [Paging Channels] (Canaux de téléavertissement) apparaissant dans la fenêtre «
Ducker » (Atténuateur).

Nom de bloc Description
DUCK Atténuateur

Remarque : L’atténuateur ne peut être placé que sur une bande de canal d'entrée. Il ne faut 
pas placer plusieurs atténuateurs sur le même canal. Pour empêcher les bruits 
étrangers sur l’entrée de téléavertissement d’être audibles, placer un obturateur 
en amont de l’atténuateur dans le diagramme de fluence.

1

2

3

4

FIGURE 7-16 : Fenêtre DUCK
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Fonctions de la fenêtre de paramètres

1) Diagramme de courbe de transfert
Le diagramme de courbe de transfert affiche le niveau de seuil sous la forme d’un élément graphique pou-
vant être positionné à l’aide de la souris.

2) Curseur de seuil
La position du curseur de seuil correspond au réglage de la commande de seuil. Il est possible de glisser
ce curseur à l’aide de la souris vers la gauche et la droite le long du bord supérieur du diagramme de
courbe de transfert pour changer le réglage du seuil.

3) Vumètre de réduction de gain
Ce vumètre indique l’augmentation ou la réduction totale de gain obtenue sur le ou les signaux atténués
avec les paramètres de processeur en vigueur. Il est possible d’activer et de désactiver cette fonction en
choisissant l’option [Options>Gain Reduction Meter] sur le menu. Elle est active par défaut.

4) Vumètre de courbe de transfert
En mode Live, ce vumètre indique le niveau d'entrée du signal de téléavertissement pour permettre d‘étab-
lir le seuil au-dessus du bruit ambiant. Il est possible d’activer et de désactiver cette fonction en choisissant
l’option [Options>Transfer Curve Meter] sur le menu. Elle est active par défaut.

Indicateur de dépassement du seuil.

Threshold (Seuil)
Cette fonction commande le niveau de gain que le signal de téléavertissement doit atteindre
avant que le processeur n’affaiblisse les signaux atténués. Il est possible de changer la valeur
en cliquant sur les boutons compteur circulaire ou en tapant une valeur précise entre +20 dB

et –60 dB. La valeur par défaut est 0 dB.

Attenuation (Atténuation)
Cette fonction commande l’amplitude de la réduction du gain appliquée aux signaux atténués
lorsque le signal de téléavertissement dépasse le seuil. Il est possible de changer cette valeur
en cliquant sur les boutons compteur circulaire ou en tapant une valeur précise entre –1 dB et

–INF. La valeur par défaut est –40 dB.

Attack (Attaque)
Cette fonction commande le temps qu’il faut au processeur pour réduire complètement le gain
des signaux atténués une fois que le signal de téléavertissement franchit le seuil. Il est possi-
ble de changer le temps d'attaque en cliquant sur les boutons compteur circulaire ou en tapant
une valeur précise. La plage de valeurs disponibles va de 1 à 5000 ms.

Hold (Maintien)
Cette fonction commande le temps pendant lequel le processeur continue à affaiblir les sig-
naux atténués une fois que le signal de téléavertissement est retombé en dessous du seuil. Il

Remarque : Le logiciel du DFR22 risque d’être moins performant si un grand nombre de vumètres y 
sont actifs. Il est possible de désactiver sélectivement le vumètre de courbe de transfert 
ou celui de réduction de gain, voire les deux, à partir du menu [Options].

Le niveau du signal a dépassé le seuil
Cet indicateur s’allume en jaune lorsque le signal à 
l’entrée du bloc processeur excède le seuil spécifié.

Le niveau du signal n’a pas atteint le seuil
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est possible de changer cette valeur en cliquant sur les boutons compteur circulaire ou en tapant une
valeur précise. La plage de valeurs disponibles va de 1 à 10 000 ms.

Release (Libération)
Cette fonction commande le temps qu’il faut au processeur pour ramener les signaux atténués
à leur niveau antérieur une fois que le délai de maintien s’est écoulé. Il est possible de
changer cette valeur en cliquant sur les boutons compteur circulaire ou en tapant une valeur
précise. La plage de valeurs disponibles va de 1 à 10 000 ms.

Default (Réglage par défaut)
Cliquer sur ce bouton pour rétablir les paramètres système par défaut du processeur.

Bypass (Contournement)

Paging Channels (Canaux de téléavertissement)
Cocher la case voisine de chaque sortie vers laquelle on veut acheminer le signal
de téléavertissement. Cela revient au même que si l’on utilise le diagramme de

fluence ou le mélangeur matriciel pour acheminer le signal de cette entrée vers les sorties. Tout autre signal
dirigé vers le(s) point(s) de mélange de sortie choisi(s) sera atténué par le signal de téléavertissement.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le 
modifier. Lorsque le contournement est actif, le bouton est 
allumé en rouge. Le réglage par défaut est inactif.Contournement inactif

Processeur lié

Processeur non lié
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Obturateur/extenseur descendant

L’obturateur et l’extenseur descendant réduisent le niveau de sortie du signal par rapport au niveau d’entrée une fois 
que ce dernier tombe en dessous d’un seuil spécifié.

Fonction
Utiliser ces processeurs pour réduire ou éliminer le bruit de fond indésirable. L’obturateur coupe le signal d’entrée
une fois qu’il tombe en dessous d’un seuil spécifié. L’extenseur descendant réduit progressivement le gain une
fois que le signal d’entrée tombe en dessous d’un seuil spécifié, offrant une réduction plus précise du gain que
l’obturateur. L’obturateur est idéal lorsqu’on a besoin d’éliminer un bruit de faible niveau qui sinon créerait une
distraction pendant le déroulement du programme. Choisir l’extenseur descendant pour réduire légèrement le
bruit de fond dans les cas où une coupure totale du signal perturberait le déroulement du programme.

Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres de l’extenseur descendant et de l’obturateur en
prenant le DOWN EXP à titre d’exemple, comme illustré ci-dessus à la figure 7-17. Le fonctionnement de ces
deux processeurs est très similaire. Toutes les différences entre leurs caractéristiques et leur fonctionnalité
sont indiquées quand il y a lieu.

1) Diagramme de courbe de transfert
Le diagramme de courbe de transfert affiche le niveau de seuil et les paramètres de taux de compression
sous forme d’éléments graphiques pouvant être positionnés à l’aide de la souris. La courbe de transfert
résultante représente le changement du niveau de sortie de signal.

Nom de bloc Description
DOWN EXP Extenseur descendant
GATE Obturateur

1

2 3

4

56
FIGURE 7-17 : Fenêtre DOWN EXP
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2) Curseur de seuil
La position du curseur de seuil correspond au réglage de la commande de seuil. Il est possible de glisser
ce curseur à l’aide de la souris vers la gauche et la droite le long du bord supérieur du diagramme de
courbe de transfert pour changer le réglage du seuil.

3) Vumètre de réduction de gain
Ce vumètre indique l’augmentation ou la réduction totale de gain obtenue sur le signal d’entrée avec les
paramètres de processeur en vigueur. Il est possible d’activer et de désactiver cette fonction en choisis-
sant l’option [Options>Gain Reduction Meter] sur le menu. Elle est active par défaut.

4) Commandes de gain
Utiliser les commandes de gain pour régler les niveaux de gain d’entrée et de sortie. Les niveaux de gain
disponibles vont de -12 dB à +12 dB par paliers de 0,5 dB, la valeur par défaut étant de 0 dB. Il est possible
de changer la valeur en utilisant les conventions décrites dans la section Affaiblisseurs à la page 35.

5) Vumètre de courbe de transfert
En mode Live, ce vumètre indique le niveau d’entrée et le niveau relatif de sortie du signal pour permettre
de surveiller l’effet du processeur sur le niveau sonore du programme en cours. Il est possible d’activer et
de désactiver cette fonction en choisissant l’option [Options>Transfer Curve Meter] sur le menu. Elle est
active par défaut.

6) Curseur de rapport
La position du curseur de rapport correspond au réglage de la commande de rapport. Il est possible de
glisser ce curseur à l’aide de la souris vers la gauche ou la droite le long du bord inférieur du diagramme de
courbe de transfert pour changer le réglage du rapport.

Indicateur de dépassement du seuil

Threshold (Seuil)
Il indique le niveau en dessous duquel le gain de signal d’entrée doit tomber avant que le pro-
cesseur ne le réduise. Il est possible de changer la valeur en cliquant sur les boutons compteur
circulaire, en tapant une valeur précise ou en utilisant le curseur de seuil qui se trouve au bord

supérieur du diagramme de courbe de transfert. Les valeurs disponibles vont de -80,0 dB à 0 dB par paliers de
0,5 dB, la valeur par défaut étant -65,0 dB pour l’obturateur et -40,0 dB pour l’extenseur descendant.

Ratio (Rapport)
Il indique l’amplitude de la réduction de gain à la sortie du processeur par rapport au niveau
d’entrée. Un rapport de 4:1, par exemple, signifie qu'une réduction de 1 dB du niveau sonore
du programme entraîne une réduction de 4 dB du niveau de sortie du processeur. Il est pos-

sible de changer la valeur en cliquant sur les boutons compteur circulaire, en tapant une valeur précise ou
en utilisant le curseur de rapport qui se trouve sur le bord inférieur du diagramme de courbe de transfert.
Les valeurs disponibles vont de 1:1 à INF:1 par paliers d’un dixième, la valeur par défaut étant INF:1 pour
l’obturateur et 4:1 pour l’extenseur descendant.

Remarque : Le logiciel du DFR22 risque d’être moins performant si un grand nombre de vumètres y 
sont actifs. Il est possible de désactiver sélectivement le vumètre de courbe de transfert 
ou celui de réduction de gain, voire les deux, à partir du menu [Options].

Le niveau du signal a dépassé le seuil
Cet indicateur s’allume en jaune lorsque le signal à 
l’entrée du bloc processeur excède le seuil spécifié

Le niveau du signal n’a pas atteint le seuil
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Attack (Attaque)
Cette valeur indique le temps qui s'écoule avant que le processeur ne revienne au gain unité
une fois que le gain du signal d’entrée dépasse le seuil. Les valeurs disponibles vont de 1 à 200
ms, la valeur par défaut étant 2 ms pour l’obturateur et 20 ms pour l’extenseur descendant.

Decay (Déclin)
Cela indique le temps qu’il faut au processeur pour atteindre la réduction de gain spécifiée. Il
est possible de changer la valeur en cliquant sur les boutons compteur circulaire ou en
tapant une valeur précise. Les valeurs disponibles vont de 50 ms à 1000 s, la valeur par

défaut étant 100 ms pour l’obturateur et 50 ms pour l’extenseur descendant.

Hold (Maintien)
Cette valeur indique le temps qui s'écoule avant que le processeur ne commence à réduire
le gain une fois que le gain du signal d’entrée tombe en dessous du seuil. Il est possible de
changer la valeur en cliquant sur les boutons compteur circulaire ou en tapant une valeur

précise. Les valeurs disponibles vont de 0 à 500 ms, la valeur par défaut étant 0 ms.

Default (Réglage par défaut)
Cliquer sur ce bouton pour rétablir les paramètres système par défaut du processeur.

Bypass (Contournement)

Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le 
modifier. Lorsque le contournement est actif, le bouton est 
allumé en rouge. Le réglage par défaut est inactif.Contournement inactif

Processeur lié

Processeur non lié
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Égaliseur graphique

Les égaliseurs graphiques répartissent sur tout le spectre de fréquences un ensemble fixe de filtres à large bande et 
forme constante dont chacun est pourvu de commandes individuelles d’amplification/coupure. Le processeur audio 
offre les types suivants d’égaliseurs graphiques :

Fonction
Utiliser ce processeur comme moyen commode de réaliser une égalisation à large bande en salle. La bande
passante globale du processeur et la bande passante des filtres individuels dépendent du type d’égaliseur
graphique choisi. Le GEQ10 comporte 10 filtres d’un octave entre 31,5 Hz et 16 kHz, alors que le GEQ30 en
comporte 30 de 1/3 d’octave entre 25 Hz et 20 kHz. Le GEQ10 est illustré à la figure 7-18 ci-dessus.

Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres de l’égaliseur graphique en prenant le GEQ10 à titre
d’exemple. Le GEQ30 est identique à l’exception du nombre de bandes et de la gamme de fréquences globale. 

1) Affaiblisseurs de bandes de fréquence
Il est possible de régler les affaiblisseurs de bandes de fréquence en glissant le bouton vers le haut ou le
bas à l'aide du souris ou en cliquant sur la graduation au niveau auquel on désire les régler. Toute bande
peut être coupée ou amplifiée entre -18 dB et +12 dB par paliers de 0,5 dB. Pour de plus amples informa-
tions sur le réglage des affaiblisseurs, voir la section Affaiblisseurs à la page 35.

Nom de bloc Description
GEQ10 Égaliseur graphique à 10 bandes
GEQ30 Égaliseur graphique à 30 bandes

1

2

FIGURE 7-18 : Fenêtre GEQ10
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Égaliseur graphique
2) Diagramme de réponse
Cette courbe est une représentation graphique des résultats des réglages de bandes de fréquence et du
type de facteur Q de filtre choisi.

Freq (Fréquence)
Cette valeur indique la bande de fréquences en cours de réglage. Il est possible d’en
choisir une différente en cliquant sur les boutons compteur circulaire. Le choix par
défaut est la bande de fréquence la plus basse.

Gain
Cette valeur indique le réglage de gain actif de la bande de fréquence choisie. Les
niveaux de gain disponibles vont de -18 dB à +12 dB par paliers de 0,5 dB, la valeur
par défaut étant de 0 dB. Il est possible de changer la valeur en utilisant les conven-
tions décrites dans la section Affaiblisseurs à la page 35. 

Type (Type de facteur Q de filtre)
Cette zone indique le type de facteur Q de filtre défini pour toutes les bandes de
fréquences. Utiliser la liste déroulante pour changer cette valeur. La valeur par

défaut est COMBINING (Combinaison).

Bypass (Contournement)

Flat (Uniforme)
Cliquer sur ce bouton pour régler le gain de toutes les bandes de fréquences sur zéro.

Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

ASCII File (Importation de fichiers ASCII)
Cette fonction permet l’importation de données de fréquences dans le diagramme de
réponse à partir de SIA Smaart et de Gold Line TEF. Une fois dans le diagramme, les don-
nées graphiques peuvent être utilisées à titre de référence lors de la modification de la
courbe de réponse du processeur. Se reporter à la page 38 pour obtenir des instructions

sur la façon d’utiliser la fonction d’importation de fichiers ASCII.

Remarque : La courbe ne reflète pas l’effet cumulé de plusieurs blocs processeur dans le chemin du sig-
nal. Pour visualiser une courbe combinée, choisir [View>Combined Response Curve] sur le 
menu principal. Pour de plus amples renseignements, voir la section Diagramme de 
réponse combinée à la page 40.

COMBINING 
(COMBINAISON)

Établit la pente moyenne entre les bandes de fréquences pour 
créer une courbe d’égalisation globale régulière.

NON-COMBINING 
(SANS COMBINAISON)

Isole le résultat de l’action de chaque commande de bande de 
fréquence permettant un réglage de gain plus indépendant.

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le modi-
fier. Lorsque le contournement est actif, le bouton est allumé en 
rouge. Le réglage par défaut est inactif.Contournement inactif
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Égaliseur graphique
Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Copie et collage
Il est possible d’utiliser le menu [Edit] pour copier et coller des paramètres de bandes de fréquence d’un
égalisateur graphique dans un autre du même type.

Processeur lié

Processeur non lié

Remarque : On ne peut pas coller des paramètres entre les processeurs GEQ10 et GEQ30
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Égaliseur paramétrique
Égaliseur paramétrique

Les égaliseurs paramétriques permettent de spécifier le placement, le type et la bande passante de plusieurs filtres en 
n’importe quel point du spectre de fréquences entre 25 Hz et 20 kHz. Le processeur audio offre les types suivants 
d’égaliseurs paramétriques :

Fonction
Utiliser ce processeur pour obtenir une égalisation précise de la réponse dans la salle sans affecter inutilement
les fréquences voisines. Choisir un égaliseur paramétrique en fonction du nombre de bandes de fréquence
qu’il est nécessaire de régler et suivant qu’on désire ou non inclure des filtres passe-haut et passe-bas ou de
dégradé dans le processeur. On peut économiser des ressources de traitement numérique des signaux en
choisissant aussi peu de filtres qu’il n’en faut pour répondre aux besoins.

Nom de bloc Description
PEQ3

Ces processeurs n’offrent que des filtres écrêteurs/coupe-bande
PEQ5
PEQ7

PEQ10

PEQ3+CS
Ces processeurs offrent des filtres écrêteurs/coupe-bande, plus un filtre passe-
haut ou de dégradé et un filtre passe-bas ou de dégradé

PEQ5+CS
PEQ7+CS

PEQ10+CS

Remarque : Le nombre figurant dans le nom de bloc reflète le nombre maximum de filtres écrêteurs/
coupe-bande disponibles pour ce processeur.

1

2

3 4

6

FIGURE 7-19 : Fenêtre PEQ10 + CS

5
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Égaliseur paramétrique
Fonctions de la fenêtre de paramètres
Cette section décrit les fonctions et la gestion des paramètres des processeurs égaliseurs paramétriques en
prenant le PEQ10+CS à titre d’exemple, comme illustré à la figure 7-19 à la page précédente. Les caractéris-
tiques des autres égaliseurs paramétriques ne varient qu’en termes de nombre de bandes et de disponibilité
de filtres passe-haut et passe-bas et de dégradé.

1) Diagramme de réponse
Cette courbe est une représentation graphique des résultats combinés de l’action des points filtre et des
manipulateurs dans le traceur de réponse.

2) Traceur de réponse
Cette zone de la fenêtre de paramètres est celle où sont placés et réglés les filtres paramétriques. Elle
affiche graphiquement les filtres écrêteurs/coupe-bande sous forme de points et les filtres passe-haut et
passe-bas et de dégradé sous forme de manipulateurs carrés. Lors de l’ouverture initiale de la fenêtre de
processeur, le traceur de réponse ne contient aucun point filtre et, le cas échéant, les filtres passe-haut et
passe-bas et de dégradé apparaissent dans leurs positions par défaut. Cliquer sur un point filtre ou un
manipulateur pour visualiser sa courbe de réponse et régler ses paramètres. Voir la section Utilisation des
filtres à la page 87 pour des instructions sur la façon d'ajouter des points filtre

3) Points filtre
Les filtres écrêteurs/coupe-bande apparaissent dans le traceur de réponse sous forme de points filtre à
côté desquels se trouvent des commandes réglables de bande passante. Cliquer une fois sur un point filtre
pour le choisir, puis régler ses paramètres à l’aide de la souris, des commandes au clavier ou des boîtes
de valeur.

4) Filtre sélectionné
Lorsqu’un filtre est sélectionné, il est mis en surbrillance en vert. Sa courbe active est également affichée
en vert par rapport à zéro avec le diagramme de réponse.

5) Manipulateur de largeur de filtre
Cliquer sur ces manipulateurs et les glisser vers la gauche et la droite pour rétrécir ou élargir le filtre choisi.
Leur position correspond à la valeur s’affichant sur la commande [WIDTH] (Largeur).

6) Filtres passe-haut et passe-bas et de dégradé
Les filtres passe-haut et passe-bas et de dégradé apparaissent sous forme de manipulateurs carrés.
Chaque manipulateur peut être utilisé comme filtre passe-haut, passe-bas ou de dégradé suivant sa posi-
tion verticale dans le traceur de réponse. Lors de l’ouverture initiale de la fenêtre de paramètres, les
manipulateurs fonctionnent comme filtres de dégradé haute et basse fréquences avec un réglage par
défaut de 0 dB, à 20 kHz et 25 Hz respectivement. Ils deviennent filtres passe-haut et passe-bas lorsqu’on
les glisse jusqu’au bord inférieur du traceur de réponse.

Freq (Fréquence)
Cette valeur indique la fréquence du point filtre choisi. Il est possible de changer la
valeur en cliquant sur les boutons compteur circulaire, en utilisant des commandes au

clavier ou en tapant une valeur précise. La gamme de fréquences va de 25 Hz à 20 kHz, la valeur par
défaut étant 1 kHz quand on ajoute un nouveau point filtre.

Remarque : La courbe ne reflète pas l’effet cumulé de plusieurs blocs processeur dans le chemin du 
signal. Pour visualiser une courbe combinée, choisir [View>Combined Response Curve] 
sur le menu principal. Pour de plus amples renseignements, voir la section Diagramme de 
réponse combinée à la page 40.
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Égaliseur paramétrique
Width /Slope/Type (Largeur/pente/type)
Cette commande change suivant le type de filtre choisi, comme indiqué ci-dessous. Pour un filtre passe-
haut ou passe-bas, on peut choisir entre deux pentes sur le menu déroulant. Lorsqu’un filtre écrêteur/
coupe-bande est sélectionné, il est possible d’utiliser le menu déroulant de valeurs prédéfinies ou de spéci-
fier la largeur à un millième d’octave près en tapant une valeur. Cette commande n’offre aucun paramètre
pour des filtres de dégradé.

Gain
Cette valeur indique le réglage de gain actif du filtre choisi. Les niveaux de gain disponi-
bles vont de -18 dB à +18 dB par paliers de 0,5 dB, la valeur par défaut étant de 0 dB.

Lorsqu’on travaille avec un filtre passe-haut ou passe-bas, cette commande est désactivée et le mot « CUT
» (passe-haut/passe-bas) est affiché.

New (Nouveau)
Cliquer sur ce bouton pour ajouter un nouveau filtre écrêteur/coupe-bande au traceur de
réponse. Lors de l'ouverture initiale de la fenêtre, le nombre qui se trouve en dessous du bouton
indique la quantité de points filtre disponibles pour l'égaliseur paramétrique choisi. Ce nombre
diminue d'une unité à chaque fois que l'on ajoute un point filtre au traceur de réponse. Le bouton
est désactivé lorsque le nombre maximum de filtres pour le processeur a été atteint.

Clear (Réinitialisation)
Cliquer sur ce bouton pour réinitialiser les paramètres de filtres. Il ouvre la boîte de dialogue «
Clear » qui permet de choisir entre la réinitialisation de tous les paramètres de filtres ou celle des

seuls points filtre sélectionnés sur le traceur de réponse. Voir la section Utilisation des filtres à la page 87
pour de plus amples renseignements.

Bypass (Contournement)

Snapshot (Instantané)
Cette fonction permet de figer une image de la courbe de réponse active en cliquant sur le bou-
ton [TAKE], puis de l’afficher en arrière-plan pour comparaison en cliquant sur le bouton [SHOW].
Le bouton [SHOW] est allumé en vert lorsque l’instantané est affiché. Pour une description plus
détaillée de la fonction instantané, voir la section Instantanés à la page 37.

ASCII File (Importation de fichiers ASCII)
Cette fonction permet l’importation de données de fréquences dans le diagramme de réponse
à partir de SIA Smaart et de Gold Line TEF. Une fois dans le diagramme, les données
graphiques peuvent être utilisées à titre de référence lors de la modification de la courbe de
réponse du processeur. Se reporter à la page 38 pour obtenir des instructions sur la façon
d’utiliser la fonction d’importation de fichiers ASCII.

Type de filtre Aspect Gamme de valeurs

Écrêteur/
coupe-bande

De 1/70 d’octave à 4 octaves ; valeur par défaut : 2/3 d’octave
De 100,99 Q à 0,27 Q ; valeur par défaut : 2,14 Q

Passe-haut et 
passe-bas –6 dB/oct et –12 dB/oct ; valeur par défaut : –6 dB/oct

Dégradé Néant

Contournement actif Cliquer sur ce bouton pour faire passer un signal sans le modi-
fier. Lorsque le contournement est actif, le bouton est allumé en 
rouge. Le réglage par défaut est inactif.Contournement inactif
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Égaliseur paramétrique
Indicateur de liaison
Il affiche l’état de liaison du processeur. Tout paramètre changé sur un processeur lié le sera également
sur tous les autres processeurs liés du même groupe. Pour une explication complète sur l'établissement
de liaisons et sur les groupes de blocs liés, voir la section Liaison à la page 25.

Utilisation des filtres
Il n’y a aucun filtre écrêteur/coupe-bande dans le traceur de réponse lors de l’ouverture initiale de la fenêtre de
paramètres d’un égaliseur paramétrique. Ajouter des points filtre lorsque le besoin s’en fait sentir jusqu’au
nombre maximum disponible pour le bloc processeur choisi.

Pour ajouter un nouveau point filtre :
1. Cliquer sur le bouton [NEW].
2. Un point filtre apparaît à 0 dB avec une fréquence par défaut de 1 kHz et une bande passante de 

2/3 d’octave.

Pour supprimer tous les points filtre :
1. Cliquer sur le bouton [CLEAR] ou choisir [Edit>Clear Filters] (Édi-

tion>Réinitialiser les filtres) sur la barre de menu de la fenêtre de 
paramètres.

2. La boîte de dialogue « Clear » apparaît, comme illustré sur la droite 
à la figure 7-20.

3. Choisir [Clear All Filters] et cliquer sur [OK]. Cela supprime tous les 
points filtre du traceur de réponse et restaure les paramètres par 
défaut des filtres passe-haut et passe-bas et de dégradé.

Pour supprimer des points filtre particuliers :
1. Cliquer sur un point filtre pour le choisir ou appuyer sur Ctrl et 

cliquer pour choisir plusieurs filtres.
2. Appuyer sur la touche Suppr - OU - Cliquer sur le bouton [CLEAR] pour ouvrir la boîte de dialogue « Clear 

», puis choisir l'option [Clear Selected Filter(s)].

Réglage des filtres dans le traceur de réponse
Il est possible de changer les paramètres des filtres en glissant les points filtre et les manipulateurs à l’aide
de la souris.

Pour régler le gain et la fréquence :
1. Positionner le curseur sur le centre du point filtre ou du manipulateur.

2. Le curseur prend la forme du symbole de déplacement :

3. Cliquer sur le filtre et le glisser vers la gauche ou la droite pour régler la fréquence et vers le haut ou le 
bas pour régler le gain.

Processeur lié

Processeur non lié

Remarque : Il est impossible de supprimer les manipulateurs des filtres passe-haut et passe-bas et 
de dégradé ; on peut toutefois restaurer leurs paramètres par défaut à l’aide du bouton 
[CLEAR] ou de la touche Suppr.

Remarque : Le traceur de réponse n’affiche une courbe que pour le filtre choisi. La courbe 
combinée est affichée dans le diagramme de réponse.

FIGURE 7-20 : Boîte de dialogue « Clear »
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Égaliseur paramétrique
Pour régler la bande passante d’un point filtre :
1. Positionner le curseur sur l’un ou l’autre des points de commande de bande passante du filtre.
2. Le curseur prend la forme du symbole de redimensionnement horizontal : 
3. Cliquer sur le point de commande et le glisser vers la gauche ou la droite pour régler la bande passante.

Affinage des paramètres
Il est possible d’ajuster avec précision les paramètres du point filtre choisi en appliquant l’une quelconque
des méthodes suivantes :

• Saisie d’un chiffre dans l’une quelconque des boîtes de paramètres
• Utilisation des boutons compteur circulaire (ou de la boîte déroulante) voisins des boîtes de 

paramètres
• Utilisation de commandes au clavier

Commandes au clavier
Il est possible d’utiliser les commandes au clavier suivantes pour affiner le réglage du filtre choisi.

Copie, coupe et collage
Il est possible de copier, couper et coller des points filtre d’une fenêtre d’égaliseur paramétrique à une
autre dans les conditions suivantes :
• Il y a suffisamment de points filtre disponibles dans la fenêtre de paramètres dans laquelle on colle.
• Les paramètres des filtres passe-haut et passe-bas et de dégradé ne peuvent être copiés et collés que 

d’un processeur PEQ+CS à un autre.

Pour copier et coller des filtres :
1. Cliquer pour choisir un seul filtre ou en choisir plusieurs en appliquant l’une des méthodes suivantes :

• Ctrl + Cliquer.
• Utiliser la commande [Edit>Select All] du menu.

2. Choisir la commande [Edit>Copy] du menu.
3. Ouvrir la fenêtre de paramètres de l’égaliseur paramétrique dans laquelle on désire coller des 

paramètres de filtre.
4. Choisir la commande [Edit>Paste] du menu.

Touche Résultat

� Réduit la fréquence d’un point à l’écran

� Augmente la fréquence d’un point à l’écran

� Augmente le gain de 0,5 dB

� Réduit le gain de 0,5 dB

Maj + � Réduit la fréquence de 1/3 d’octave

Maj + � Augmente la fréquence de 1/3 d’octave

Ctrl + � Réduit la bande passante d’un point filtre par faibles paliers

Ctrl + � Augmente la bande passante d’un point filtre par faibles paliers

Maj + �
ou Page précédente Augmente le gain de 3 dB

Maj + �
ou Page suivante Réduit le gain de 3 dB

Barre d’espacement ou bou-
ton droit de la souris Établit le gain à 0 dB

Remarque : Pousser la fréquence d’un point à l’écran change la valeur d’environ 1/100 d’octave, ou 1 %

Remarque : La commande Cut (Couper) ne peut pas être utilisée pour les manipulateurs de filtres passe-
haut et passe-bas et de dégradé.

Remarque : Lorsque plusieurs filtres sont sélectionnés en même temps, ils sont mis en surbrillance rose et leurs 
paramètres sont verrouillés. Pour désélectionner l’un de ces filtres, cliquer sur une commande 
quelconque dans la fenêtre de paramètres ou sur un filtre à l’extérieur de la zone de sélection.
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SECTION 8 Broches de commande
Le connecteur à broches situé sur le panneau arrière du processeur audio DFR22 permet à l’installateur de raccorder
du matériel externe spécial tel que des interrupteurs et des potentiomètres pour régler le volume, couper des canaux
et choisir des préréglages. Il peut également être utilisé comme interface avec les cartes de commande logique Cre-
stron ou AMX. Ce type de commande simple offre aux utilisateurs finaux un moyen de gérer des fonctions particulières
sans l’aide d’un ordinateur.

Généralités sur les broches de commande

La commande de dispositif externe est établie à trois niveaux différents : les connexions externes, la configuration 
des broches et le mappage de processeur. Sur l’illustration ci-dessous, l’appareil est configuré pour la commande 
externe suivante :

• Passage d’un préréglage à un autre dans une configuration « une pour un ».
• Réglage du gain de sortie global du système à l’aide d’un potentiomètre.
• Coupure d’un canal d’entrée à l’aide d’un interrupteur de verrouillage.

Niveau un : Connexions externes

Lors de l'installation initiale de l’appareil, déterminer le type de commande externe que demande le système
de sonorisation et câbler le matériel approprié en conséquence. Voir le Guide d’installation pour obtenir les
instructions et schémas de câblage correspondants.

Niveau deux : Configuration des broches

Dans le logiciel du DFR22, utiliser la section « Pin Configuration » (Configuration des broches) de la fenêtre «
Control Pins » (Broches de commande) pour choisir quel matériel sera raccordé à l’appareil. Cette configura-
tion est stockée comme paramètre global dans l’appareil et peut également être enregistrée comme fichier
informatique. Voir la section « Pin Configuration » à la page 93 pour obtenir les instructions correspondantes.

Niveau trois : Mappage de processeur

Une fois l’appareil configuré pour identifier le matériel de commande externe, affecter des canaux d'entrée et
de sortie aux connexions de commande. Utiliser la section « Processor Mapping » (Mappage de processeur)
de la fenêtre « Control Pins » dans le logiciel du DFR22. Chaque préréglage stocke une mappe de processeur
qui lui est propre. Voir la section « Processor Mapping » à la page 97 pour de plus amples renseignements.

FIGURE 8-1 : Les trois niveaux de commande de dispositif externe
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Tutoriel sur les broches de commande
Tutoriel sur les broches de commande

Ce tutoriel explique étape par étape la façon de configurer le DFR22 pour pouvoir utiliser la commande externe. On 
peut également y accéder en cliquant sur le bouton [Tutorial] (Tutoriel) situé dans le coin supérieur droit de la fenêtre « 
Control Pins », ce qui permet de suivre les instructions au fur et à mesure de l’exécution de ces étapes. Pour une expli-
cation plus détaillée des caractéristiques et fonctions de la fenêtre « Control Pins », voir la section La fenêtre « Control 
Pins » à la page 93.

A. Passer en mode Design et ouvrir la fenêtre « Control Pins ».
Cliquer sur le bouton [Design Mode] de la barre de contrôle de la fenêtre principale et choisir [Devices>Control
Pin Configuration] sur le menu principal.

B. Les broches de commande sont-elles configurées en vue du choix des préréglages?
• Si NON, passer directement à l’étape D.
• Si OUI, entrer le nombre de préréglages qui vont être choisis dans le champ [# Presets].

C. Quel type de commande sera utilisé pour assurer le passage d’un préréglage à un autre?
Spécifier le choix correspondant dans le menu déroulant du champ [Encoding Type].

• Priority (Prioritaire) : un préréglage par broche de commande (utiliser des interrupteurs instantanés ou 
de verrouillage). Cette option permet de passer d’un préréglage à un autre avec un maximum de quatre 
préréglages au total.

• Binary (Binaire) : déclenche des préréglages particuliers avec une combinaison de broches ouvertes et 
fermées (utiliser des interrupteurs de verrouillage).

• DRS-10/Custom (DRS-10/spécial) : commutateur rotatif à 10 positions modifiant les préréglages en fonc-
tion de la valeur de résistance. Le DRS-10 est un accessoire de Shure proposé en option ; il est également 
possible de créer un circuit spécial sur mesure. Pour un tableau des valeurs de résistance et des 
préréglages correspondants, se reporter à la page 95. Cette option permet de passer d’un préréglage à un 
autre avec un maximum de dix préréglages au total et elle utilise une broche de commande.

Les blocs de connexion figurant dans la fenêtre « Control Pins » affectent le nombre de broches requises pour
passer d’un préréglage à un autre en fonction des paramètres qui ont été spécifiés dans les champs [# Pre-
sets] et [Encoding Type]. Ces broches apparaissent sous la forme du bloc de commande de préréglage situé
sur le côté gauche de la fenêtre.

Remarque : Lors de la configuration des broches de commande 
pour permettre le passage d’un préréglage à un autre, 
le sélecteur de préréglage situé sur le panneau frontal 
du DFR22 est désactivé.

Nombre 
maximum de 
préréglages

Nom-
bre de 
broches

2 1
4 2
8 3

16 4
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Tutoriel sur les broches de commande
REMARQUE IMPORTANTE SUR LE PASSAGE D’UN PRÉRÉGLAGE À UN AUTRE :
Une fois que la commande de préréglage est activée pour les broches de
commande, il est impossible de changer les préréglages à partir de l’ordi-
nateur ou du sélecteur de préréglage situé sur le panneau frontal du
DFR22. Toutefois, l’indicateur du panneau frontal continue à afficher le
préréglage actif.

En cas de besoin, il est possible de passer d’un préréglage à un autre à
partir de l’ordinateur ou du panneau frontal du DFR22 une fois que les bro-
ches de commande ont été activées, en désactivant le bloc de commande
de préréglage situé sur la fenêtre « Control Pins ».

Pour désactiver le bloc de commande de préréglage :
1. Cliquer sur la flèche se trouvant sur le côté droit du bloc de commande de préréglage et choisir [Dis-

able] dans le menu déroulant.
2. Une coche apparaît à côté de cette option lorsque le bloc est désactivé. En mode Live, la modification 

est effectuée dès que l’option [Disable] a été sélectionnée. En mode Design, il faut procéder à nou-
veau au stockage de la configuration des broches en choisissant [Configuration>Store to Device] sur 
le menu de la fenêtre « Control Pins ».

3. Lorsque la sélection des préréglages à partir de l’ordinateur est terminée, choisir de nouveau [Disable] 
afin que la commande de sélection de préréglage par les broches de commande soit restaurée.

D. Les broches de commande seront-elles utilisées pour commander le gain?
• Si NON, passer directement à l’étape E.
• Si OUI, choisir un potentiomètre pour l’un des blocs de connexion ou 

choisir un interrupteur instantané pour chacun des deux blocs de con-
nexion qui vont être utilisés, l’un pour augmenter et l’autre pour réduire le 
gain par paliers.

À la droite de chaque bloc de connexion se trouve un menu déroulant. Cliquer
à l’aide de la souris et maintenir le bouton enfoncé pour choisir l’option appro-
priée dans la liste de connexions du matériel proposées. Choisir [Moment]
pour un interrupteur instantané ou [Pot] pour un potentiomètre.

E. Les broches de commande seront-elles utilisées pour commander la coupure de canal?
• Si NON, passer directement à l’étape F.
• Si OUI, choisir soit [Moment], soit [Switch] (Interrupteur) sur le menu déroulant du bloc de connexion en 

fonction des paramètres suivants :
> Si l’on veut appuyer pour couper un canal, puis appuyer de nouveau pour le rétablir à l’aide d’un inter-

rupteur instantané, choisir [Moment].
> Si l’on veut appuyer sur le bouton et le maintenir enfoncé pour couper un canal, puis relâcher le bouton 

pour rétablir le canal à l’aide d’un interrupteur instantané, choisir [Switch].
> Si l’on veut que la position un corresponde à la coupure d’un canal et la position deux à son rétablisse-

ment en utilisant un interrupteur de verrouillage, choisir [Switch].

F. Stocker la configuration des broches dans l’appareil.
1. Choisir [Configuration>Store to Device] sur le menu de la fenêtre « Control Pins ».
2. Si la boîte de dialogue « Select Device » (Choix de l’appareil) apparaît, cliquer pour choisir le DFR22, 

puis cliquer sur [OK].

Remarque : Il est également possible d’enregistrer une configuration de broches sur l’ordinateur si l’on 
n’est pas connecté à l’appareil, puis de la stocker dans l’appareil ultérieurement. Voir la sec-
tion « Pin Configuration » à la page 93 pour obtenir les instructions correspondantes.

FIGURE 8-2 : Désactivation du bloc 
de commande de préréglage

FIGURE 8-3 : Menu déroulant du 
bloc de connexion
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Tutoriel sur les broches de commande
G. Tous les préréglages sont-ils stockés dans l’appareil?
• Si OUI, passer directement à l’étape H.
• Si NON, créer et stocker les préréglages dans l’appareil. Voir la section Création d’un préréglage à la 

page 18 et la section Préréglages de l’appareil à la page 31 pour de plus amples renseignements.

H. Si ce n’est déjà fait, connecter physiquement le matériel de commande aux broches de com-
mande du DFR22 en respectant la configuration des broches qui a été spécifiée dans la 
fenêtre « Control Pins ».
• Si les broches de commande sont utilisées uniquement pour le passage d’un préréglage à un autre, la 

procédure est terminée.
• Si les broches de commande sont utilisées pour le réglage du gain ou la coupure de canal, passer à l’étape I.

I. Passer en mode Live et ouvrir la fenêtre « Control Pins ».
Cliquer sur le bouton [Live Mode] de la barre de contrôle de la fenêtre principale et choisir [Devices>Control 
Pin Configuration] sur le menu principal.

J. Un ou plusieurs potentiomètres sont-ils utilisés?
• Si NON, passer directement à l’étape L.
• Si OUI, étalonner chaque potentiomètre. Cliquer sur le bouton [Calibrate] (Étalon-

nage) situé sous le bloc de commande du potentiomètre afin de démarrer le guide 
intelligent d’étalonnage. Chaque potentiomètre doit être étalonné séparément.

 K. Régler la gamme de gain pour chaque potentiomètre.
1. Cliquer sur le bouton [Gain Range] (Gamme de gain).
2. La boîte de dialogue « Range Edit » (Éditer la gamme) s’ouvre.
3. Spécifier les valeurs minimum et maximum.
4. Cliquer sur [OK].

L. Affecter par mappage les canaux d’entrée et de sortie aux connexions de commande.
Les canaux d’entrée et de sortie sont répertoriés sous chaque bloc de connexion des broches de commande.
Cliquer pour cocher la case correspondant à chaque canal que l’on veut commander.

M. Un ou plusieurs interrupteurs instantanés sont-ils utilisés pour commander le gain?
• Si NON, passer directement à l’étape N.
• Si OUI, régler la valeur du palier d’augmentation ou de réduction du gain, ainsi que les valeurs minimum et 

maximum de celui-ci.
1. Cliquer sur le bouton [Gain Up Limit] (Limite maximum du gain) ou sur le bouton [Gain Down Limit] 

(Limite minimum du gain).
2. La boîte de dialogue « Set Gain Maximum » (Régler la valeur maximum du gain) ou « Set Gain Mini-

mum » (Régler la valeur minimum du gain) s’ouvre.
3. Spécifier la valeur du palier d’augmentation ou de réduction du gain, ainsi que les limites minimum et 

maximum de celui-ci.
4. Cliquer sur [OK].

Voir la section Interrupteurs instantanés à la page 98 pour de plus amples renseignements.

N. Répéter les étapes K à M pour chaque préréglage stocké dans le DFR22.

Remarque : Si le potentiomètre ne fait pas l’objet d’un étalonnage, l’étalonnage par 
défaut correspond à un potentiomètre de réduction audio de 100 kohms.

FIGURE 8-4 : Bouton 
Calibrate
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La fenêtre « Control Pins »
La fenêtre « Control Pins »
La fenêtre « Control Pins » est une interface permettant à la fois de configurer les broches de commande globalement 
au niveau de l’appareil et d’affecter des processeurs de gain d’entrée et de sortie aux contrôleurs pour chaque 
préréglage individuellement. Il est possible d'y accéder en choisissant la commande sur menu [Devices>Control Pins 
Configuration] de la fenêtre principale.

1. Commandes de passage d’un préréglage à un autre : Utiliser ces commandes pour spécifier le nombre 
de préréglages et le type de matériel de commande qui permettra le passage d’un préréglage à un autre. 
Taper d’abord le nombre de préréglages, puis choisir le type de codage.

2. Bloc de commande de préréglage : Il affiche de manière graphique les broches de commande affectées 
au passage d’un préréglage à un autre. Ses caractéristiques et son aspect dépendent des paramètres 
spécifiés pour les commandes de passage d’un préréglage à un autre. 

3. Bloc de connexion : Chaque bloc affiche le type de matériel de commande spécifié pour la broche 
correspondante.

4. Menu déroulant du bloc de connexion : Utiliser ce menu pour spécifier le type de commande associé au 
bloc de connexion.

5. Configuration des broches : Les réglages apparaissant sur cette section de la fenêtre s’appliquent au 
DFR22 dans son ensemble. Voir la section Pin Configuration ci-dessous pour de plus amples renseigne-
ments. 

6. Mappage de processeur : Les réglages apparaissant sur cette section de la fenêtre s’appliquent de 
manière indépendante pour chaque préréglage. Voir la section « Processor Mapping » à la page 97 pour 
de plus amples renseignements.

« Pin Configuration »

Utiliser cette section de la fenêtre « Control Pins » pour configurer le DFR22 afin qu’il identifie correctement toute con-
nexion de broche de commande câblée au matériel externe. Lors de l’ouverture initiale de la fenêtre, toutes les connex-
ions sont désactivées et les fonctions des broches ne sont pas différenciées. Une fois défini le nombre éventuel de 
broches qui seront utilisées pour la commande de préréglage, le dispositif d'affichage attribue ces broches à la com-
mande de préréglage et toute broche restante peut être affectée à la commande du gain et de la coupure des canaux 
d’entrée et de sortie

1

2

3 4

5

6

FIGURE 8-5 : Fenêtre « Control Pins »
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« Pin Configuration »
.

Ces paramètres sont stockés au niveau de l’appareil. Ils ne sont pas stockés avec les préréglages ou fichiers de scène 
et ne changent pas lorsque l’on passe d’un préréglage à un autre dans l’appareil. Il est possible de stocker cette config-
uration sur l’ordinateur si l'on n'est pas connecté au DFR22 ou de la conserver comme copie de sauvegarde.

Paramètres de codage des préréglages
Lorsque les broches de commande vont être utilisées pour passer d’un préréglage à un autre, il faut tout d’abord
spécifier des valeurs dans ces commandes avant de régler tout autre paramètre dans la fenêtre « Control Pins ».

# Presets
Utiliser cette commande pour spécifier le nombre de préréglages que les broches de com-
mande vont permettre de choisir. Les valeurs disponibles vont de 1 à 16, la valeur par défaut
étant 1. Taper une valeur dans cette boîte avant de passer à la boîte [Encoding Type].

Encoding Type
Utiliser cette commande pour préciser la façon dont les préréglages seront choisis à
partir des broches de commande. Les réglages proposés dépendent du nombre de
préréglages spécifié dans le champ [# Presets], comme indiqué ci-dessous. La valeur
par défaut est « None » (Néant).

Codage prioritaire ou « une pour un »

Ce réglage affecte chaque connexion de broche à un numéro de préréglage
unique. Il permet de passer d’un préréglage à un autre avec un maximum de qua-
tre préréglages au total. Utiliser des interrupteurs instantanés ou de verrouillage
pour ce type de codage.

Le bloc de commande de préréglage affiche une boîte de texte pour chaque
broche de commande. Les valeurs initiales sont classées par défaut du
préréglage nº 1 au préréglage nº 4. Il est possible de changer les numéros de
préréglages en cliquant sur chaque boîte de texte et en y tapant un numéro entre
1 et 16. Si un utilisateur appuie par inadvertance sur une combinaison d’interrupt-
eurs lorsqu’il effectue une sélection, l’appareil passera au préréglage figurant à la
position [Highest Priority] (Plus haute priorité).

Codage binaire

Ce réglage choisit des préréglages en utilisant des combinaisons binaires au
niveau des entrées de commande, combinaisons affichées en dessous du bloc de
commande de préréglage. Il permet de passer d’un préréglage à un autre avec un
maximum de 16 préréglages au total. Utiliser des interrupteurs de verrouillage pour
ce type de codage. Le code binaire correspond à l’état logique au niveau des
entrées des broches de commande.

• 0 logique = broche sous tension
• 1 logique = broche à la masse

Remarque : Il faut être en mode Design pour créer ou modifier la configuration des broches.

Remarque : Une fois que la fonction de passage d’un préréglage à un autre a été établie à l’aide des 
broches de commande, le sélecteur de préréglage situé sur le panneau frontal est désac-
tivé et l’ordinateur ne peut pas être utilisé pour modifier les préréglages. En mode Live, il 
est possible de désactiver les broches de commande en cliquant sur le bloc de commande 
de préréglage ou en choisissant [Disable] sur le menu déroulant situé à la droite du bloc de 
commande de préréglage. Le bloc apparaît sur fond gris lorsqu’il est désactivé. Pour 
rétablir la commande externe de préréglage, choisir à nouveau [Disable] en mode Live ou 
cliquer sur le bloc de commande de préréglage.

FIGURE 8-6 : Bloc de 
commande de préréglage 

pour codage prioritaire

FIGURE 8-7 : Bloc 
de commande de 
préréglage pour 
codage binaire
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« Pin Configuration »
À chaque réglage binaire associé aux broches de commande cor-
respond une boîte de texte. Les valeurs par défaut commencent au
préréglage nº 1 pour le réglage binaire 0 et augmentent d’une unité
jusqu’au préréglage nº 16 pour le réglage binaire 1111. Le
préréglage associé à chaque combinaison logique peut être
changé en cliquant sur la boîte de texte correspondante et en y
tapant un numéro de préréglage différent, entre 1 et 16. Voir
l’Annexe A : Tableaux de codage binaire pour les valeurs par
défaut des préréglages.

Codage avec interrupteur DRS10 ou interrupteur spécial

Ce réglage choisit des préréglages en utilisant une valeur de résistance cor-
respondante au niveau de l’entrée des broches de commande. Il est possi-
ble de sélectionner un maximum de dix préréglages avec ce type de
codage. Le DRS10 est un accessoire de Shure proposé en option ; il est
également possible de créer un circuit spécial sur mesure.

Blocs de connexion
Le nombre de blocs de connexion qui apparaissent dans la
fenêtre dépend du nombre de broches disponibles une fois
qu’une commande de préréglage a été spécifiée. Affecter un
matériel de commande à une broche en choisissant parmi les
options proposées dans le menu déroulant situé sur le côté droit
du bloc. Il est possible d’activer et de désactiver alternativement
un ou plusieurs matériels de commande en cliquant sur le bloc
avec le bouton gauche de la souris ou en choisissant [Disable]
sur le menu déroulant.

Interrupteur de verrouillage [Switch]
Utiliser le choix correspondant à l’interrupteur de verrouillage pour couper les canaux d’entrée et
de sortie. Ce réglage est en général prévu pour un contrôleur externe à deux positions. Il peut
également être utilisé avec un interrupteur instantané, auquel cas le canal est coupé lorsqu’on
appuie sur l’interrupteur et est rétabli lorsqu’on relâche ce dernier.

Interrupteur instantané [Moment]
Utiliser le réglage correspondant à l’interrupteur instantané pour couper les canaux d’entrée et
de sortie. Ce réglage est prévu pour un interrupteur instantané externe qui, chaque fois que l’on
appuie dessus, permettra d’établir la coupure ou de l’annuler. Il peut également être utilisé pour

augmenter ou réduire le gain par paliers. Dans ce cas, il faut établir le gain minimum et maximum, ainsi
que la valeur des paliers pour chaque préréglage. Voir la section Interrupteurs instantanés à la page 98
pour de plus amples renseignements.

Nº DE 
PRÉRÉGLAGE

VALEUR DE 
RÉSISTANCE

Nº DE 
PRÉRÉGLAGE

VALEUR DE 
RÉSISTANCE

1 97 k� – ��� 6 7,8 – 9,3 k�
2 44 – 60 k� 7 5,2 – 6,3 k�
3 26 – 32 k� 8 3,3 – 4,1 k�
4 17 – 20 k� 9 1,9 – 2,5 k�
5 11,3 – 13,6 k� 10 0,63 – 1,1 k�

Remarque : En mode Design, il faut d’abord stocker la configuration des broches dans l’appareil avant 
d’activer ou de désactiver les connexions du matériel.

Codage binaire des préréglages
Nombre maximum 
de préréglages

Nombre de 
broches

2 1
4 2
8 3

16 4

FIGURE 8-8 : Bloc de commande 
de préréglage pour codage avec 

interrupteur DRS10/spécial

Connexion
activée

Connexion 
désactivée

FIGURE 8-9 : Blocs de connexion
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« Pin Configuration »
Potentiomètre [Pot]
Utiliser le réglage correspondant au potentiomètre pour ajuster le gain d’entrée ou de sortie.
Cliquer sur le bouton [Calibrate] pour étalonner l’entrée de commande en fonction de la gamme
de réglage du potentiomètre associé. Si le potentiomètre ne fait pas l’objet d’un étalonnage,
l’étalonnage par défaut correspond à un potentiomètre de réduction audio de 100 kohms avec

une tolérance de +/–20 %.

Création d’une nouvelle configuration des broches de commande pour l’appareil
1. Passer en mode Design.
2. Choisir [Devices>Control Pin Configuration] sur le menu principal.
3. La fenêtre « Control Pins » s’ouvre.
4. Configurer la commande de préréglage.

a) Taper le nombre de préréglages dans la boîte de valeur [# Presets].
b) Choisir un type de codage sur le menu déroulant [Encoding Type].
c) Le bloc de broches de commande de préréglage apparaît.
d) En cas d'utilisation d'un codage prioritaire ou binaire, taper les numéros appropriés des 

préréglages sous le bloc de commande de préréglage.
5. Configurer toute broche restante pour les contrôleurs externes en choisissant une option sur le menu 

déroulant qui se trouve sur le côté droit de chaque bloc de connexion.
6. Choisir l’option de menu [Configuration>Store to Device].
7. Si la boîte de dialogue « Select Devices » apparaît, choisir l’appareil voulu, puis cliquer sur [OK].
8. La configuration des broches est stockée dans l’appareil

Enregistrement d’une configuration des broches de commande dans l'ordinateur
1. Effectuer les opérations 1 à 5 précédentes.
2. Choisir l’option de menu [Configuration>Save to PC].
3. La boîte de dialogue « Save Config As » (Enregistrer la configuration sous) s’ouvre.
4. Passer au répertoire approprié, taper un nom de fichier et cliquer sur [OK].
5. La configuration est enregistrée dans l’ordinateur sous la forme d’un fichier à extension « .d22pin ».

Édition d’une configuration des broches de commande dans l’appareil
1. Passer en mode Design.
2. Choisir [Devices>Control Pin Configuration] sur le menu principal.
3. La fenêtre « Control Pins » s’ouvre.
4. Choisir l’option de menu [Configuration>Recall From Device].
5. Si la boîte de dialogue « Select Devices » apparaît, choisir l’appareil voulu, puis cliquer sur [OK].
6. La configuration des broches en vigueur apparaît dans la fenêtre « Control Pins ».
7. Apporter les changements nécessaires.
8. Choisir l’option de menu [Configuration>Store To Device].
9. Si la boîte de dialogue « Select Devices » apparaît, choisir un appareil, puis cliquer sur [OK].
10. La configuration des broches est stockée dans l’appareil.
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« Processor Mapping »

Utiliser cette section de la fenêtre « Control Pins » pour spécifier les canaux d’entrée et de sortie qui seront com-
mandés par le matériel externe. Les canaux d’entrée et de sortie sont répertoriés dans une colonne en dessous de 
chaque bloc de connexion auquel un contrôleur a été affecté. Afin que le matériel externe puisse commander le gain et 
la coupure de canal, chaque préréglage dans l’appareil doit être affecté par mappage aux connexions de commande.

Il est possible de créer le mappage de processeur en mode Live ou Design. La barre de titre de cette section de la 
fenêtre est bleue en mode Live et noire en mode Design. En mode Live, toute modification apportée au mappage de 
processeur est directement enregistrée et appliquée au préréglage actif.

Affectation par mappage du matériel de commande aux canaux d’entrée et de sortie
Il est possible d’affecter par mappage toute combinaison de canaux d’entrée et de sortie à un contrôleur. Pour
les interrupteurs instantanés, il existe trois fonctions de mappage possibles pour chaque canal : augmentation
du gain, réduction du gain et coupure. Chaque canal d’entrée ou de sortie ne peut être affecté par mappage
que pour l’une de ces trois fonctions à un moment donné. Par exemple, il est impossible de régler le même
canal à la fois pour une augmentation de gain et une coupure.

Pour affecter par mappage un canal d’entrée ou de sortie à un contrôleur :

• Cliquer sur une case pour affecter par mappage à une commande le canal d’entrée ou de sortie corre-
spondant.

• Pour enlever la coche de la case, cliquer dessus à nouveau.

Réglages des commandes de gain
En plus de l’affectation par mappage des canaux d’entrée et de sortie à la commande de gain, il faut égale-
ment spécifier la gamme au sein de laquelle l’utilisateur final est autorisé à régler le gain. Ces réglages faisant
partie du mappage de processeur, ils sont enregistrés individuellement avec chaque préréglage.

Potentiomètres
Sous chaque bloc de commande correspondant à un potentiomètre se
trouve un bouton [Set Gain Range] (Régler la gamme de gain). Si une
gamme de gain n’est pas spécifiée pour chaque commande, elle s’établit
par défaut entre �� dB et +10 dB.

Pour régler la gamme de gain d’un potentiomètre :
1. Cliquer sur le bouton [Set Gain Range].
2. La boîte de dialogue « Range Edit » s’ouvre.
3. Taper les valeurs minimum et maximum autorisées pour le réglage du 

gain. Le niveau minimum est �� dB et le maximum est +10 dB.
4. Cliquer sur [OK].

Remarque : Avant de créer une mappe de processeur, il faut d’abord générer une configuration des 
broches de commande et la stocker dans l’appareil.

Case de processeur sélectionnée pour 
mappage.

Case désélectionnée.

FIGURE 8-10 : Mappage de 
processeur pour un potentiomètre
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« Processor Mapping »
Interrupteurs instantanés
Sous chaque bloc de commande correspondant à un interrupteur
instantané se trouvent un bouton [Set Gain Max] et un bouton [Set
Gain Min]. En plus du réglage du gain maximum ou minimum d’un
interrupteur instantané désigné comme commande de gain, ces
boutons permettent de régler la valeur en dB du palier d’augmenta-
tion ou de réduction du gain par la commande. Lorsque l’on appuie
sur une commande de gain, elle augmente ou réduit immédiate-
ment le gain de la valeur spécifiée. Lorsque l’on appuie sur une
commande de gain et qu’on la maintient enfoncée, elle augmente
ou réduit immédiatement le gain de la valeur spécifiée. Ensuite,
après un délai de 1000 ms, elle continue à augmenter ou réduire le
gain d’un palier toutes les 120 ms tant qu’on la maintient enfoncée.

Si la valeur maximum du gain et la valeur du palier d’augmentation
ne sont pas spécifiées, les valeurs par défaut utilisées seront un
maximum de +10 dB et un palier de 2 dB. Si la valeur minimum du
gain et la valeur du palier de réduction ne sont pas spécifiées, les
valeurs par défaut utilisées seront un minimum de �� dB et un
palier de 2 dB.

Pour régler les limites maximum et minimum du gain pour un interrupteur instantané :
1. Cliquer pour choisir un canal d’entrée ou de sortie dont on veut commander l’augmentation de gain.
2. Cliquer sur le bouton [Gain Up Limit].
3. La boîte de dialogue « Set Gain Maximum » s’ouvre.
4. Taper la limite maximum du gain (maximum +10 dB).
5. Taper la valeur du palier dont augmentera le gain chaque fois que l’on appuie sur l’interrupteur (maxi-

mum 10 dB).
6. Cliquer sur [OK].
7. Cliquer pour choisir un canal d’entrée ou de sortie dont on veut commander la réduction de gain.
8. Cliquer sur le bouton [Gain Down Limit].
9. La boîte de dialogue « Set Gain Minimum » s’ouvre.
10. Taper la limite minimum du gain (minimum -� dB).
11. Taper la valeur du palier dont diminuera le gain chaque fois que l’on appuie sur l’interrupteur (maxi-

mum 10 dB).
12. Cliquer sur [OK].

Création d’une mappe de processeur
En affectant du matériel externe aux entrées et aux sorties qu’il veut commander, l’utilisateur crée une mappe
de processeur. Pour ce faire, l’une des méthodes suivantes peut être appliquée :

• En mode Live, créer une mappe de processeur pour chaque préréglage dans l’appareil, un par un.
• En mode Design, ouvrir un fichier de préréglage à partir de l’ordinateur ou le rappeler à partir de 

l’appareil, et stocker une mappe de processeur en association avec lui.

Pour créer une mappe de processeur en mode Live :
1. Passer en mode Live et choisir le préréglage que l’on veut modifier.
2. Choisir [Devices>Control Pin Configuration] sur le menu principal.
3. La fenêtre « Control Pins » s’ouvre et les canaux d’entrée et de sortie y sont répertoriés sous les blocs de 

connexion.
4. Pour chaque bloc de connexion, cliquer sur les cases de mappage de processeur qui se trouvent à côté 

des canaux qui seront commandés par la connexion du matériel externe.
5. Régler la gamme de gain pour tout potentiomètre et les limites maximum et minimum du gain ainsi que les 

valeurs des paliers pour les interrupteurs instantanés utilisés pour la commande de gain.

FIGURE 8-11 : Mappage de processeur 
pour des interrupteurs instantanés
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« Processor Mapping »
6. Le mappage est automatiquement enregistré dans l’appareil avec le préréglage chaque fois qu’un change-
ment est apporté en mode Live. 

7. Pour établir une autre mappe de processeur, passer à un autre préréglage (il n’est pas nécessaire de 
fermer la fenêtre « Control Pins »).

Pour créer une mappe de processeur en mode Design :
1. Passer en mode Design.
2. Cliquer sur le bouton [Open] de la barre de contrôle de la fenêtre principale.
3. La boîte de dialogue « Open Preset » (Ouvrir un préréglage) apparaît.
4. Choisir le fichier de préréglage approprié et cliquer sur [OK].
5. Le préréglage choisi apparaît sur le diagramme de fluence.
6. Choisir [Devices>Control Pin Configuration] sur la fenêtre principale.
7. La fenêtre « Control Pins » s’ouvre.
8. Charger une configuration des broches en appliquant l’une des méthodes suivantes :

• Choisir l’option de menu [Configuration>Open from PC] (Configuration>Ouvrir à partir de l’ordinateur) 
et ouvrir un fichier à extension « .d22pin » stocké dans l’ordinateur.

• Si l’on est connecté au DFR22, choisir l’option de menu [Configuration>Recall from Device].
• Si aucune configuration des broches n’a été créée, voir la section « Pin Configuration » à la page 93.

9. Pour chaque bloc de connexion affecté, cliquer sur les cases de mappage de processeur qui se trouvent à 
côté des canaux qui seront commandés par la connexion du matériel externe.

10. Revenir à la fenêtre principale (il n’est pas nécessaire de fermer la fenêtre « Control Pins »).
11. Enregistrer le fichier de préréglage dans l’ordinateur (voir la section Révision des fichiers de préréglages à 

la page 30 pour obtenir les instructions correspondantes).

Remarque : Il est obligatoire d’établir une mappe de processeur pour chaque préréglage figurant dans 
l’appareil, si l’on veut qu’il puisse fonctionner avec les contrôleurs externes.
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SECTION 9 Sécurité
La sécurité est une fonction disponible en option qui permet à l’installateur ou à tout autre responsable de la sécurité
de limiter l’accès de l’utilisateur final aux paramètres du DFR22 via le panneau frontal ou l’ordinateur.

Verrouillage du panneau frontal

L’accès aux commandes du panneau frontal peut être verrouillé afin que 
l’utilisateur final ne puisse pas apporter de changement, quel qu’il soit, aux 
paramètres du processeur de réduction numérique de Larsen ou aux 
préréglages. Pour verrouiller toutes les commandes du panneau frontal, 
régler en position basse le cinquième micro-interrupteur situé sur le panneau 
arrière du DFR22. Le logiciel peut être utilisé pour contourner le micro-inter-
rupteur et verrouiller de manière sélective certaines commandes tout en lais-
sant libre accès aux autres.

Pour verrouiller l’accès au panneau frontal de manière sélective :
1. Choisir [Security>Front Panel Lockout] sur le menu principal.
2. La boîte de dialogue « Front Panel Lockout » s’ouvre, comme 

illustré à la figure 9-1.
3. Cliquer sur la case [Override and Disable Dip Switch] (Con-

tourner et désactiver le micro-interrupteur).
4. Cliquer sur chaque case correspondant aux commandes du panneau frontal dont on veut limiter 

l’accès utilisateur.

Les paramètres de verrouillage peuvent également être protégés à l’aide d’un mot de passe afin que le responsable de 
la sécurité soit le seul à pouvoir apporter des changements au verrouillage du panneau frontal via l’ordinateur. Pour de 
plus amples renseignements, lire la section suivante concernant l’accès via l’ordinateur.

Limitation de l’accès via l’ordinateur

Le responsable est la personne qui établit le mot de passe de l’appareil et le niveau d’accès auquel il fonctionnera une 
fois installé. Il y a trois niveaux d’accès différents pour l’appareil :

Niveau un
Lorsque l’appareil est réglé au niveau un, l’utilisateur jouit d’un accès illimité aux fonctions du processeur
audio, à l’exception des deux qui sont toujours protégées par le mot de passe du responsable :

1. Établissement du niveau de sécurité de l’appareil.
2. Changement du mot de passe du responsable.

Niveau deux
Lorsque l’appareil est réglé au niveau deux, l’utilisateur jouit d’un accès limité défini par le responsable de
la sécurité. L’accès suivant au DFR22 peut être autorisé pour le niveau deux :

• Changements apportés aux préréglages via l'ordinateur.
• Changements apportés à l’acheminement des signaux dans le mélangeur matriciel.
• Changements apportés aux paramètres de verrouillage du panneau frontal.
• Accès permettant de modifier les paramètres de processeur pour tout bloc qui n’est pas verrouillé par 

le responsable (voir la section Sécurité de processeur individuel à la page 103 pour de plus amples 
informations).

Remarque : Il faut être connecté à l’appareil pour pouvoir configurer tout paramètre de sécurité, sauf s’il 
s’agit de la sécurité d'un processeur individuel.

FIGURE 9-1 : Boîte de dialogue 
« Front Panel Lockout »
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Limitation de l’accès via l’ordinateur
Niveau trois
Ce niveau permet un accès en consultation seule aux paramètres du DFR22 pour le préréglage actif.

Établissement de la sécurité de l’appareil
L’établissement de la sécurité doit constituer la phase finale de la configuration de l’appareil. Il s’effectue en
deux étapes principales :

1. Créer un mot de passe
2. Établir le niveau d’accès utilisateur

Créer un mot de passe
Avant de pouvoir établir le niveau d’accès utilisateur dans l’appareil,
il est nécessaire de créer le mot de passe qui protège l’accès du
responsable de la sécurité.

Pour créer un mot de passe :
1. Choisir [Security>Set Password] sur le menu principal.
2. La boîte de dialogue « Create Password » s’affiche, comme 

illustré à la figure 9-2.
3. Taper un mot de passe dans le champ [Administrator Pass-

word] (Mot de passe du responsable).
4. Appuyer sur Tab pour passer au champ [Confirm Password] 

(Confirmer le mot de passe) et retaper le mot de passe.
5. Remplir les champs [Administrator Name] (Nom du respons-

able) et [Phone or Contact info] (Coordonnées du responsable).

Établir le niveau d’accès utilisateur
Une fois qu’un mot de passe est créé, l’appareil est automatique-
ment réglé au niveau un d’accès utilisateur. Si l’accès à l’appareil
doit être plus limité, régler ce dernier au niveau d’accès approprié.

Pour établir le niveau d’accès utilisateur :
1. Choisir [Security>Level] (Sécurité>Niveau) sur le menu principal.
2. La boîte de dialogue « Input Password » (Saisir le mot de 

passe) apparaît, comme illustré sur la droite à la figure 9-3.
3. Taper le mot de passe et cliquer sur [OK].
4. La boîte de dialogue « Set Security Level » (Établir le niveau de 

sécurité) s’affiche, comme illustré à la figure 9-4.
5. Cliquer sur la case d'option qui se trouve à gauche du niveau 

approprié.
6. Spécifier les options propres au niveau deux, le cas échéant.
7. Cliquer sur [OK].

Remarque : La sécurité n’affecte que l’accès par l’intermédiaire de l’interface logicielle et du 
panneau frontal. Elle ne limite pas la commande de dispositif externe via les bro-
ches de commande.

Remarque : La longueur de toutes les saisies dans la boîte de dialogue « Create Password » 
est limitée à quinze caractères.

FIGURE 9-2 : Boîte de dialogue 
« Create Password »

FIGURE 9-3 : Boîte de dialogue 
« Input Password »

FIGURE 9-4 : Boîte de dialogue 
« Set Security Level »
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Limitation de l’accès via l’ordinateur
Changement de la sécurité de l’appareil
Au cas où il sera nécessaire d’apporter des changements à la configuration de l’appareil ou aux paramètres de
sécurité à la suite d’une restriction de l’accès, il faut d’abord changer la sécurité de l’appareil pour la faire reve-
nir au niveau un d’accès utilisateur avant de pouvoir continuer.

Changement du niveau d’accès
Procéder comme indiqué plus haut pour établir le niveau d’accès.

Changement du mot de passe
Pour changer un mot de passe existant :
1. Choisir [Security>Set Password] sur le menu principal.
2. La boîte de dialogue « Set Password » (Établir un mot de passe) 

apparaît, comme illustré à la figure 9-5. Le curseur se trouve 
dans le champ [Old Password] (Ancien mot de passe).

3. Taper le mot de passe en vigueur.
4. Appuyer sur Tab pour passer au champ [Administrator Pass-

word] et taper le nouveau mot de passe.
5. Appuyer sur Tab pour passer au champ [Confirm Password] et 

retaper le nouveau mot de passe.
6. Changer le contenu des champs [Administrator Name] et [Phone 

or Contact info] si nécessaire.
7. Cliquer sur [OK].

Élimination de la sécurité
Il est possible de réinitialiser complètement la sécurité de l’appareil à l’état par défaut pour permettre à
d’autres personnes d’établir un mot de passe de responsable et de définir les niveaux d’accès utilisateur.

Pour éliminer la protection par mot de passe :
1. Choisir [Security>Set Password] sur le menu principal.
2. La boîte de dialogue « Set Password » s’affiche, comme illustré à la figure 9-5 ci-dessus.
3. Taper le mot de passe en vigueur dans le champ [Old Password].
4. Supprimer, si on le désire, le nom et les coordonnées du responsable.
5. Laisser les champs [Administrator Password] et [Confirm Password] en blanc.
6. Cliquer sur [OK].
7. Toutes les restrictions d’accès sont éliminées.

Remarque : Le mot de passe du responsable de la sécurité est obligatoire pour pouvoir exécuter 
ces fonctions.

Remarque : La longueur de toutes les saisies dans la boîte de dialogue « Set Password » est 
limitée à quinze caractères.

Remarque : Tout attribut de sécurité de bloc processeur individuel demeure mais est inopérant 
tant que l'appareil n’est pas réglé au niveau deux d’accès utilisateur.

FIGURE 9-5 : Boîte de dialogue 
« Set Password »
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Limitation de l’accès via l’ordinateur
Sécurité de processeur individuel
La sécurité de processeur individuel bloque l’accès à des blocs processeur particuliers d’un préréglage. Il est
possible de bloquer l’accès à un seul bloc, à plusieurs ou à tous les blocs d’un préréglage. On peut utiliser
cette fonction, par exemple, si l’on désire que l’utilisateur final puisse changer les paramètres de gain mais pas
ceux d’un égaliseur paramétrique. Il reste possible d’ouvrir un processeur verrouillé pour surveiller les
vumètres ou visualiser des paramètres.

Alors que le niveau d’accès utilisateur est propre à l'appareil, la sécurité de bloc processeur est propre au
préréglage. En outre, la sécurité d’un processeur individuel est un attribut distinct de chaque bloc. Il est par
exemple possible d’établir l’attribut de verrouillage sur un bloc et, lorsqu’on copie ce bloc, son attribut de sécu-
rité est copié avec. Cet attribut demeure, que l’on soit en mode Design ou en mode Live.

Pour verrouiller des blocs processeur :
1. Faire passer l’appareil en mode Live.
2. Vérifier que l’appareil est réglé au niveau 1 de sécurité.
3. Cliquer pour mettre un bloc processeur en surbrillance ou appuyer sur Ctrl et cliquer pour en choisir plu-

sieurs.
4. Choisir [Security>Level 2>Lock Selected] sur le menu principal.
5. Une coche apparaît en regard de cette option du menu pour indiquer que le processeur choisi est ver-

rouillé.
6. Régler l’appareil au niveau deux d’accès utilisateur, comme indiqué dans la section Établir le niveau 

d’accès utilisateur à la page 101.

Remarque : La sécurité de processeur individuel ne s’applique qu’à l’accès via l’ordinateur. Elle 
n’affecte pas l’accès aux paramètres du processeur via le panneau frontal ou les broches 
de commande.
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SECTION 10 Impression de rapports
Le logiciel du DFR22 produit des rapports imprimés pour documenter tous les préréglages et paramètres stockés dans
l’appareil. Ces rapports sont conçus aux fins suivantes.

1. Pour documenter la configuration de l’appareil à l’intention du client et de l’utilisateur final.
2. Pour fournir une copie de sauvegarde sur papier de façon à permettre si nécessaire de reconstituer la 

configuration de l’appareil.

Pour imprimer des rapports relatifs au DFR22 :
1. Choisir [File>Print] (Fichier>Imprimer) sur le menu principal.
2. La boîte de dialogue « Choose Report » (Choisir un rapport) 

s'ouvre, comme illustré sur la droite à la figure 10-1.
3. Cliquer pour choisir le rapport que l’on désire imprimer.
4. Une boîte de dialogue s’ouvre pour le rapport spécifié.
5. Spécifier les informations à inclure dans le rapport, comme 

indiqué dans la section suivante.
6. Cliquer sur [OK].
7. La boîte de dialogue « Imprimer » de Windows apparaît.

Device Information (Informations sur l’appareil)

Le rapport Device Information donne toutes les informations au niveau de l’appareil, sauf le mot de passe de sécurité. 
Lorsque la boîte de dialogue « Device Information » s’ouvre, choisir l’appareil pour lequel on désire imprimer un rap-
port sur la liste déroulante [Device]. Taper les informations relatives à l’appareil choisi et cliquer sur [OK]. Ces informa-
tions n’apparaissent que sur le rapport qui va être imprimé et ne sont pas stockées pour un usage futur. Se reporter à 
la page 105 pour un exemple de ce rapport.

Remarque : Les rapports sont sortis directement sur l’imprimante au lieu de l’être dans un fichier ; il 
est donc nécessaire d’être connecté à une imprimante pour pouvoir utiliser cette fonction.

FIGURE 10-1 : Boîte de dialogue 
« Choose Report »

FIGURE 10-2 : Boîte de dialogue « Device »
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Preset Information (Informations sur les préréglages) et Current Preset Information (Informa-
Preset Information (Informations sur les préréglages) et Current Preset 
Information (Informations sur le préréglage actif)

Le rapport Preset Information donne les détails sur un préréglage particulier stocké dans l’appareil. Lorsque la boîte de 
dialogue « Individual Presets from Device » (Préréglages individuels de l’appareil) s’ouvre, choisir l’appareil pour lequel 
on désire imprimer un rapport sur la liste déroulante [Device]. Choisir ensuite le préréglage pour lequel on désire 
imprimer un rapport et cliquer sur [OK]. Se reporter aux pages 106 et 107 pour un exemple de rapport.

Le rapport Current Preset Information est identique. Il donne les détails sur le préréglage affiché(e).

Processor Information (Informations sur le processeur)

Le rapport Processor Information indique les paramètres d’un ou de plu-
sieurs blocs processeur. La boîte de dialogue « Individual Processor 
Blocks » (Blocs processeur individuels) affiche une liste de tous les pro-
cesseurs fixes et à glisser-déplacer pour le préréglage affiché. Cliquer 
pour choisir un processeur ou appuyer sur Maj et cliquer pour en choisir 
plusieurs, puis cliquer sur [OK]. Se reporter à la page 108 pour un exem-
ple de ce rapport.

FIGURE 10-3 : Boîte de dialogue 
« Individual Presets from Device »

FIGURE 10-4 : Boîte de dialogue « Currently 
Displayed Preset » [Préréglage affiché(e)]

FIGURE 10-5 : Boîte de dialogue 
« Individual Processor Blocks »
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Exemples de rapports
Exemples de rapports

DEVICE INFORMATION

Location: 4325 W. Division, Chicago

Client: Sacred Heart School

Designer: Bob Reiling

Installer: RC Communications

System Description:

Main Gymnasium Audio Processor

Installation Information:

ShureLink Device ID: 15

Device Name: Gymnasium

Hardware Information:

Control Input Configuration:
Pin-1: Encoding Type: Priority, Mapped to preset: 1
Pin-2: Encoding Type: Priority, Mapped to preset: 2
Pin-3: Switch
Pin-4: Potentiometer

Preset Information:
Total Presets: 4

Preset 1 Concert
Preset 2 Assembly
Preset 3 Game
Preset 4 Dance

1 of 1 February 1, 2003, 11:11AM
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Exemples de rapports
PRESET INFORMATION:

Preset ID: 2

Preset Name: Assembly

Description: Preliminary tuning.

Control Input Pin Mapping:
Pin-1: Reserved for Preset Control - See Device Information
Pin-2: Reserved for Preset Control - See Device Information
Pin-3: Mutes: Input 1 2
Pin-4: Gains: Input 1 2, Gain Range: -inf to 0 dB

1 of 2 February 1, 2003, 11:12AM
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Exemples de rapports
Drag and Drop Processors:

Input-1, Slot-1, Processor: DFR16
Input-1, Slot-2, Processor: PEQ 10CS
Input-1, Slot-3, Processor: GEQ30
Input-1, Slot-4, Processor: LIM
Input-1, Slot-5, Processor: N/A

Input-2, Slot-1, Processor: DFR16
Input-2, Slot-2, Processor: PEQ 10CS
Input-2, Slot-3, Processor: GEQ30
Input-2, Slot-4, Processor: LIM
Input-2, Slot-5, Processor: N/A

Output-1, Slot-1, Processor: DLY 2s
Output-1, Slot-2, Processor: N/A
Output-1, Slot-3, Processor: N/A
Output-1, Slot-4, Processor: N/A
Output-1, Slot-5, Processor: N/A
Output-1, Slot-6, Processor: N/A

Output-2, Slot-1, Processor: DLY 2s
Output-2, Slot-2, Processor: N/A
Output-2, Slot-3, Processor: N/A
Output-2, Slot-4, Processor: N/A
Output-2, Slot-5, Processor: N/A
Output-2, Slot-6, Processor: N/A

2 of 2 February 1, 2003, 11:13AM
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Exemples de rapports
PROCESSOR INFORMATION:

Input Gain Block
Security: Unlocked
Input-1: Name: Music, Operating Level: +4 dBu, Polarity: +, Gain: –4.5dB, Mute: Off, Link Group N/A
Input-2: Name: Speech, Operating Level: +4 dBu, Polarity: +, Gain: 0.0dB, Mute: Off, Link Group N/A

1 of 2 February 1, 2003, 11:12AM

Input-1, Slot-1, Processor: DFR16
Name: DFR 16, Link Group: N/A, Security: Unlocked
Bypass: Off
Autoclear: Disabled
Front Panel Assignment: ROW A
Fixed Filters: 3, New Filters: High
Filter: 1, Freq: 65Hz, Depth: –3.0dB, Type: HighQ
Filter: 2, Freq: 171Hz, Depth: –3.0dB, Type: HighQ
Filter: 3, Freq: 2.5kHz, Depth: –3.0dB, Type: HighQ

Input-1, Slot-2, Processor: PEQ10CS
Name: PEQ with CS, Link Group: N/A, Security: Unlocked
Bypass: Off
Filter: L, Type: Shelf, Freq: 0.1kHz, Gain: -18.5dB
Filter: H, Type: Shelf, Freq: 10kHz, Gain: -18.5dB
Filter: 3, Freq: 4.3kHz, Gain: –9.0dB, Width(oct): 2/3, Width(Q): 2.14
Filter: 4, Freq: 0.7kHz, Gain: –4.5dB, Width(oct): 1.249, Width(Q): 1.12
Filter: 5, Freq: 0.2kHz, Gain: –9.0dB, Width(oct): .350, Width(Q): 4.11
Filter: 6, Freq: 0.1kHz, Gain: –6.0dB, Width(oct): 1, Width(Q): 1.41
Filter: 7, Freq: 6.8kHz, Gain: –6.0dB, Width(oct): 1/6, Width(Q): 8.65

Input-1, Slot-3, Processor: GEQ30
Name: Graphic EQ, Link Group: N/A, Security: Unlocked
Bypass: Off, Filters Type: Combining
Filter: 31.5 Hz, Gain: 1.5dB Filter: 800 Hz, Gain: –1.5dB Filter: 8kHz, Gain: 3.0 dB
Filter: 250 Hz, Gain: 0.5dB Filter: 3.15kHz, Gain: –0.5dB Filter: 16 kHz, Gain: 0.5dB

Input-1, Slot-4, Processor: LIM
Name: Limiter, Link Group: N/A, Security: Unlocked
Bypass: Off
Threshold: 9.5 dB, Attack: 2ms, Ratio: 100.0, Decay: 50ms
Input Gain: 0.00, Output Gain: 0.00
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SECTION 11 Annexe A : Tableaux de codage binaire
Les tableaux qui suivent indiquent le codage binaire pour les préréglages du DFR22. Appliquer ce codage aux broches
d’entrée de commande pour faire passer l’appareil au préréglage correspondant.

Remarque : 0 = broche sous tension, 1 = broche à la masse

TABLE 1. Codage binaire pour une seule broche

Nº DE 
PRÉRÉGLAGE

BROCHE 
1

1 0
2 1

TABLE 2. Codage binaire pour deux broches

Nº DE 
PRÉRÉGLAGE

BROCHE 
1

BROCHE 
2

1 0 0
2 0 1
3 1 0
4 1 1

TABLE 3. Codage binaire pour trois broches

Nº DE 
PRÉRÉGLAGE

BROCHE 
1

BROCHE 
2

BROCHE 
3

1 0 0 0
2 0 0 1
3 0 1 0
4 0 1 1
5 1 0 0
6 1 0 1
7 1 1 0
8 1 1 1
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TABLE 4. Codage binaire pour quatre broches

Nº DE 
PRÉRÉGLAGE

BROCHE 
1

BROCHE 
2

BROCHE 
3

BROCHE 
4

1 0 0 0 0
2 0 0 0 1
3 0 0 1 0
4 0 0 1 1
5 0 1 0 0
6 0 1 0 1
7 0 1 1 0
8 0 1 1 1
9 1 0 0 0

10 1 0 0 1
11 1 0 1 0
12 1 0 1 1
13 1 1 0 0
14 1 1 0 1
15 1 1 1 0
16 1 1 1 1
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SECTION 12 Annexe B : Usage de capacité de traitement 
numérique des signaux par processeur
Le tableau qui suit indique le pourcentage de ressources de traitement numérique des signaux utilisé par chaque pro-
cesseur. Le total des ressources de traitement numérique des signaux utilisées est déterminé en combinant l’ensem-
ble des processeurs employés.

Catégorie Nom de bloc Description % 
Égaliseurs 
graphiques

GEQ10 Égaliseur graphique à 10 bandes 4,5

GEQ30 Égaliseur graphique à 30 bandes 9,8

Égaliseurs 
paramétriques

PEQ 3 Égaliseur paramétrique à 3 bandes 2,6

PEQ 5 Égaliseur paramétrique à 5 bandes 3,2

PEQ 7 Égaliseur paramétrique à 7 bandes 3,7

PEQ 10 Égaliseur paramétrique à 10 bandes 4,5

PEQ 3 + CS Égaliseur paramétrique à 3 bandes, avec filtres 
passe-haut et passe-bas et de dégradé 3,2

PEQ 5 + CS Égaliseur paramétrique à 5 bandes, avec filtres 
passe-haut et passe-bas et de dégradé 3,7

PEQ 7 + CS Égaliseur paramétrique à 7 bandes, avec filtres 
passe-haut et passe-bas et de dégradé 4,2

PEQ 10 + CS Égaliseur paramétrique à 10 bandes, avec filtres 
passe-haut et passe-bas et de dégradé 5,0

CUT/SHELF Filtres passe-haut et passe-bas/filtres de dégradé 
haute et basse fréquences 3,4

Réducteurs de 
Larsen

DFR 5 Réducteur numérique de Larsen à 5 bandes 14,3

DFR 10 Réducteur numérique de Larsen à 10 bandes 15,9

DFR 16 Réducteur numérique de Larsen à 16 bandes 17,8

ST DFR 5 Réducteur numérique de Larsen stéréo à 5 bandes 28,6

ST DFR 10 Réducteur numérique de Larsen stéréo à 10 bandes 31,7

ST DFR 16 Réducteur numérique de Larsen stéréo à 16 bandes 35,5

Processeurs de 
délai

DLY 5ms Délai de 5 ms au maximum 4,7

DLY 150ms Délai de 150 ms au maximum 4,7

DLY 500ms Délai de 500 ms au maximum 4,7

DLY 2s Délai de 2 secondes au maximum 4,7

Dynamique COMP Compresseur 2,6

Sft COMP Compresseur � option Soft Knee 2,9

ST COMP Compresseur stéréo 5,2

Sft ST COMP Compresseur stéréo � option Soft Knee 7,0

LIM Écrêteur 2,6

Sft LIM Écrêteur � option Soft Knee 2,9

ST LIM Écrêteur stéréo 5,2

Sft ST LIM Écrêteur stéréo � option Soft Knee 7,0

AGC Commande automatique de gain 7,7

GATE Obturateur 3,1

DOWN EXP Extenseur descendant 3,1

PEAKLIM Écrêteur de pointe 3,7

DUCK Atténuateur 3,9

Filtres réparti-
teurs

XOVER 2 Filtre répartiteur à 2 voies 3,2

SUB Caisson de graves 4,5

Séparateur SPLIT 2 Séparateur à 2 voies 0,0
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SECTION 13 Annexe C : Extensions de fichiers
Le tableau suivant énumère les extensions de tous les différents types de fichiers créés par le logiciel du DFR22.

Extension de fichier Source
.agc Commande automatique de gain

.backup Sauvegarde complète

.cdk Gain d’entrée et de sortie

.comp Compresseur

.cutshf Filtres passe-haut et passe-bas/filtres de dégradé haute et basse fréquences

.d22 Fichier de préréglage

.d22pin Configuration des broches de commande

.dfr10 Réducteur numérique de Larsen à 10 bandes

.dfr16 Réducteur numérique de Larsen à 16 bandes

.dfr5 Réducteur numérique de Larsen à 5 bandes

.dly150ms Délai de 150 ms au maximum

.dly2s Délai de 2 secondes au maximum

.dly500ms Délai de 500 ms au maximum

.dly5ms Délai de 5 ms au maximum

.duck Atténuateur

.exp Extenseur descendant

.gate Obturateur

.geq10 Égaliseur graphique à 10 bandes

.geq30 Égaliseur graphique à 30 bandes

.lim Écrêteur

.mix Mélangeur matriciel

.peaklim Écrêteur de pointe

.peq10 Égaliseur paramétrique à 10 bandes

.peq10cs Égaliseur paramétrique à 10 bandes, avec filtres passe-haut et passe-bas et de dégradé

.peq3 Égaliseur paramétrique à 3 bandes

.peq3cs Égaliseur paramétrique à 3 bandes, avec filtres passe-haut et passe-bas et de dégradé

.peq5 Égaliseur paramétrique à 5 bandes

.peq5cs Égaliseur paramétrique à 5 bandes, avec filtres passe-haut et passe-bas et de dégradé

.peq7 Égaliseur paramétrique à 7 bandes

.peq7cs Égaliseur paramétrique à 7 bandes, avec filtres passe-haut et passe-bas et de dégradé

.softcomp Compresseur avec option Soft Knee

.softlim Écrêteur avec option Soft Knee

.softstcomp Compresseur stéréo avec option Soft Knee

.softstlim Écrêteur stéréo avec option Soft Knee

.stcomp Compresseur stéréo

.stdfr10 Réducteur numérique de Larsen stéréo à 10 bandes

.stdfr16 Réducteur numérique de Larsen stéréo à 16 bandes

.stdfr5 Réducteur numérique de Larsen stéréo à 5 bandes

.stlim Écrêteur stéréo

.sub Caisson de graves

.xover2 Filtre répartiteur à 2 voies
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SECTION 14 Annexe D : Guide de dépannage
Panne de communication entre l’ordinateur et le DFR22 :
Les messages suivants sont affichés lorsque le logiciel du DFR22 ne communique pas avec l’appareil.

« COM(port) is already in use or does not exist... » (Le port COM est déjà utilisé ou 
n’existe pas...)
Ce message apparaît dans les cas suivants :

• Le port COM spécifié est déjà utilisé par une autre application.

Si le port COM choisi est déjà utilisé par une autre application, il suffit de fermer cette dernière pour
résoudre le problème. Un exemple d’application maintenant le port COM ouvert est HotSync Manager,
ainsi que d’autres programmes utilitaires similaires utilisés pour synchroniser l’ordinateur et des appa-
reils du type Palm Pilot™. La fermeture de ces programmes risque toutefois de s’avérer difficile dans
la mesure où ils tournent généralement en arrière-plan. Consulter le manuel d’utilisation du pro-
gramme. Les ordinateurs de bureau disposent généralement de plusieurs ports série. Dans ce cas, le
choix d’un port COM différent et le raccordement du câble série du DFR22 à ce port devrait résoudre
le problème.

• Le port série de l’ordinateur est désactivé.

Exécuter l’utilitaire de configuration du BIOS et activer le port série. Dans ce cas, noter les paramètres
(demande d’interruption et adresse E/S) du port série et s’assurer qu’un port COM Windows est
mappé pour ces paramètres. Choisir ensuite ce port COM dans le logiciel du DFR22.

« Network not ready... » (Réseau pas prêt...)
Ce message indique que le logiciel du DFR22 a réussi à ouvrir le port COM mais n’a identifié aucun disposi-
tif raccordé à ce dernier. S’assurer que le DFR22 est sous tension et qu’il a terminé sa séquence de démar-
rage avant d’essayer de communiquer avec. Si l’ordinateur est doté de plusieurs ports COM, vérifier que le
câble de réseau est bien raccordé au port COM choisi dans la boîte de dialogue « Select COM Port ».

Vérifier que le câble utilisé est un câble série du type approprié et qu’il est solidement raccordé à l’ordina-
teur et au DFR22. Voir le Guide d’installation pour de plus amples renseignements.

« No devices detected... » (Aucun appareil détecté...)
Le logiciel du DFR22 a identifié un appareil autre qu’un DFR22 raccordé au port COM sélectionné. Il peut
s’agir d’un modem ou d’un autre dispositif série tel qu’un DFR11EQ. Il suffit de choisir un port COM dif-
férent auquel raccorder le DFR22 pour résoudre le problème.

L’indicateur de préréglage du DFR22 affiche la lettre « E » suivie d’un numéro :
• Un préréglage altéré est présent dans la mémoire de l’appareil et doit être supprimé. Si le 

problème persiste après que l’on a procédé comme indiqué ci-dessous, contacter le groupe 
d'applications de Shure.

Pour supprimer des préréglages altérés :
1. Ouvrir le logiciel du DFR22 et, en mode Design, choisir [File>Delete Preset] (Fichier>Supprimer le 

préréglage).
2. Supprimer tout préréglage signalé comme étant « **corrupted** » (altéré). Si le préréglage actif se 

révèle être en cause, cliquer sur [Cancel] (Annuler).
3. Choisir [File>New>Blank] (Fichier>Nouveau>Vierge) pour générer un préréglage vierge, puis 

choisir [File>Store Preset] (Fichier>Stocker le préréglage) et remplacer le préréglage actif altéré 
par le préréglage vierge.

• Le processus de mise à jour des microprogrammes a été interrompu ; ce problème peut être résolu 
en procédant comme indiqué ci-après. Si le problème persiste, contacter le groupe d'applications 
de Shure.
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Pour achever la mise à jour des microprogrammes :
1. Mettre l’appareil hors puis sous tension.
2. Sélectionner [Firmware Upgrade] (Mise à jour des microprogrammes) sur le menu [File] (Fichier).
3. Lorsque le logiciel demande une mise à jour du code, cliquer sur [Continue] (Continuer).

• En dernier recours, effectuer un redémarrage à froid. Cela supprime tous les préréglages et 
paramètres de l’appareil et le ramène à son état par défaut.

Pour effectuer un redémarrage à froid :
1. Mettre l’appareil hors tension.
2. Maintenir enfoncés les boutons Press to Lock/Hold to Clear et Bypass de la rangée A pendant que 

le DFR22 est remis sous tension.
3. L’indicateur de préréglage effectue un comptage dégressif à mesure que le redémarrage 

s’exécute.

Impossibilité de passer d’un préréglage d’appareil à un autre à partir de l’ordinateur :
• Vérifier le niveau de sécurité de l’appareil. Pour qu’on puisse passer d’un préréglage à un autre à partir 

de l’ordinateur, l’appareil doit être réglé au niveau 1 de sécurité ou à un niveau 2 spécial. Pour de plus 
amples informations, voir la section Sécurité à la page 100.

• i les changements de préréglage via les broches d’entrée de commande sont activés, l’appareil ne 
réagit pas aux changements effectués via le logiciel. Pour résoudre le problème, désactiver le change-
ment de préréglage via les broches de commande dans la fenêtre « Control Pins ». Pour de plus 
amples renseignements, voir la section « Pin Configuration » à la page 93.

Impossibilité de passer d’un préréglage à un autre à partir du panneau frontal de 
l’appareil :

• Le cinquième micro-interrupteur situé sur le panneau arrière de l’appareil est en position basse. Le 
mettre en position haute pour déverrouiller les commandes du panneau frontal.

• Le verrouillage du panneau frontal est activé pour le sélecteur de préréglage dans le logiciel du 
DFR22. Choisir [Security>Front Panel Lockout] (Sécurité>Verrouillage du panneau frontal) dans le 
menu principal et désélectionner la case [Preset selector] (Sélecteur de préréglage) dans la boîte de 
dialogue « Front Panel Lockout » (Verrouillage du panneau frontal).

• Si les changements de préréglage via les broches d’entrée de commande sont activés, l’appareil ne 
réagit pas aux changements effectués via le panneau frontal. Pour résoudre le problème, désactiver le 
changement de préréglage via les broches de commande dans la fenêtre « Control Pins ». Pour de 
plus amples renseignements, voir la section Sécurité à la page 100.
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